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1
About this guide

This chapter includes these topics:

• Documentation overview (page 14)

• Safety symbols (page 15)

• BD FACS Sortware help system (page 16)

• Technical assistance (page 17)
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Documentation overview
Introduction The guide contains a basic description of the BD FACSJazz™ cell 

sorter, BD FACS™ Sortware sorter software, QC procedures, 
configuration, operating procedures, and maintenance 
information. 

Using the guide A familiarity with basic flow cytometry concepts is assumed 
throughout this guide. You should have a working knowledge of 
basic Microsoft® Windows® operation. If you are not familiar 
with the Windows operating system, see the documentation 
provided with your computer.

The information in this guide is organized into the following parts:

• Part 1: Instrument information. Includes information about 
system hardware and components, basic system procedures, 
and system maintenance. Some system procedures require the 
use of BD FACS Sortware software.

• Part 2: Software information. Includes information about 
BD FACS Sortware software, general procedures for setting up 
and operating the instrument, and procedures for sorting 
samples. 

• Part 3: System workflow. Includes the essential workflows for 
the setup and operation of the BD FACSJazz system.

• Part 4: Reference. Includes information about the 
BD FACSJazz options and troubleshooting.

Other 
documentation

See the BD FACSJazz Safety and Limitations Guide for 
descriptions of safety and warning labels, general system hazards, 
and laser, electrical, and biological hazards. 
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More information • Safety symbols (page 15)

• Technical assistance (page 17)

• BD FACS Sortware help system (page 16)

Safety symbols
Introduction The following table lists the safety symbols used throughout this 

guide. 

Safety symbols The following safety symbols are used in this guide to alert you to 
potential hazards.

For a complete description of safety hazards, see the BD FACSJazz 
Safety and Limitations Guide.

More information • Documentation overview (page 14)

• BD FACS Sortware help system (page 16)

Symbol Meaning

General warning. Risk of personal injury to operator.

Dangerous. High voltage. Risk of electrical shock.

Biohazard
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BD FACS Sortware help system
Introduction BD FACS Sortware software includes a comprehensive help system 

that includes all content from this user’s guide. Internet access is 
not required to access this content.

Navigating the help 
system 

To access the BD FACS Sortware software help system:

1. In the BD FACS Sortware window, select Help > Contents.

The help window opens.

2. Use the table of contents, interactive links, related topics, or 
the search tool to locate topics of interest. 

– Search. Type words or phrases into the search field. Search 
results are displayed in a familiar web search format to help 
you find information quickly.

– Tips. Click the Help icon to view tips for using the help 
system.

– Print. Use the print tools to print individual topics or to 
print entire sections as formatted PDF files.

More information • Documentation overview (page 14)

• Safety symbols (page 15)

• Technical assistance (page 17)

Help icon

Print and PDF tools
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Technical assistance
Introduction This topic describes how to get technical assistance.

Contacting 
technical support

If you require assistance, contact your local BD Biosciences 
technical support representative or supplier. For the current 
technical support phone and email contact information, go to 
bdbiosciences.com/support/technical.

When contacting BD Biosciences, have the following information 
available:

• Product name, part number, and serial number

• Any error messages

• Details of recent system performance

More information • Documentation overview (page 14)

• BD FACS Sortware help system (page 16)

http://www.bdbiosciences.com/support/technical
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Part 1
Instrument information

This part includes these chapters:

• Chapter 2: Instrument overview (page 21)

• Chapter 3: Fluidics (page 31)

• Chapter 4: Optics and signal processing (page 45)

• Chapter 5: Sort components (page 55)

• Chapter 6: Maintenance (page 61)
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2
Instrument overview

This chapter includes these topics:

• System description (page 22) 

• System and components (page 26) 

• System controls (page 29) 
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System description
Introduction This topic describes the BD FACSJazz cell sorter system. 

The BD FACSJazz cell sorter system provides detection, analysis, 
and sorting of particles excited by laser light. The instrument has a 
fixed nozzle size (100 µm) and sheath pressure (27 psi).

Detection The BD FACSJazz cell sorter focuses laser light on a fast-moving, 
thin stream of particles (for example, cells, chromosomes, or 
organisms). Sensitive photomultiplier tubes (PMTs) collect the 
fluorescence and light scatter emitted by the particles.

Forward scatter detector

Fluorescence detector Beam stop



Instrument overview 23

Sorting The following are the steps in the sorting process

.

The following figure shows stages 1 to 3 of the sorting process.

The following figure shows stages 4 to 7 of the sorting process.

Stage Description

1 Drop-drive energy is applied to the stream to break it into 
highly uniform drops. 

2 Droplets detach from the stream a few millimeters 
downstream from the nozzle. This is the breakoff point. The 
drop is surrounded by air.

3 When a particle that meets the sorting criteria is detected, an 
electrical charge is applied to the stream at the breakoff 
point. The drop acquires an electrical charge (positive or 
negative), depending on whether the particle has been gated 
to be sorted.

4 The charged drop passes between two high-voltage deflection 
plates. 

5 Electrostatic attraction and repulsion deflect the charged 
drop into the left or right stream, depending on the drop’s 
charge polarity.

6 Charged drops sort into a collection device (multiwell plate 
or tube).

7 Uncharged drops pass down the center stream to the waste 
drain.

Charged droplet
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Nozzle

Laser beam

Deflection plate

Waste

Sorted cells
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Analysis Use the BD FACS Sortware worksheet tools for sorting and data 
analysis. The following figure shows a worksheet.

More information • System and components (page 26)

• Functional subsystems (page 28)
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System and components
Introduction This topic describes the BD FACSJazz system and components.

System 
components

The following figure shows the system components.

The following table describes the system components.

Workstation
Sheath and
waste tanks

Electronics
box

Cell sorter

System Component Description

Cell sorter A compact research cell sorter that has a fixed nozzle size 
(100 µm) and sheath pressure (27 psi). Several hardware options 
and upgrades can be used to customize the system for different 
applications. 

Sheath and waste tanks 7-L stainless steel tanks.

Electronics box Contains the isolation transformer, DC power supply, and 
cytometer interface—a dedicated computer that interacts with the 
software and controls the cytometer hardware.

Note:  In an emergency, use the main power switch, located on 
the front of the electronics box, to power down the system.

Workstation Runs BD FACS Sortware software.



Instrument overview 27

Instrument 
components

The following figure shows the instrument components.

The following table describes the instrument components.

Nozzle assembly

Sample station

Nozzle access door

Sort stage System controls

Laser alignment 
knobs

Nozzle 
stage

Forward scatter 
alignment knob

Plate access panel

Sort chamber door

Sort chamber

Instrument component Description

Laser alignment knobs Control the beam alignment of each laser. 

Nozzle stage Aligns the sheath stream to the collection lens and pinholes and to 
the BD FACS™ Accudrop laser and waste collector.

Forward scatter 
alignment knob

Used to align the forward scatter signal to the detector. (Intended 
for Service Use Only. Not for routine user adjustment.)

Nozzle assembly Creates the hydrodynamic focusing of the sample stream in the 
sheath stream. 

Nozzle access door Sliding door that provides access to the nozzle and interrogation 
chamber.

Plate access panel Provides access to the deflection plates. When open, the deflection 
plates and Accudrop laser are disabled.
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Functional 
subsystems

The BD FACSJazz system includes the following functional 
subsystems:

• Fluidics (page 31)

• Optics and signal processing (page 45)

• Sort components (page 55)

More information • System description (page 22)

• BD FACSJazz options (page 361)

Sort chamber door Provides access to the sort chamber. When open, the deflection 
plates and Accudrop laser are disabled.

Sample station The sample station consists of the following:

 Sample tube holder. Holds and pressurizes the sample tube.

 Bubble detector. Detects air bubbles from the sample tube and 
stops the sample flow when the sample tube is empty, 
preventing air bubbles from reaching the nozzle assembly.

System controls Includes the deflection plates power button (PLATES), illumination 
(ILLUM), and sample valve controls (BACKFLUSH and SAMPLE).

Sort stage A moving mechanical assembly that holds and positions sort tray 
devices (for example, multiwell plates and tube holders).

Sort chamber The sort chamber consists of the following:

 Deflection plates. High-voltage plates that deflect droplets from 
the main stream into specific tubes or wells in the sort tray.

 Sort tray. Plates or adapters that hold tubes or slides.

 Accudrop laser. A laser that is used for determining the drop 
delay and to correctly set up the side and center streams.

 Waste drain. Collects the uncharged droplets of the center 
stream.

Instrument component Description
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System controls
Introduction This topic describes the BD FACSJazz system controls.

Components The following figure shows the BD FACSJazz system controls.

The following table describes the BD FACSJazz system controls.

More information • System description (page 22)

• System and components (page 26)

• Pressure Console pane (page 92)

PLATES button

ILLUM button

BACKFLUSH button

SAMPLE button

Component Description

PLATES button Turns the power to the plates on and off.

ILLUM button Turns the light to view the lower section of the stream on and off.

BACKFLUSH button Carries sheath fluid from the nozzle back to the sample station via the 
sample line.

SAMPLE button Opens the sample valve when a tube is in place and the fluidics are in 
stream mode, which allows sample to be carried from the tube to the 
nozzle.
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3
Fluidics

This chapter includes these topics:

• Fluidics overview (page 32)

• Sample introduction (page 33)

• Waste fluidic components (page 40)
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Fluidics overview
Introduction This topic describes the fluidics subsystem.

Components The fluidic subsystem components are:

• System controls

• Sample introduction components

• Waste tank and associated components

The following figure shows the fluidics subsystem components. 

More information • System and components (page 26)

• System controls (page 29)

• Functional subsystems (page 28)

• Sheath tank components (page 34)

• Waste fluidic components (page 40)

Sample 
station
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Sample introduction
Introduction This topic describes the fluidic components that move sample fluid 

from the sample tube to the sort chamber.

The purpose of the fluidics system is to present the sample to the 
laser intercept in a single-file stream in a uniform and reproducible 
fashion. The resulting laser/particle interaction generates 
characteristic light-scatter and fluorescence signatures enabling 
particles to be analyzed and selected for sorting.

Components The main components of sample introduction include:

• Air pressure source

• Sheath tank components

• Sheath line

• Nozzle assembly

• Sample line

• Sample station 

• Pressure Console pane

Air pressure source A house air supply or air compressor (available as an option) is 
needed to provide air pressure to the system. The Air switch is a 
physical toggle on the system that is used to switch the air pressure 
on or off. 

Air switch
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Sheath tank 
components

The sheath tank is a 7-L stainless steel vessel that holds the sheath 
fluid (saline) and is pressurized to force the sheath fluid into the 
system through the nozzle. 

The associated components of the sheath tank and fluidics are: 

• Air line. Provides pressure to the tank so that sheath fluid can 
flow.

• Sheath line. Conveys the sheath to the nozzle assembly.

• Pressure gauge. Displays the internal tank pressure.

• Pressure release valve. Removes pressure from the tank prior 
to removing the tank lid.

Pressure gauge

Pressure release valve

Sheath tank

Sheath line Air line

Quick disconnects
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• Sheath filter. Removes possible contaminants from the sheath 
fluid. The following figure shows the sheath filter.

Sheath line The sheath line connects the sheath filter with the Y-fitting on the 
nozzle stage assembly. It delivers sheath fluid from the sheath filter, 
through the sheath pinch valve to the nozzle. 

Nozzle line

Purge line

Sheath line
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Nozzle assembly The nozzle assembly creates the hydrodynamic focusing of the 
sample stream in the sheath stream. 

The assembly uses a piezoelectric element that applies drop-drive 
energy to the stream to break it into highly uniform drops. The 
nozzle assembly also charges the stream as needed to create 
charged drops for sorting.

Nozzle 

Nozzle tip

Nozzle line 

Sample line 
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Sample line The sample line carries the pressurized sample stream from the 
sample tube to the nozzle assembly. The sample line has an inner 
diameter of 0.01 inches. The sample line can easily be replaced 
either by itself or as part of the disposable fluidics kit.

Purge line

Y connector

Sample line

Sample 
introduction

Sheath line

Nozzle assembly
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Sample station The sample station is where the sample tube is loaded and the 
sample is pressurized for sample introduction.

The following table describes the sample station components.

Tube-lock lever

Sample valve

Bubble detector

Component Description

Sample valve Opens and closes the sample line.

Bubble detector Detects bubbles and closes the sample valve when a bubble is detected.

Tube-lock lever Locks the sample tube in place and ensures that the sample tube is sealed 
with the top of the sample port.
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Pressure Console 
pane

Pressure is applied to the sheath tank and the sample tube to push 
sheath fluid and sample fluid through the nozzle simultaneously. 
The Pressure Console pane is the part of BD FACS Sortware 
software that includes controls that regulate and monitor the 
sample and sheath fluidics pressures. The sheath pressure of the 
BD FACSJazz system is set to 27 psi. The sample offset pressure 
regulator displays the differential amount of pressure applied to 
the sample relative to the sheath.

The following figure shows the Pressure Console pane. See 
Pressure Console pane (page 92) for more information.

The Sample and Backflush buttons are also available in the system 
controls. See System controls (page 29) for more information.

More information • Fluidics overview (page 32)

• System controls (page 29)

• Pressure Console pane (page 92)
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Waste fluidic components
Introduction This topic describes the waste fluidic components.

Components The main waste fluidic components are:

• Waste tank

• Purge line

• Waste drains and lines

• Vacuum source

Waste tank The waste tank is an autoclavable stainless steel 7-L tank. 

The waste tank lid seals with the tank to maintain the vacuum. It 
has one port for the vacuum line, one for the waste lines, and one 
for the gauge used to monitor the amount of vacuum applied to the 
tank. 

See Maintenance (page 61) for information about system 
maintenance tasks involving the waste tank.

Waste lines (red)

Gauge

Vacuum port
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Purge line The purge line connects the waste tank with the Y-fitting on the 
nozzle stage assembly. During rinse, purge, and pulse fluidic 
modes, the purge line valve is open and fluid travels through the 
purge line to the waste.

Waste drains and 
lines

The waste drains consist of the stream drain, backflush drain, and 
the flush bucket. 

• Stream drain. Located directly under the stream in the sort 
chamber. The middle stream of uncharged drops falls into the 
stream drain and is aspirated to the waste tank.

• Backflush drain. Located below the tube holder in the sample 
station. This drain is used to collect and aspirate the fluids 
flushed back through the sample line to the waste tank. 

Stream drain

Backflush drain
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• Flush bucket. A movable receptacle that is used during startup 
and shutdown to catch the stream from the nozzle assembly 
and during a run to access the plates without stopping the 
stream. 

It is placed directly under the nozzle to capture and aspirate 
fluid to the waste tank during maintenance and 
troubleshooting. 

The flush bucket mounts in two places: 

– Under the nozzle assembly when in use

– On top of the instrument above the sample station when 
not in use 

• Waste lines. Carry the waste from the drains to the waste tank.

Caution! The contents of the waste tank and 
waste tubing could be contaminated with 
biohazardous material. Follow your standard 
laboratory procedures for biological hazards 
during all cleaning and maintenance procedures. 
Wear protective clothing, eyewear, and gloves.

Flush bucket
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Vacuum source A house vacuum supply or vacuum pump (available as an option) 
is needed to depressurize the waste tank to draw waste fluid from 
the waste drains to the waste tank. The vacuum line connects to 
the vacuum port on the waste tank. The vacuum pressure in the 
waste tank must be between 5 and 10'' Hg.

The hydrophobic waste filter is connected between the vacuum 
source and the waste tank to prevent water from getting into the 
vacuum source.

More information • Fluidics overview (page 32)

• Sheath tank components (page 34)

• Air compressor and vacuum pump (page 364)

Caution! Do not run the system without the waste filter 
in place. Liquid contamination in the house vacuum 
supply or the dedicated air compressor can damage the 
vacuum system.
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4
Optics and signal processing

This chapter includes these topics:

• Illumination optics (page 46)

• Collection optics (page 49)

• Signal processing components (page 54)
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Illumination optics
Introduction This topic describes the illumination subsystem. 

The illumination subsystem steers and focuses the main excitation 
laser beam (and additional excitation lasers if present) onto the 
sample at the intersection of the stream and the emission optics. 

Functions of the 
optic system

The optic system is one of the three main systems on a cytometer. It 
has two main functions:

• Illumination of the particles using laser(s), steering optics, and 
a focusing lens.

• Detection of the signal from the illuminated particle as well as 
the scatter light of the particle (covered in the next chapter).

Components The main components of the illumination subsystem are:

• Lasers (up to three sample excitation lasers)

• Laser shutters and the shutter interlock system

• Steering optics

• Protective shields and guards

• Beam-shaping lenses (within laser head) that create a final 
elliptical beam profile at the focus (3:1 ratio with a typical 
beam height of 15–20 µm)

Laser Wavelength (nm) Power (mW)

Blue 488 80 

Red 640 50 

Violet 405 50
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Location of the 
lasers

The instrument includes air-cooled lasers mounted directly to the 
side of the sort head.

Laser shutter 
positions

For each laser there is a laser shutter tab that is used to block the 
laser or to allow the laser light to pass through. The laser shutter 
tab can be in one of three positions:

• Top. Open position. Laser light can pass through.

• Bottom. Closed position. Laser light is blocked.

• Middle. For service only. Do not use this position.

Lasers
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The following image shows an instrument with the three-laser 
configuration.

Laser interlock The lasers are interlocked to the nozzle access door. The lasers are 
disabled when the nozzle access door is opened. To reset the 
interlock after closing the nozzle access door, place your finger 
over the reset sensor in the upper-right corner of the nozzle access 
door.

More information • Functional subsystems (page 28)

• Collection optics (page 49)

Red laser shutter

Violet laser shutter

Blue laser shutter

Reset sensor

Nozzle
access door



Optics and signal processing 49

Collection optics
Introduction This topic describes the optical collection components. 

About optical 
detection

The optical collection system collects scattered light and 
fluorescence from the laser/particle interaction.

This detection system uses pinhole mirrors with the primary 
fluorescence objective lens to create spatial filters and separate 
fluorescence collected from the different laser intercepts with the 
sample stream. For each laser present, a separate series of dichroic 
mirrors and bandpass filters then precisely defines one or more 
wavebands of interest for quantification by the electronics.

The following illustration shows an example of an optical bench 
layout that includes: 488-nm excitation, scatter, and FITC, PE, PI, 
PE-Cy™5, and PE-Cy™7 detectors.
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Light collection The collection lens collects the light emitted from the particle 
during laser interrogation. Scattered and fluorescent light is 
collected through a 20x, 0.6 NA microscope objective and focused 
onto three spatially separated mirror pinholes.

Detectors There are up to eight optical PMT detectors in the system:

• Forward scatter (FSC) detector. Collects forward-scattered 
light from the particle/laser interaction. Resolution for the 
standard forward scatter detector is 1 µm (measured using 
beads). The collection angle is 2° to 17°. 

• Side scatter (SSC) detector. Collects side-scattered light 
through the microscope. Side scatter resolution is 1 µm 
(measured using beads).

• Fluorescence detectors.  Either four or six PMTs assigned to 
the one, two, or three lasers in a number of fixed 
configurations. These detectors collect fluorescent light 
through the microscope objective and focus the light onto 
three spatially separated pinhole mirrors.

Forward scatter 
collection lensSide scatter and

fluorescence
collection lens
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Filters The emitted light from the particle/laser interrogation is directed to 
PMTs via optical filters. The dichroic mirrors steer certain 
wavelengths to detectors, while the bandpass filters allow specific 
wavelengths to be measured by the PMTs.

Filter type Description

Longpass (LP) 
dichroic mirrors

The longpass dichroic mirrors reflect shorter wavelengths and transmit 
longer wavelengths. For example, a 505 LP dichroic mirror allows 
light of wavelengths equal to or greater than 505 nm to pass towards 
one detector, while reflecting light shorter than 550 nm to another. In 
this application, dichroic mirrors are characterized and used at 45° 
incidence.

Bandpass (BP) filters A bandpass filter allows a specified range of spectral wavelengths to 
pass through to the PMTs. For example, a 530/40 BP filters allows 
wavelengths between 530 nm ±20 (510 and 550 nm) through to the 
detector. In a few specific instances, the final filter before a PMT is a 
longpass filter (characterized in this case for normally incident light).

Neutral density 
(ND) filters

Neutral density filters allow a certain percentage of light to pass 
through. A neutral density filter is typically used with the FSC PMT 
due to the magnitude of the collected scatter signal.
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The following figure shows the layout of the BD FACSJazz 
excitation optics.

Laser delay When more than one laser is installed, the lasers are spatially 
separated, causing timing differences between the light signals 
generated by each particle as it passes through the succession of 
lasers. 

The calculated laser delay is a factor used to align all the signals so 
they can be measured and displayed on the same time scale. You 
typically optimize the laser delay(s) during daily instrument QC 
and optimization.
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The following table describes laser delay with three lasers. 

More information • Functional subsystems (page 28)

• Signal processing components (page 54)

Process Description

1 A particle intercepts the blue laser and generates signals.

2 A few microseconds later, the particle passes through the second laser, generating 
additional signals.

3 Moments later, the same particle passes through the third laser and generates a 
third batch of signals. 
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Signal processing components
Introduction This topic describes the signal processing components. 

Signal processing controls, amplifies, and processes PMT signals 
into data that can be:

• Monitored by the operator

• Acquired and analyzed by BD FACS Sortware

• Used by the sort electronics subsystem

Signal processing 
components

The main signal processing components are:

• Logarithmic and linear preamplifiers (log and lin preamps).  
Convert the current pulses generated by the PMTs to voltage 
pulses that can be quantified.

• Analog-to-digital converters (ADCs). Perform 16-bit analog-
to-digital conversion (65,536 channels).

• Digital signal processors (DSPs). Perform an 8 x 8 digital 
compensation matrix. Compensated parameters are available 
to the user for display, separately from the raw 
(uncompensated) ADC output signals, as separate parameters. 

More information • Functional subsystems (page 28)

• Sort electronics (page 56)



5
Sort components

This chapter includes these topics:

• Sort components overview (page 56)

• Sort electronics (page 56)

• Sample collection (page 58)
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Sort components overview
Introduction This topic provides an overview of the BD FACSJazz sort 

components.

Components The sort components are:

• Sort electronics

• Sorted sample collection

• Sort monitoring with the Sortview pane (page 95)

More information • Functional subsystems (page 28)

• Sort electronics (page 56)

• Sample collection (page 58)

Sort electronics
Introduction This topic describes the components of the sort electronics 

subsystem. 

The sort electronics subsystem contains the electronics components 
necessary for processing signal data and for sorting particles. 

Sort electronics 
components

The main components of sort electronics are:

• Control circuitry.  Circuit boards, counters, and other 
components that control sorting and deflection.

• Piezo drive. Powers the piezoelectric element in the nozzle 
assembly that converts the stream into controlled drops. You 
can optimize the piezo amplitude and frequency in the Sort 
Settings pane.

The drop charge is disabled when the sort chamber door is 
open.
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• High-voltage deflection plates. Pull drops from the main 
stream into left and right side streams, depending on their 
polarity, and direct them to specific tubes or wells in the sort 
tray.

More information • Functional subsystems (page 28)

• Sample collection (page 58)

Closed deflection plates Open deflection plates

Accudrop 
viewing window

High-voltage 
(HV) contact pins
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Sample collection
Introduction This topic describes the components for collecting sort stream 

drops. 

Sample collection 
devices

The sample collection subsystem collects the charged drops. You 
can collect sorted droplets into any device that will fit within the 
sort collection area, which include the following sort devices: 

• 5-mL tubes (12 x 75 mm), 15-mL conical tubes

• Multiwell plates (6, 24, 48, 96, and 384-well plates) 

• Standard microscope slides (1 x 3 in.; or 25 x 75 mm)

• 4 x 12 slides (1 x 3 in.)

• Petri dish (9-cm diameter)

• Terasaki plates (81 mm x 56 mm)

• Chilled 5-mL tubes (12 x 75 mm), 15-mL conical tubes 
(optional)

Sort stage The main component of sample collection is the sort stage—a 
platform with an xy-axis mechanism that holds sort trays (plates, 
or adapters which hold tubes, slides, or other devices). You can 
control the position of the sort stage with BD FACS Sortware. 

Sort stage
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More information • Functional subsystems (page 28)

• Sort electronics (page 56)

• Creating a sort device layout (page 235)

Tube holder 
in the sort 
stage
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6
Maintenance

This chapter includes these maintenance topics:

• Maintenance overview (page 62)

• Cleaning and inspecting the instrument (page 63)

• Inspecting and cleaning the deflection plates (page 64)

• Decontaminating the fluidics (page 66)

• Vertically aligning the lasers (page 68)

This chapter also includes the following component replacement topics:

• Component replacement (page 70)

• Replacing the nozzle tip (page 71)

• Replacing the sample line (page 72)

• Replacing the sheath and waste fluidic lines (page 75)

• Replacing the nozzle assembly (page 77)

• Replacing the sample stopper (page 80)
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Maintenance overview
Introduction This topic describes the periodic maintenance procedures required 

for proper system operation and optimal performance.

Who should 
perform 
maintenance

This maintenance should be performed by the BD FACSJazz 
system administrator or other trained person. 

Contact your BD service representative for information about 
ordering the tools or materials needed to perform these 
maintenance procedures.

Daily maintenance Daily maintenance includes the following procedures.

• Cleaning and inspecting the instrument (page 63)

• Inspecting and cleaning the deflection plates (page 64)

• Cleaning the nozzle tip (page 259)

Monthly 
maintenance

In addition to daily maintenance procedures, decontaminate the 
fluidics each month. 

See Decontaminating the fluidics (page 66) for more information.

Periodic 
maintenance

Perform these maintenance procedures every 4 to 6 months or as 
needed.

Procedure When

Replacing the sample line (page 72) Every 4 to 6 months 
or as needed

Replacing the sheath and waste fluidic lines 
(page 75)

As needed

Vertically aligning the lasers (page 68) As needed
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More information • Cleaning and inspecting the instrument (page 63)

• Component replacement (page 70)

Cleaning and inspecting the instrument
Introduction This topic describes the basic instrument cleaning and inspection 

procedure. Perform this procedure daily to avoid contamination 
and degradation of the instrument. 

Required materials • 10% bleach 

• Deionized (DI) water

• Kimwipes® wipe or other lint-free towel 

• Small hand-held vacuum

Procedure To clean and inspect the instrument:

1. Remove dust from all exposed surfaces.

2. Clean salt buildups from the parts and areas exposed to sheath 
or sample fluids.

3. Clean the sort tray with a solution of 10% bleach and then 
wipe down with DI water.

4. Vacuum dust and lint from fan areas, such as the back of the 
electronics box and the computer, if needed.

5. Inspect the tubing and fluidics for leaks.

Caution! All biological specimens and materials can 
transmit potentially fatal disease. Follow your 
standard laboratory procedures for biological 
hazards during all cleaning and maintenance 
procedures. Use proper precautions and wear 
suitable protective clothing, eyewear, and gloves.
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More information • Maintenance overview (page 62)

• Inspecting and cleaning the deflection plates (page 64)

• Component replacement (page 70)

Inspecting and cleaning the deflection plates
Introduction This topic describes how to inspect the deflection plates for wear 

or damage and how to clean them. Perform this procedure twice 
daily, before starting the system and after shutting down the 
system, and as necessary.

Required materials • Kimwipes wipe or other lint-free towel 

• DI water

Inspecting the 
deflection plates

To inspect the deflection plates:

1. Inspect the deflection plates for signs of fluid or salt buildup.

Clean the plates thoroughly if salt crystals are visible.

Cleaning the 
deflection plates

To clean the deflection plates:

1. If you want to keep the sheath running, position the flush 
bucket under the nozzle to prevent the stream from wetting the 
plates during the procedure.

2. Power off the deflection plates by pressing the PLATES button. 

The PLATES button is not illuminated when the plates are 
powered off.

3. Remove the plate access panel. 

Caution: Electrical! To prevent electrical shock when 
cleaning the deflection plates, make sure that the plates 
are powered off.
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When the plate access panel is removed, the deflection plates 
are automatically powered off as an additional safeguard.

4. Open and remove the plates by lifting each plate separately out 
of the holder assembly. 

Plate access panel



BD FACSJazz User’s Guide66

5. Wet a Kimwipes wipe or other lint-free towel with DI water 
and wipe down the deflection plates and the body of the 
deflection plate holder.

6. Wipe the plates and the plate holder assembly again with a dry 
wipe. 

7. Re-install the deflection plates by sliding the pins on the plates 
into the deflection plate holders.

8. Close the deflection plates by swinging them into their closed 
position.

9. Restart the sheath stream or remove the flush bucket, if used.

The attached magnetic latches hold them in place.

10. Replace the plate access panel.

More information • Maintenance overview (page 62)

• Cleaning and inspecting the instrument (page 63)

Decontaminating the fluidics
Introduction This topic describes how to decontaminate the fluidics.

This procedure is similar to the dry shutdown process. If your lab 
does not usually perform dry shutdowns, perform this procedure 
weekly or monthly to maintain a clean system.

Caution! All biological specimens and materials can 
transmit potentially fatal disease. Follow your 
standard laboratory procedures for biological 
hazards during all cleaning and maintenance 
procedures. Use proper precautions and wear 
suitable protective clothing, eyewear, and gloves.
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Required materials • 0.5–1 L of 10% bleach or 70% ethanol

• DI water

Procedure To decontaminate the fluidics:

1. Install the nozzle tip.

2. Bypass the sheath filter.

3. Place the flush bucket under the nozzle.

4. Empty the waste tank.

5. Rinse the system with bleach or ethanol.

a. Fill the sheath tank with 0.5 L to 1 L of 10% bleach or 
70% ethanol.

b. In the Pressure Console pane, click Rinse and Backflush. 

c. Once the system begins to run dry, click Rinse to stop the 
fluidics.

d. Unload the tube from the sample station.

6. Rinse the system with DI water.

a. Rinse out the sheath tank with DI water.

b. Empty the waste tank.

c. Fill the sheath tank with at least 2x volume of DI water (for 
example, if you used 1 L of bleach or ethanol, rinse with 
2 L of DI water).

d. Fill the debubble reservoir with DI water, submerge the 
nozzle tip in the reservoir, then click Purge to draw DI 
water in to the nozzle body. After 1 minute, click Purge to 
stop the process. 

e. In the Pressure Console pane, click Rinse and Backflush. 

f. Once the system begins to run dry, click Rinse to stop the 
fluidics.
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7. Complete one of the following workflows according to your 
requirements: 

• Dry shutdown workflow (page 351)

• Dry startup workflow (page 248)

More information • Maintenance overview (page 62)

• Cleaning and inspecting the instrument (page 63)

• Replacing the nozzle assembly (page 77)

Vertically aligning the lasers
Introduction This topic describes how to adjust the vertical alignment of the 

lasers. Perform this procedure as needed when the vertical laser 
alignment drifts (laser beams do not go through the pinholes).

Required materials • 3-µm SPHERO™ Ultra Rainbow beads

• 0.5 mL of filtered sheath fluid

• 5/64'' Allen wrench

Before you begin • Prepare a tube of 3-µm SPHERO Ultra Rainbow beads (1 drop 
per 0.5 mL of filtered sheath fluid).

• Ensure that the stream is aligned. See Aligning the stream 
(page 277).
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Adjusting the 
vertical alignment 
of the laser

To adjust the vertical alignment of the laser:

1. Load the tube of Ultra Rainbow beads onto the sample tube 
holder and close the tube-lock lever.

2. Verify that the sample pressure offset is about 1.0 psi.

Use the Pressure Control pane to adjust the sample offset, if 
necessary. 

See Introducing a sample into the system (page 264).

3. In the Pressure Console pane, click Sample to start running 
beads. 

4. Use a 5/64'' Allen wrench to adjust the appropriate vertical 
alignment laser steering knob so that the flash of beads in the 
core stream is in the center of the pinhole (as viewed in the 
pinhole image of the Sortview pane).

 

More information • Sortview pane (page 95)

• Alignment and QC (page 267)

• Preparing beads for QC (page 276)

Vertical 
alignment laser 
steering knobs
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Component replacement
Introduction This topic lists the typical component replacement procedures you 

perform without the assistance of a service representative.

Before replacing 
components

Before beginning any maintenance procedures, complete the 
following tasks:

• Shutter all lasers

• Turn off the piezo amplitude

• Turn off the deflection plates

• Turn off all PMTs

• Decontaminate any parts of the instrument that have been in 
contact with biohazardous samples, or use biohazard 
precautions

User-replaceable 
component 
procedures

You can perform the following component replacement 
procedures:

• Replacing the nozzle tip (page 71)

• Replacing the sample line (page 72)

• Replacing the sheath and waste fluidic lines (page 75)

• Replacing the nozzle assembly (page 77)

• Replacing the sample stopper (page 80)

More information • Maintenance overview (page 62)

• Cleaning and inspecting the instrument (page 63)

• Decontaminating the fluidics (page 66)

• Cleaning the nozzle tip (page 259)

• Turning off the power (page 357)
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Replacing the nozzle tip
Introduction This topic describes how to remove and replace a nozzle tip. You 

need to remove the nozzle tip to clean the nozzle. Perform this 
procedure as needed.

Removing the 
nozzle tip

To remove the nozzle tip:

1. Open the nozzle access door. 

2. Loosen the nozzle nut by hand. 

Do not use a wrench.

3. Remove the nut and nozzle tip.

4. Place the nozzle tip and nut in a safe place.

Cleaning the nozzle 
tip 

See Cleaning the nozzle tip (page 259) for instructions.

Installing the 
nozzle tip

To attach the nozzle tip:

1. Place the clean nozzle tip into the nozzle nut, ensuring that the 
O-ring is in place in the nut.

2. Install the nozzle tip onto the nozzle, ensuring that the nozzle 
tip is seated in the nozzle body and not jammed or askew. 

3. Tighten the nozzle tip by hand as much as possible. 

Do not use a wrench.

More information • Maintenance overview (page 62)

• Decontaminating the fluidics (page 66)

• Component replacement (page 70)
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Replacing the sample line
Introduction This topic describes how to replace the sample line. 

Replacing the sample line prevents any sample carryover or cross-
contamination of cells. Perform this procedure every 4 to 6 
months, or when decreased event rates indicate that the sample line 
is kinked or clogged and cannot be unclogged by backflushing or 
running 10% bleach through the sample line.

Required materials • Sample line 

• 7/64'' Allen wrench

• 1/16'' Allen wrench

• 2–3 mL of DI water

Before you begin • See Before replacing components (page 70) for more 
information. 

• Make sure the system is dry.

Removing the 
sample line

To remove the sample line:

1. Verify that the Air switch is on and the fluidic modes are off. 

2. Remove the nozzle line from the Y-fitting.

3. Remove the nozzle assembly using the 7/64'' Allen wrench to 
loosen the socket-head cap screw that holds the nozzle 
assembly in place.
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4. Gently remove the sample line from the nozzle assembly while 
supporting the stainless steel tubing.

5. In the Pressure Console pane, click Override to open the 
sample valve. 

6. Remove the sample line from the sample valve.

7. Gently remove the sample line from the sample stopper 
column. 

Installing a new 
sample line

To install a new sample line:

1. Attach the sample line into the sample stopper column.

Caution! All biological specimens and materials 
can transmit potentially fatal disease. Follow your 
standard laboratory procedures for biological 
hazards during all cleaning and maintenance 
procedures. Use proper precautions and wear 
suitable protective clothing, eyewear, and gloves.

Caution! Do not bend the stainless steel fitting.

Sample stopper column

Sample valve

Caution! Do not bend the stainless steel fitting and be 
careful not to kink the sample line.
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2. Install a tube onto the sample station and check the depth of 
the sample line. 

The sample line should just touch the bottom of the tube 
without bending.

3. Verify that the fluidics are not running, then with the tube still 
locked in place, in the Pressure Console pane, click Override to 
open the sample valve.   

4. Insert the silicone section of the tubing into the pinch valve 
using a 1/16'' Allen wrench to gently push the tube inside the 
valve, if necessary.

5. Verify that the sample line is not blocking the bubble detector 
just below the sample valve. 

The bubble detector should have only silicone tubing in front 
of it.

6. Remove the nozzle tip.

7. Gently feed the sample line through the stainless steel fitting on 
top of the nozzle assembly, sliding the silicone rubber tubing 
over the stainless steel fitting.

8. Verify that the sample line extends about 1 mm beyond the end 
of the stainless steel fitting inside the nozzle assembly.

Sample line installed 
incorrectly

Sample line installed 
correctly
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9. Reattach the nozzle assembly using the socket-head cap screw 
removed earlier.

The nozzle assembly keys into position automatically.

10. Perform the dry startup procedure. See Dry startup workflow 
(page 248).

More information • Maintenance overview (page 62)

• Decontaminating the fluidics (page 66)

• Component replacement (page 70)

Replacing the sheath and waste fluidic lines
Introduction This topic describes how to replace the fluidics lines that connect 

to the sheath and waste tanks. Perform this procedure as needed.

Required materials • Sterile sheath fluid (at least 200 mL)

• 3/22'' Allen wrench

Before you begin • See Before replacing components (page 70) for more 
information.

• Perform a dry shutdown (see Dry shutdown workflow 
(page 351)).

Removing the 
fluidic lines

To remove the fluidic lines:

1. Verify that the Air switch is on and the fluidic modes are off.

2. Depressurize the sheath tank.

a. Disconnect the air line to the sheath tank.

b. Open the pressure release valve.

3. Remove the nozzle line from the Y-fitting above the nozzle.
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4. Remove the Y-fitting using a 3/22'' Allen wrench.

5. In the Pressure Console pane, click Rinse to open both the 
sheath and purge valves.

6. Remove the tubing from the two valves on the top of the 
instrument.

7. Undo the blue connections on the fluidics lines going to the 
sheath and waste tanks.

Installing new 
sheath and waste 
fluidic lines

To install new fluidic lines:

1. Attach a new sheath filter.

2. Attach the new sheath and purge lines and route them to the 
top of the instrument.

3. Attach the Y-fitting to the chassis.Attach the nozzle line to the 
Y-fitting. 

4. Slide the lines into the pinch valves.

Purge line

Sheath line

Nozzle line
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The purge line runs through the left pinch valve and the sheath 
line runs through the right pinch valve. 

5. Perform a dry startup.

More information • Maintenance overview (page 62)

• Dry startup workflow (page 248)

Replacing the nozzle assembly
Introduction This topic describes how to replace the nozzle assembly. 

Required materials • 7/64'' Allen wrench

• 1–2 L of sterile sheath fluid

Before you begin See Before replacing components (page 70) for more information.
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Removing the 
nozzle assembly

To remove the nozzle assembly:

1. Remove the sample line from the top of the nozzle assembly by 
sliding the silicone rubber tubing off the stainless steel tubing.

2. Detach the nozzle line from the Y-fitting. 

3. Remove the nozzle assembly using the 7/64'' Allen wrench to 
loosen the socket-head cap screw that holds the nozzle 
assembly in place.

4. Inspect the drop charge contact and the piezo drive 
connections for corrosion or bending. 

Remove corrosion, if corrosion is present. Bend connections 
back into the proper orientation, if connections are bent.

Caution: Electrical! To prevent possible electrical shock 
when working with the nozzle assembly, make sure that 
the system power is off.

Silicone rubber seal
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Installing the 
nozzle assembly

To install the nozzle assembly:

1. Gently feed the sample line through the stainless steel fitting on 
the top of the new nozzle assembly, sliding the silicone rubber 
tubing over the stainless steel fitting.

2. Verify that the sample line extends about 1 mm beyond the 
end of the stainless steel fitting inside the nozzle assembly.

3. Attach the new nozzle assembly using the socket-head cap 
screw removed earlier.

The nozzle assembly keys into position automatically.

4. Tighten the socket-head cap screw using an Allen wrench.

5. Reattach the sheath tubing to the Y-fitting.

6. Perform a dry start up.

More information • Component replacement (page 70)

• Before replacing components (page 70)

• Dry startup workflow (page 248)

Caution! Do not bend the sample line or the 
stainless steel fitting.

Sample line installed 
incorrectly

Sample line installed 
correctly
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Replacing the sample stopper
Introduction This topic describes how to replace the sample stopper. Replace the 

sample stopper when it is worn out or when there is a leak around 
the tube seal.

Removing the 
sample stopper

To remove the sample stopper:

1. Power off the electronics and the lasers. 

2. Remove the sample line from the pinch valve.

a. In the Pressure Console pane, click Override to open the 
sample pinch valve.

b. Hold the sample line above and below the pinch valve and 
remove.

3. Remove the sample line from the sample-stopper column.

4. Gently pull the sample stopper off the end of the sample 
column. 

Removing the sample station T from the chassis allows better 
access to the sample stopper.

Caution! Do not bend the stainless steel fitting.

Caution! Do not remove the sample line from the 
nozzle assembly.

Sample stopper
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Installing a new 
sample stopper

To install a new sample stopper:

1. Gently slide the new sample stopper onto the sample column.

2. Inspect the stopper for cracks, and replace it if there are any. 

3. Replace the sample line in the sample column.

4. Replace the sample line in the sample valve.

More information • Maintenance overview (page 62)

• Component replacement (page 70)

• Replacing the sample line (page 72)
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Part 2
Software information

This part includes these chapters:

• Chapter 7: Software overview (page 85)

• Chapter 8: Preferences and settings (page 97)

• Chapter 9: Cytometer settings (page 117)

• Chapter 10: Worksheets (page 139)

• Chapter 11: Acquisition and recording tools (page 153)

• Chapter 12: Plots (page 169)

• Chapter 13: Gates and populations (page 195)

• Chapter 14: Sort settings and layout (page 225)
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7
Software overview

This chapter includes these topics:

• BD FACS Sortware overview (page 86)

• Pressure Console pane (page 92)

• Sortview pane (page 95)
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BD FACS Sortware overview
Introduction This topic describes the BD FACS Sortware user interface, 

including the panes that you can select from the main window.

How the software 
interacts with the 
instrument

BD FACS Sortware serves as the user interface and works through 
the cytometer interface to control the instrument, acquisition, 
sorting, and analysis. The cytometer interface is the access point 
for controlling the cytometer and keeps track of the state of the 
instrument.

User interface BD FACS Sortware serves as the user interface and provides all 
user control for the instrument, acquisition, sorting, and analysis.

The worksheet is always open. Use the worksheet to create and 
modify plots, monitor sort data, and analyze sort results. 

Sorter hardware
BD FACS Sortware

(software user interface)
Cytometer interface

(instrument control software )

Computer Electronics box BD FACSJazz
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Examples of panes in the workspace

Worksheet
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Panes Panes can be opened, closed, resized, moved, and pinned within 
the workspace so that you can create your own window layout. 
Click the tools on the BD FACS Sortware toolbar to open panes in 
the workspace. 

You can arrange individual panes to create specific window 
layouts. See Setting up your window layout (page 98) for more 
information.

The following table describes the toolbar controls and the panes 
they open.

Control Description

Opens the Acquisition Dashboard pane. Use this pane to start or stop 
acquisition, record events, and monitor data acquisition details.

See Using the Acquisition Dashboard (page 166) for more 
information.

Opens the Recording Settings pane. Use this pane to set details about 
the flow cytometry standard (FCS) file that is generated when you 
record data.

See Using the Recording Settings pane (page 162) for more 
information.

Opens the Data Sources pane. Use this pane to view data and 
information from the instrument or loaded or recorded data sources 
(FCS files). 

See Using the Data Sources pane (page 154) for more information.

Opens the Gate Hierarchy pane. Use this pane to display and 
manipulate the hierarchy (tree) of the gates in an active plot. 

See Using the Gate Hierarchy pane (page 199) for more information.
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Opens the Inspector pane. Use this pane to view and modify data 
source properties and properties for selected worksheet items.

See Using the Inspector to view and modify plot properties 
(page 176) for more information.

Opens the Logicle Scaling pane. Use the logicle scale after 
compensation to view events that have negative values.

See Using the Logicle Scaling pane (page 136) for more information.

Opens the Compensation pane. Use this pane to create a 
compensation matrix, select parameters for auto compensation, and 
calculate fluorescence spillover values. 

See Using the Compensation pane (page 131) for more information.

Opens the Tray Control pane. Use this pane to view or modify the 
current sort device and adjust the offsets for the tray, or create a new 
sort device configuration.

See Using the Tray Control pane (page 233) for more information.

Opens the Sort Layout pane. Use this pane to select the sort device, 
set up populations to be sorted, and control the position and 
readiness of the sort device.

See Using the Sort Layout pane (page 241) for more information.

Opens the Sort Settings pane. Use this pane to set up the drop 
formation, drop delay, breakoff, and deflection parameters, and to 
select a sort mode.

See Using the Sort Settings pane (page 226) for more information.

Opens the Cytometer Settings pane. Use this pane to view the status 
or modify the laser and detector settings of the cytometer. 

See Using the Cytometer Settings pane (page 118) for more 
information.

Control Description
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Setting numeric 
values in panes and 
dialogs

BD FACS Sortware panes and dialogs include fields with 
adjustable numeric values. You can adjust these numeric values 
using different mouse and keyboard options. 

To set numeric values in fields with the mouse:

• Hold the mouse pointer over the field (the value will change 
from normal to bold) and roll the mouse scroll wheel up or 
down to change the value. You do not need to click in the field 
to change the values with the scroll wheel. 

• Click the small up and down arrows to change the value.

• Click in the small blue/white data slider below the value to 
change the value.

Cursor in field

Small up and down arrows

Small blue slider
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• In the field, click and hold the larger down arrow.

The large data slider appears.

Continue to hold the mouse button and slide the data slider 
left or right to adjust the values.

To set numeric values in fields with the keyboard:

• Click in the field and press the up or down arrow keys to 
adjust the values.

• Click in the field and press Ctrl and the up or down arrow 
keys to adjust the values in larger increments.

The increment values are dependent on the field that is being 
adjusted. For example, the detector voltage is adjusted in 
increments of 0.1 with the arrow keys and 1.0 volts with 
Ctrl+arrow keys, while piezo amplitude is adjusted in 
increments of 0.01 and 0.1, respectively.

More information • Preferences and settings (page 97)

• Worksheets (page 139)

• About settings files (page 110)

• Working with settings files (page 113)

Larger down arrow
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Pressure Console pane
Introduction This topic describes the Pressure Console pane in 

BD FACS Sortware.

About the Pressure 
Console pane

The Pressure Console pane has the software controls that regulate 
and monitor the sample and sheath fluidics pressures, and control 
the deflection plates and Accudrop laser. The Pressure Console 
pane starts when BD FACS Sortware software is started.

The following figure shows the collapsed view of the Pressure 
Console pane.

To change the offset pressure, select the pressure offset control and 
perform any of the following actions: 

• Use the scroll wheel on the mouse.

• Use the arrow keys on the keyboard.

• Type a new value and press Enter.

The following figure shows the expanded view of the Pressure 
Console pane.
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The following table describes the Pressure Console pane controls 
and displays.

Control Description

Offset Allows you to adjust and view the sample offset.

Boost When this button is held down, the sample offset is 
increased an additional 3.0 psi over the current offset. 
Boost stops when the button is released. The shortcut key is 
F7.

Sample Opens the sample valve when a tube is in place and the 
fluidics are in stream mode, allowing the sample to be 
carried from the sample tube to the nozzle. The shortcut 
key is F6.

Plates Turns the power to the plates on and off.

Stream Opens the sheath valve (turns the stream on) and closes the 
sheath valve (turns the stream off). The shortcut key is F8.

Backflush Opens the sample valve when no tube is in place and 
fluidics are in stream mode, allowing sheath fluid to be 
carried from the nozzle to the sample station.

Illum Turns the BD FACS Accudrop laser on and off.

Purge Opens and closes the waste valve, allowing fluid to be 
carried from the debubbler up through the nozzle to the 
waste line.

Pulse Pulses the fluidic valves to clear bubbles in the nozzle.
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More information • System startup (page 247)

• System shutdown (page 349)

Accudrop Moves the Accudrop filter in and out of position over the 
sort stream camera.

Rinse Opens and closes the sheath and waste valves.

Override Opens the sample valve regardless of the state of the other 
fluidics to allow for the removal or installation of the 
sample line or other maintenance procedures.

Automatically boost before 
sampling

Automatically boosts the sample briefly when Sample is 
clicked.

Start sampling when door is 
closed

Automatically starts sampling when the sample door is 
closed.

Backflush when door is opened Automatically opens the sample valve when the door is 
opened, briefly backflushing the sample line.

Messages Displays system messages.

Control Description
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Sortview pane
Introduction This topic describes the Sortview pane and how to use it to 

monitor your sort.

About the Sortview 
pane

Sortview is a pane within BD FACS Sortware. Sortview displays 
three different images (pinhole, drop, and sort stream) on the 
computer screen that are taken from the cameras on the 
BD FACSJazz system. These images are used in sort monitoring as 
well as in system QC and alignment.

The Sortview pane opens when BD FACS Sortware software is 
started.

Pinhole image

Drop image

Sort stream image
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Monitoring sorts 
with the Sortview 
pane

To monitor sorts with Sortview:

1. View the images from the BD FACSJazz cameras displayed in 
the Sortview pane.

2. Resize the window as needed. 

The camera displays will arrange themselves horizontally if the 
window is stretched horizontally. 

The following table describes what each image displays.

3. Click each image to zoom, if needed.

More information • Sample introduction (page 33)

• Sort components overview (page 56)

• BD FACS Sortware overview (page 86)

Display Description

Pinhole image Displays an image of the pinholes.

Drop image Displays an image of the stream breakoff.

Sort stream image Displays an image of the side streams and 
the stream drain.
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Preferences and settings

This chapter includes these topics:

• Setting up your window layout (page 98)

• Editing user preferences (page 101)

• Setting cytometer preferences (page 102)

• Setting gate and population display preferences (page 105)

• Setting plot display preferences (page 107)

• Setting statistics view display preferences (page 108)

• About settings files (page 110)

• Working with settings files (page 113)

• Creating storage folders (page 116)
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Setting up your window layout
Introduction This topic describes how to set up and customize the 

BD FACS Sortware window layout. 

You can open different panes within the BD FACS Sortware 
window and drag and dock them to different locations, or create 
standalone (floating) panes.

Undocking and 
docking panes

To undock panes:

1. Click in the title bar area of any docked pane and drag the 
pane away from its docked location. 

The pane becomes a floating pane.

To dock a floating pane to a new location in the workspace:

1. Drag the floating pane to where you want to dock it.

Docking targets appear when floating panes are dragged near 
a dockable location.

An undocked pane

Title bar
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2. Drag the floating pane over the docking target.

3. When the area where you are docking highlights, release the 
mouse button.

The floating pane docks in the direction of the arrow on the 
docking target.

Changing themes To change the window theme:

1. Select Windows > Themes.

2. Select the default or other available window theme.

Docking target

Floating pane
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Saving the window 
layout

To save the current window layout:

1. Select Windows > Save Window Layout.

The Save Window Layout dialog opens.

2. Select the storage folder where you want to save this layout 
from the Storage menu.

3. Under Window Layout Details, type a name for the new 
window layout in the Name field.

4. Click OK to save the window layout and close the dialog.

Restoring the 
window layout

To restore the window layout:

1. Select Windows > Restore Window Layout.

The Restore Window Layout dialog opens.
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2. Select the storage folder that contains the file you want to 
restore (default or a user-defined storage folder) from the 
Storage menu.

3. Under Window Layout List, select a layout to restore.

4. Click OK.

More information • Preferences and settings (page 97)

• Editing user preferences (page 101)

• About settings files (page 110)

• Working with settings files (page 113)

Editing user preferences
Introduction This topic describes how to edit user preferences for gates, plots, 

statistical displays, acquisition, and the cytometer using the Edit 
User Preferences dialog.

Preferences are not required. You can set preferences at any time 
and in any order. If you do not specify preferences, default settings 
are used.

User preferences You can perform the following user preferences tasks:

• Setting cytometer preferences (page 102)

• Setting gate and population display preferences (page 105)

• Setting plot display preferences (page 107)

• Setting statistics view display preferences (page 108)
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More information • Preferences and settings (page 97)

• About settings files (page 110)

• Working with settings files (page 113)

Setting cytometer preferences
Introduction This topic describes how to specify:

• The display of a parameter name

• How plots are used

• How the cytometer updates at startup

• The sort tray direction

These are global settings. You can use the default values or set 
custom preferences as needed.

Procedure To set cytometer preferences:

1. Select Edit > Preferences.

The Edit User Preferences dialog opens.
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2. Click the Cytometer tab.

3. Set cytometer preferences.

• Under Parameters, select the Show Parameter’s Full Name 
checkbox to display the full fluorochrome/parameter name 
in plots and statistics views.

• Under Plot/Views, select Set Cytometer Plots/Views as 
Global.

All worksheet elements (plots, population hierarchies, 
statistics views) with Cytometer as the data source show 
data from a single file (the file selected in the Data Sources 
pane). Use this to quickly view all the data from a file. 
Non-global worksheet elements (those showing data from 
a file other than the file selected in the Data Sources pane) 
can still be added to the worksheet when this option is 
selected.

See Worksheet overview (page 140) for more information.
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• Under Cytometer Settings/Update at Startup, select a 
startup option.

• Under Sort Tray Direction, select a tray sort direction. 

4. Click OK to apply your preferences.

More information • Preferences and settings (page 97)

• Setting gate and population display preferences (page 105)

• Setting plot display preferences (page 107)

• Setting statistics view display preferences (page 108)

Option Description

Get Current Cytometer 
State

Gets the current instrument state from the cytometer 
interface. This does not include parameter names or 
labels.

Restore Laser and 
Parameter Names

Gets the current instrument state from the cytometer 
interface and restores parameters and laser names.

Restore Full Cytometer Restores the cytometer settings to the settings from the 
last time the system was used.

Option Description

Optimized (Serpentine) Sets the sort tray sorting direction to move in a serpentine 
motion: A1 to A12, B12 to B1, etc.

Left to Right Sets the sort tray sorting direction to move left to right.

Top to Bottom Sets the sort tray sorting direction to move top to bottom.
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Setting gate and population display preferences
Introduction This topic describes how to set gate and population display 

preferences.

These are global settings. You can use the default values or set 
custom preferences whenever you want to modify the appearance 
of gates and populations.

Procedure To set the default gate and population colors:

1. Select Edit > Preferences. 

The Edit User Preferences dialog opens.

2. Click the Gating tab.

3. Click in the Gates field and enter a new default name for any 
of the gates (populations) in the list.

4. Right-click a colored box next to a gate (population) in the list 
(for example, P1).
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The Color Picker dialog opens.

5. Click on a color sample in the Color Picker dialog or click 
Advanced Colors to create a custom color sample. 

The selected color appears in the Color sample at the bottom 
of the dialog.

6. Close the dialog to apply the color.

7. Click OK to apply your preferences.

More information • Preferences and settings (page 97)

• Setting cytometer preferences (page 102)

• Setting plot display preferences (page 107)

• Setting statistics view display preferences (page 108)
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Setting plot display preferences
Introduction This topic describes how to set the plot background, display 

attributes, and label fonts.

These are global settings. You can use the default values or set 
custom preferences whenever you want to modify the appearance 
of plots.

Procedure To set the plot background and the plot label fonts:

1. Select Edit > Preferences.

The Edit User Preferences dialog opens.

2. Click the Plots tab.
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3. Make plot display selections:

• Under General, right-click the color sample for one of the 
options to open the color picker and select colors for the 
plot frame background, the plot area background, text, and 
tick marks. You can also set the level of transparency and 
show the plot border as full or half.

• Under Title, modify the plot title font face, font size, or 
make the title invisible.

• Under Axis/Tick, modify the axis label font face, axis size, 
tick mark size, or make these elements invisible. 

4. Click OK to apply your preferences.

More information • Preferences and settings (page 97)

• Setting cytometer preferences (page 102)

• Setting gate and population display preferences (page 105)

• Setting statistics view display preferences (page 108)

Setting statistics view display preferences
Introduction This topic describes how to set statistics view display preferences. 

Statistics views contain summary data for plots and populations. 
These views include the population hierarchy and statistics box 
and appear in the worksheet. They can be saved or printed.

These are global settings. You can use the default values or set 
custom preferences whenever you want to modify the appearance 
of statistics views.

Procedure To set statistics view display preferences:

1. Select Edit > Preferences.

The Edit User Preferences dialog opens.
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2. Click the Views tab.

3. Make statistics views selections:

• Under General, select or clear the Show population 
hierarchy/statistics view border checkbox to show or hide 
the border for the statistics view.

• Under Header, modify the statistics view header font face, 
size, or color. 

• Under Table, modify the table text display font face, size, 
or color.

4. Click OK to apply your preferences.

More information • Preferences and settings (page 97)

• Setting cytometer preferences (page 102)

• Setting gate and population display preferences (page 105)

• Setting plot display preferences (page 107)
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About settings files
Introduction This topic describes settings files and the different settings that can 

be saved and restored in them.

Settings files When you start BD FACS Sortware, all settings display default 
selections. To apply specific values or layouts, you can restore these 
settings from a saved settings file.

Settings that can 
be restored

The settings that can be restored are:

• Workspace 

• Cytometer settings

• Analysis templates

• Sort layouts

• Window layouts

• Compensation settings

Workspace settings The following elements are saved with a workspace:

• Cytometer settings

• Compensation

• Analysis template

• Sort layout

• Window layout

• Data sources

• Gates

• Fluidics setup

You can restore a previously saved workspace or the workspace 
that was automatically saved the last time you closed the software 
(Workspace on Exit).

Data sources, Gates, and Sort settings are only saved with the 
Workspace.
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When you restore a workspace, you can select any of the following 
options.

Cytometer settings When you save cytometer settings, you save all settings in the 
Cytometer Settings pane. These settings are also saved with a saved 
workspace. You can restore these cytometer settings separately or 
when you restore a workspace.

If you select... The following data is restored...

Restore Cytometer Settings: 
Laser and Parameter Names

 Laser names

 Detector names

 Detector labels

Restore Cytometer Settings: All 
Settings

All settings in the Cytometer Settings pane. Laser delays 
can be excluded from the cytometer settings restore, if 
desired, by clearing the Restore Laser Delays checkbox.

Restore Compensation  Compensation matrix

 Logicle scaling

Restore Data Sources Any data sources recorded in a saved workspace

Restore Gates Any gates (local and global) 

Note that gates are automatically restored if data sources 
are restored.

Restore Analysis Template  Worksheet settings

 Analysis elements

Restore Sort Layout Sort Layout pane (except the piezo amplitude value)

Restore Window Layout Pane presence, docking, and position

Restore Fluidics Setup Piezo amplitude, drop frequency, stream focus, drop 
charge, drop delay, and laser intercept
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Analysis template 
settings

When you save an analysis template, you save the current 
worksheet settings and analysis elements (plots, population 
hierarchies, statistics views). When you restore an analysis 
template, you can select one of the following options.

Sort layout settings When you save or restore a Sort layout, you save or restore the 
current settings from the Sort Layout pane.

Window layout 
settings

When you save a window layout, you save the current window 
layout and pane locations. You can restore the saved layout, a 
default layout, or the window layout that was automatically saved 
the last time you closed the software (Window Layout on Exit).

See Setting up your window layout (page 98) for more 
information.

If you select... Then...

Replace Current Analysis The current analysis is replaced by the saved analysis.

If you clear the checkbox, the current analysis remains and 
the restored analysis is added to a new page.

Restore Worksheet 
Preferences

All worksheet settings in the Inspector pane except scale and 
number of pages are restored.
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Compensation 
settings

After you have calculated compensation, you can save the 
compensation by right-clicking the Cytometer data source. You 
can restore the compensation matrix to other FCS files in the Data 
Sources pane by right-clicking Restore Compensation.

More information • Working with settings files (page 113)

• Creating storage folders (page 116)

Working with settings files
Introduction This topic describes how to save, overwrite, restore, and delete 

settings files.

Saving settings 
files

You can save settings at any time. Workspaces and window layouts 
are automatically saved when you exit BD FACS Sortware.

To save settings:

1. Select File > Save, then select a settings file type.

The selected save dialog opens.
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2. Select the storage folder where you want to save this settings 
file from the Storage menu.

See Creating storage folders (page 116) for more information 
about creating custom storage folders.

3. Type a name for the new settings file in the Name field.

4. Click OK to save the settings and close the dialog.

Overwriting a 
saved settings file

To overwrite a setting that you have already saved:

1. Select File > Save.

2. Select the name of the settings file and click OK.

3. Click Yes to confirm the overwrite.
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Restoring settings 
files

To restore a settings file:

1. Select File > Restore, then select a settings file type.

The selected restore dialog opens.

2. Select the storage folder that contains the file you want to 
restore (Default or a user-defined storage folder) from the 
Storage menu.

3. Select a file to restore. 

4. Click OK to open the settings file and apply all settings.

Deleting saved 
settings files

To delete saved settings files:

1. In the list of settings files, click the red X for the settings file 
you want to delete. 

The Confirm Deletion dialog opens.

2. Click Yes to delete the cytometer settings file.

3. Click OK to close the dialog.

More information • Setting up your window layout (page 98)

• About settings files (page 110)

• Creating storage folders (page 116)

• Preparing beads for QC (page 276)
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Creating storage folders
Introduction This topic describes how to create custom storage folders for 

settings files. 

Procedure To create new storage folders for user-defined settings:

1. Select File > Save and select a settings file.

The selected save dialog opens.

2. Click Add New Storage Location. 

The Create Storage Location dialog opens.

3. In the Name field, type a name for the new storage folder.

4. Click OK.

The new storage folder appears in the Storage field.

More information • About settings files (page 110)

• Working with settings files (page 113)
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Cytometer settings

This chapter describes the different adjustment, customization, and compensation tasks 
you can perform using the Cytometer Settings pane. These tasks are not typically 
performed as a part of the daily workflow and can be performed as needed.

This chapter includes these topics:

• Using the Cytometer Settings pane (page 118)

• Viewing the cytometer status (page 119)

• Assigning fluorochrome labels to detectors (page 120)

• Selecting amplification preferences (page 122)

• Powering the PMTs on and off (page 123)

• Adjusting PMT voltages and using optional integrators (page 125)

• Selecting channels to capture (page 129)

• Viewing cytometer details (page 130)

• Using the Compensation pane (page 131)

• Using the Logicle Scaling pane (page 136)

Other related information:

• Preferences and settings (page 97)
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• Alignment and QC (page 267)

• Optimizing system settings for samples (page 295)

Using the Cytometer Settings pane
Introduction This topic describes the Cytometer Settings pane and the functions 

of the different tabs.

Description Use this pane to view the status or modify the laser and detector 
settings of the cytometer. You can also view the integrator board 
options.
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This pane includes the following tabs:

More information • Viewing the cytometer status (page 119)

• Integrators (page 368)

Viewing the cytometer status
Introduction This topic describes how to view the current cytometer status and 

any cytometer error conditions, and how to clear the status logs. 

Viewing the 
cytometer status

To view the cytometer status:

1. Click Cytometer Settings on the BD FACS Sortware toolbar to 
display the Cytometer Settings pane.

Tab Description

Lasers/Detectors Use this tab to view and modify triggers, laser names and delays, 
detectors, power, voltage, scale, and labels.

Integrators Use this tab to view any optional integrators. Integrators measure the 
area and the width of a voltage pulse for selected parameters. 

Status Use this tab to view the current status of the cytometer and any error 
conditions.
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2. Click the Status tab. 

The current cytometer status is listed by date and time.

Clearing the status 
logs

To clear the status logs:

1. In the Status tab, click Clear. 

The status screen refreshes and all status messages are cleared. 
New status messages appear in the Status tab if any new errors 
have occurred.

More information • Using the Cytometer Settings pane (page 118)

Assigning fluorochrome labels to detectors
Introduction This topic describes how to assign fluorochrome labels to specific 

detectors. 

The label identifies how the detector is being used for a specific 
configuration and creates a more descriptive parameter label 
whenever the detector is used in a plot.
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Procedure To assign a fluorochrome label to a detector:

1. On the toolbar, click Cytometer Settings to display the 
Cytometer Settings pane.

2. In the Lasers/Detectors tab, locate the detector you want to 
configure in the Detectors list.

You can click the down or up arrows in the laser bar to expand 
or collapse the list.

3. In the Label field, type a fluorochrome name.

The fluorochrome label appears in the parameter label in a 
plot.

More information • Using the Cytometer Settings pane (page 118)
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Selecting amplification preferences
Introduction This topic describes how to set linear or logarithmic amplification.

About 
amplification 
preferences 

The amplification preference sets the scale for plots. The 
instrument is pre-configured for linear (lin) signal amplification for 
scatter detectors and logarithmic (log) amplification for 
fluorescence detectors. 

Lin amplification is typically used whenever you use the FSC and 
SSC detectors and log amplification is used for all other 
fluorescence channels to provide a wider range of intensities. 
However, depending on your application, you may want to use log 
amplification with the FSC and SSC detectors to achieve higher 
resolution on the lower end of the scale and/or lin amplification for 
other fluorescence channels.

Procedure To change lin or log settings:

1. On the toolbar, click Cytometer Settings to display the 
Cytometer Settings pane.

2. In the Lasers/Detectors tab, locate the detector you want to 
configure in the Detectors list.

You can click the down or up arrows in the laser bar to expand 
or collapse the list.
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3. Select the Log checkbox to enable logarithmic amplification, 
or clear it to enable linear amplification.

More information • Assigning fluorochrome labels to detectors (page 120)

• Adjusting PMT voltages and using optional integrators 
(page 125)

Powering the PMTs on and off
Introduction This topic describes how to power all the PMTs on and off and 

how to power off individual PMTs. 

PMTs are automatically powered on or off based on the user 
preferences selected when you open BD FACS Sortware. Power off 
all the PMTs for maintenance purposes.

Powering all PMTs 
on or off

To power all the PMTs on or off:

1. Click Cytometer Settings on the BD FACS Sortware toolbar.

The Cytometer Settings pane opens.

2. Click the Lasers/Detectors tab.

3. Click PMT Power to toggle all the power buttons on or off.
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When the power to a PMT is on, the PMT power button is 
green. When the power is off, the button is gray.

PMT 
power off

PMT 
power on
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Powering off 
individual PMTs

If you do not want all PMTs on, you can selectively power off 
individual PMTs.

To power off individual PMTs:

1. In the Lasers/Detectors tab, click the power button for any 
individual detectors you want to power off.

Click the button again to turn it back on.

More information • Assigning fluorochrome labels to detectors (page 120)

• Adjusting PMT voltages and using optional integrators 
(page 125)

Adjusting PMT voltages and using optional 
integrators
Introduction This topic describes how to adjust PMT voltages and set laser 

delays using the Cytometer Settings pane. 

You can adjust voltages at any time. However, adjustment is 
typically performed after you create plots and while acquiring 
data.
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Procedure To adjust PMT voltages:

1. Click Cytometer Settings on the BD FACS Sortware toolbar.

The Cytometer Settings pane opens.

2. Click the Lasers/Detectors tab.

3. In the Detectors list, locate the detector you want to set.

You can click the down or up arrows in the laser bar to expand 
or collapse the list.

4. Adjust the values by using the mouse scroll wheel, small 
arrows, data slider, or keyboard keys. 

See Setting numeric values in panes and dialogs (page 90) for 
more information.
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You can also use the data sliders in the plot to perform a 
coarse voltage adjustment. You need to place the mouse cursor 
over the plot axes to make the sliders visible.

5. Adjust the laser delay in the Delay field using the mouse scroll 
wheel, data slider, or keyboard keys. 

See Setting numeric values in panes and dialogs (page 90) for 
more information.

Integrators tab Integrators are designed for use with linear events. They measure 
the area and the width of a voltage pulse for selected parameters 
and work in parallel with the height and peak measurements. You 
can select to enable or disable integrators as needed. The settings 
become the default but can be changed at any time. You can apply 
different integrators to different plots within the same worksheet.

Plot axis data sliders
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Turning integrators 
on

To turn the integrators on:

1. Click the Integrators tab in the Cytometer Settings pane. 

2. Select a parameter from the ADC Intercept menu to turn the 
integrators on. 

3. Set the gain to 1.0 initially and adjust as needed depending on 
your sample.

Area and width for the selected parameter are now available to 
view in a plot.

More information • Collection optics (page 49)

• Integrators (page 368)
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Selecting channels to capture
Introduction This topic describes how to select channels in the Cytometer 

Configuration dialog.

The default channel configuration enables all available channels 
for every sort, even if channels are not being used for specific 
samples. This results in a long list of available parameters for each 
plot. 

Select only specific channels each time you run samples to 
minimize the list of available parameters. 

Procedure To select specific channels to capture:

1. Select Cytometer > Configuration. 

The Cytometer Configuration dialog opens.

2. In the Channels tab, select the appropriate checkboxes. 

Select the Capture checkboxes only for channels that you want 
to capture with the current set of samples.
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3. If some integrators are turned on, click the Integrators tab and 
select the integrators that you want to capture.

4. Click OK to apply your preferences and close the dialog.

More information • Viewing cytometer details (page 130)

• Resizing plots (page 189)

Viewing cytometer details
Introduction This topic describes how to open the Cytometer Details dialog to 

view information about the cytometer configuration. 

This information is also displayed on the sort report header.

Procedure To open the Cytometer Details dialog:

1. Select Cytometer > Details.

The Cytometer Details dialog opens.

These values are for informational purposes only. The settings 
are displayed on the sort report.

2. Click OK to close the dialog.
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More information • Working with sort reports (page 340)

Using the Compensation pane
Introduction This topic describes the Compensation pane and related tabs and 

dialogs used to create a compensation matrix and calculate 
spillover values.

About 
compensation

To create a compensation matrix and calculate compensated 
values, you need to collect single- or multicolor control data using 
ADCs, identify populations as positive or negative, and calculate 
the results to determine spillover values for each fluorochrome you 
plan to use. BD FACS Sortware uses the calculated values (matrix) 
and automatically applies compensation to minimize fluorescence 
spillover. 

You can view your compensated data on ADC parameters, but to 
sort with these compensated values, you need to create sort gates 
using digital signal processors (DSPs) as your parameters. Altering 
or applying a new compensation matrix to previously recorded 
files will not change the compensated events in the DSP parameters 
(including files with no compensation matrix defined). However, 
you can view alternate compensation with ADC parameters.

If no compensation matrix was defined for a recorded file, all DSP 
parameters will be available to view (regardless of ADC capture 
status) and the DSP values for a given parameter will match the 
ADC values in the same parameter.
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Once a compensation matrix is defined on the cytometer, DSP 
parameters in the subsequent recorded files will display only the 
compensation-defined parameters.

DSP parameters ADC parameters

Uncompensated Data
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Creating a 
compensation 
matrix

To create a compensation matrix: 

1. Click Compensation on the BD FACS Sortware toolbar.

Compensated Data

DSP parameters ADC parameters
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The compensation matrix displays the spillover values for each 
compensated parameter.

2. In the Matrix tab, set the following properties.

Properties Description

Data Source Select a data source for compensation.

Visualize Select this checkbox to view the software compensation for 
ADCs in the plot.

Manage Parameters Click to display the Select Compensation Parameters dialog. 

Clear Click to clear the values in the compensation matrix.

Values in the matrix Manually adjust compensation values if needed.
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3. In the Auto Compensation tab, set the following properties.

More information • BD FACS Sortware overview (page 86)

Properties Description

Negative Select and drag, or right-click and select the ADC parameters 
that correspond to a negative control. You can drag a 
universal negative population on top of the negative header 
to populate all negative boxes.

Positive Select and drag, or right-click and select the ADC parameters 
that correspond to a positive control.

Calculate Click to calculate compensation values after positive and 
negative populations have been assigned.

Reset Clears all the selected populations.
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Using the Logicle Scaling pane
Introduction This topic describes the Logicle Scaling pane. 

Use the logicle scale after compensation has been applied to view 
any events with negative values. This is useful when evaluating the 
compensation matrix.

Description After compensation, populations can include low mean values and 
negative values. Using a logarithmic scale, plots display a wide 
range of event data. However, they do not properly display events 
that have compensated low mean values, high variances, or 
negative values. 

Logicle scaling is available only when viewing ADC-compensated 
data.

Procedure To calculate logicle display for the data:

1. In the Compensation pane, select the data source that you 
want to view logicle scaling on (the data source must have a 
compensation matrix).

2. Select the Visualize checkbox.
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3. In the Data Sources pane, select the data source that you want 
to perform logicle scaling on.

4. Click Calculate Scales to calculate the logicle display for the 
data. 

You can adjust the R Factor (logical scale ratio) for each 
parameter to include negative or positive outliers in the plot to 
display data that conveys full and accurate information about 
the distributions of the events.

5. To view the logicle scale on a plot (which must be an ADC 
plot), select the plot and then open the Inspector pane.
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6. Select Logicle from the Scale field under X Parameter or Y 
Parameter.

The following figure shows a plot in log scale and a plot in 
logicle scale.

More information • Software overview (page 85)

• Setting numeric values in panes and dialogs (page 90)

• Using the Compensation pane (page 131)

Log scale Logicle scale
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Worksheets

This chapter includes these topics:

• Worksheet overview (page 140)

• Creating a worksheet layout (page 144)

• Customizing worksheet properties (page 146)

• Aligning and distributing worklist items (page 149)

• Magnifying (scaling) analysis elements on a worksheet (page 150)
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Worksheet overview
Introduction This topic provides an overview of worksheet elements, layouts, 

and how to manage multiple worksheets.

Description A worksheet contains all analysis elements including plots, gates, 
and statistics views. A new (blank) worksheet opens each time you 
start BD FACS Sortware. You can save and restore a worksheet 
with its analysis elements as an analysis template. 

Worksheet layouts A worksheet layout is created from a blank worksheet by adding 
plots, gates, population hierarchies, and statistics views that 
display your data. 
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Worksheet tools The Worksheet toolbar provides tools for creating plots and gates, 
managing multiple worksheets, and organizing worksheet items.
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See Creating plots in a worksheet (page 175) for more information 
about using worksheet tools to create plots. See Gating overview 
(page 196) for more information about using worksheet tools to 
create and modify gates.

Analysis templates You can save and restore analysis templates, and then modify the 
plots, histograms, gates, and statistics views to suit your needs.

Worksheet pages You can create multiple pages in each worksheet and modify the 
size, distribution, alignment, magnification, and properties details 
of all elements on each page of a worksheet.

Undo and redo 
functions

You can undo and redo most actions (for example, adding or 
deleting any worksheet elements or changing Inspector properties) 
when working with the worksheet. 

To undo an action: 

1. Select Edit > Undo. 

To redo an action:

1. Select Edit > Redo. 

You can perform multiple undos and redos. 

Alignment tools Distribution tools

Printing tools Worksheet and page view/control tools

Plot/gate zoom tools Selection tools

Plot tools Gate tools
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Defining a global 
worksheet

Individual worksheet elements (plots, hierarchies, and statistics 
views) are linked to one data source (cytometer for real-time data, 
or an FCS file). When you select Set Cytometer Plots/Views as 
Global in the Edit User Preferences dialog, all worksheet elements 
with cytometer as the data source display data from an FCS file. 
Use this preference to quickly view data from multiple FCS files.

To use cytometer plots/views as global worksheet elements:

1. Select Edit > Preferences.

2. Click the Cytometer tab.

3. Select the Set Cytometer Plots/Views as Global checkbox. 

4. Create plots, hierarchies, or statistics view with Cytometer 
selected in the Data Sources pane.

With this feature selected, the FCS files in the Data Sources 
pane will have an eye icon beside them if the files were 
collected using the same configuration as the cytometer data 
source. You can now select any FCS file with an eye icon and 
the data will be displayed in the worksheet. 

Note that the title of the plot is italicized. This indicates that 
the Set Cytometer Plots/Views as Global option is selected.

If the Set Cytometer Plots/Views as Global is not selected, the 
plots are specific to the FCS file selected during plot creation. 

Eye icon
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To change the plots to the same FCS file:

1. Select all plots.

2. In the Inspector pane, select the FCS file from the Source field. 

More information • Creating a worksheet layout (page 144)

• Customizing worksheet properties (page 146)

• Aligning and distributing worklist items (page 149)

• Magnifying (scaling) analysis elements on a worksheet 
(page 150)

• Using the Inspector to view and modify plot properties 
(page 176)

Creating a worksheet layout
Introduction This topic describes how to create a worksheet layout from a blank 

(default) worksheet. 

A blank worksheet opens in the window each time you start 
BD FACS Sortware.

Creating a new 
worksheet layout

To create a new worksheet layout:

1. Add analysis elements to the worksheet:

a. Click a plot tool on the Worksheet toolbar to add plots.

You can add multiple plots to each worksheet.

b. Click a gate tool on the Worksheet toolbar to add gates to 
the plots and define populations.

c. Right-click the plot and select Statistics View to create a 
statistics view of the plot data.
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d. Right-click the plot and select Population Hierarchy to 
create a population hierarchy of the plot data.

Adding pages to a 
worksheet

To add pages to a worksheet:

1. Click Add Page on the Worksheet toolbar. 

The page is added after the last page in the worksheet.

Plot

Gate

Statistics 
view
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Deleting pages 
from a worksheet

To delete pages from a worksheet:

1. In a multipage worksheet, scroll or click Go to locate the page 
you want to delete.

2. Right-click the page and select Delete Page.

3. Click Delete Last Page on the Worksheet toolbar to delete the 
last page from the worksheet.

Deleting analysis 
elements 

To delete analysis elements (plots, gates, histograms, statistics 
views) from a worksheet:

1. Right-click an analysis element in the worksheet and select 
Delete. 

The analysis element is deleted. You can select multiple items 
at once to delete.

More information • Creating plots in a worksheet (page 175)

• Gating overview (page 196)

• Displaying a statistics view (page 222)

Customizing worksheet properties
Introduction This topic describes how to customize worksheet properties.

Customizing 
worksheet 
properties using 
the Inspector or the 
Worksheet toolbar

To customize worksheet properties using the Inspector or the 
Worksheet toolbar:

1. Click on a blank area of the worksheet.

2. Click Inspector on the BD FACS Sortware toolbar.
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The Inspector opens.

3. Under General, select a display scale from the Scale menu. 

The default is 100%.

4. In the Pages field, specify the number of pages in the 
worksheet. 

5. Select a horizontal or vertical page layout from the Layout 
menu or use the worksheet toolbar.

6. Select True from the Grid menu to display a grid on the 
worksheet pages or select False to display the worksheet pages 
without a grid. 

You can also use the toolbar menu to toggle the grid on or off.
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Customizing 
worksheet headers 
and footers

To customize worksheet headers and footers:

1. In the Inspector pane, click the Headers or Footers tab.

2. Select the header and footer properties.

• Select the Visible checkbox to display a header or footer on 
the worksheet.

• Select the Border checkbox to display a border around the 
header or footer.

• Under Left, Center, and Right, select the elements you want 
to include in Line 1 and Line 2. You can also type in the 
field to enter information.
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More information • Worksheet overview (page 140)

• Aligning and distributing worklist items (page 149)

Aligning and distributing worklist items
Introduction This topic describes how to align and distribute plots, histograms, 

statistics, and other items on a worksheet. 

You can drag items to different locations within a worksheet.

Aligning items To align items on a worksheet:

1. Click the item you want to use as the anchor item.

2. Ctrl+click the other items you want to align to the anchor 
item.

3. Click an alignment tool on the Worksheet toolbar (left, top, 
right, bottom, center horizontal, or center vertical). 

Distributing items To evenly distribute items on a worksheet:

1. Click the item you want to use as the anchor item.

2. Ctrl+click the other items you want to distribute evenly 
around the anchor item.

3. Click a distribute tool on the Worksheet toolbar. 



BD FACSJazz User’s Guide150

You can distribute selected objects horizontally, vertically, or 
both. 

When distributing in both directions, the selected objects are 
evenly spaced. The objects are not resized.

More information • Worksheets (page 139)

• Magnifying (scaling) analysis elements on a worksheet 
(page 150)

Magnifying (scaling) analysis elements on a 
worksheet
Introduction This topic describes how to enlarge or shrink the size of analysis 

elements on the worksheet. 

Zooming in and out You can select an area within a plot and enlarge the image. You 
can zoom multiple times. Tick marks on the axes of the plot adjust 
to reflect the zoomed view. 

Zoom tools



Worksheets 151

1. To zoom in or out:

2. Complete one of the actions in the following table. 

You must have the plot selected to use the zoom out or clear 
buttons.

More information • Worksheet overview (page 140)

• Creating a worksheet layout (page 144)

• Resizing plots (page 189)

To... Do this...

Zoom in on an area in a 
plot

1. Click Zoom In on the Worksheet toolbar.

2. Select an area in the plot that you want to zoom in on 
using the mouse.

Zoom out 1. Click Zoom Out on the Worksheet toolbar.

Clear the zoom 1. Click Clear Zoom on the Worksheet toolbar.
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Acquisition and recording tools

This software reference chapter describes the tools used to select a data source, set the 
data recording details, acquire, and record. 

This chapter includes these topics:

• Using the Data Sources pane (page 154)

• Using the Recording Settings pane (page 162)

• Using the Acquisition Dashboard (page 166)

Other related information: 

• Alignment and QC (page 267)

• Optimizing system settings for samples (page 295)

• Sorting (page 319)
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Using the Data Sources pane
Introduction This topic describes how to use the Data Sources pane to view data 

and information from the cytometer or recorded data sources (FCS 
files). 

The Data Sources pane also allows you to browse and import FCS 
files.

About the Data 
Sources pane

From the Data Sources pane, you can double-click the data source 
and open the following:

• FCS keyword browser

• Compensation matrix

• Index sort analysis

You can also right-click the data source in the Data Sources pane 
to:

• Create sort gates, which are gates that identify events that were 
or are being sorted

• Save and restore compensation

• Export BD FACSDiva™–compatible software files

• Export FCS files in comma separated value (CSV) format

• Remove (delete) the data source from the Data Sources pane



Acquisition and recording tools 155

Data sources tabs This pane has two tabs:

• Data Sources. This tab displays a cytometer (real-time) source 
and the current FCS (recorded) file or other saved FCS files 
that you add to the list. BD FACS Sortware supports FCS v3.0 
format.

• Directory. This tab displays the directory you can use to locate 
recorded FCS data files and to select FCS files to add to the 
Data Sources list.

Viewing cytometer 
and FCS file 
information

To open the FCS keyword browser:

1. In the Data Sources tab, double-click the tube icon or FCS file.
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The FCS Keyword Browser opens.

To open the compensation matrix:

1. In the Data Sources tab, double-click Compensation beneath 
the FCS file.
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The compensation matrix opens.

To open the Index Sort Analysis and Report dialog: 

1. In the Data Sources tab, double-click the Index Sort Analysis 
beneath the FCS file.
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The Index Sort Analysis and Report dialog opens.

Selecting, 
importing, and 
deleting FCS files in 
the Data Sources 
pane

When you first open the software or restore a settings file, 
Cytometer is selected as the default data source. At any time, one 
data source is always selected in the Data Sources pane.

To select an FCS file as the data source:

1. Click an FCS file in the list to display collected (recorded) data 
for analysis.

FCS files only appear in the list when you record acquired data 
or when you import an FCS file.

Importing FCS files 
as data sources

To import FCS files as data sources:

1. If the FCS file you want to use is not in the list, click the 
Directory tab and navigate to the folder that contains your 
FCS files.

2. Double-click the file you want to add to the Data Sources tab.



Acquisition and recording tools 159

A disk icon appears next to the FCS files that were added to 
the list.

3. To import multiple FCS files at the same time, select the files, 
right-click, and then select Import Data Source.

Removing an FCS 
file from the Data 
Sources tab

To remove an FCS file from the Data Sources tab:

1. Right-click the file name and select Remove.
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Viewing data 
source details

To view data source details using the Inspector:

1. Click Inspector on the BD FACS Sortware toolbar.

2. Select the cytometer or an FCS data source in the Data Sources 
pane. 

The Inspector displays the data source details.

Cytometer data sources details display the name, label, scale, 
data type, and voltage values for all current parameters for this 
cytometer.

FCS data source details display the name, location, and 
number of recorded events, keywords, keyword values, and 
the parameter settings. The parameter settings are the settings 
used during recording.

If you want to change the recording preferences or keywords 
before you record an FCS file, you need to use the Recording 
Settings pane.

Details for the Cytometer data source Details for an FCS file data source
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Exporting FCS files FCS files can be exported as BD FACSDiva–compatible files or as 
CSV files.

To export FCS files compatible with BD FACSDiva software:

1. In the Data Sources tab, right-click the FCS file you want to 
export.

2. Select Export Diva Compatible FCS File. 

The Save Diva Compatible FCS dialog opens.

3. Navigate to the target export folder, then click Save.

To export FCS files in CSV file format:

1. In the Data Sources tab, right-click the FCS file you want to 
export.

2. Select Export FCS File in CSV format.

The Save CSV File dialog opens.

3. Navigate to the target export folder, then click Save.

More information • Using the Recording Settings pane (page 162)

• Using the Acquisition Dashboard (page 166)
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Using the Recording Settings pane
Introduction This topic describes the Recording Settings pane and how to set 

recording properties.

Description Use the Recording Settings pane to set specific recording and 
keyword properties before you record data to set details about the 
FCS file that is generated during recording.

This pane has two tabs. Use the Recording tab to set the default 
display count (total events to display), name the FCS file, and set 
the default location for the FCS files. Use the Keywords tab to 
define values for keywords in the FCS file.

Certain elements of the Recording Settings pane can be minimized. 
Click the arrow button to hide or show these elements.
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Setting recording 
properties

To set recording properties:

1. Click Recording on the BD FACS Sortware toolbar. 

The Recording Settings pane opens.

2. Click the Recording tab.

3. Under Display Buffer, select an event display count from the 
Default Display Count menu.

The default display count determines the number of events to 
display in cytometer plots. You can modify the display count 
for individual plots in the Plot Properties Inspector. However, 
the default display count setting determines the maximum 
display count that can be selected (up to 1,000,000 events). 
The default display count does not apply to plots made with 
existing FCS files. 

4. Under FCS File, set the following properties for the FCS file 
that is generated when you record data.

Property Description

Path Click Path to select a storage location for the 
generated FCS file.

File Click File to view which FCS files have been recorded 
or to select an existing FCS file to append or 
overwrite.

File field Enter a file name for an FCS file.

Prefix Enter a prefix for the FCS files (for example, Presort).
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The recording progress bar appears at the bottom of the pane 
and displays the current recording progress.

5. Under Recording Rule, set the following properties.

Property Description

Event Limit Select the event limit (total events collected) as a 
stopping rule. 

Time (sec) Select the time-based stopping rule. 

Stopping 
Gate 

Select an available gate as a stopping gate. This 
indicates which gate to use to fulfill the event 
limit or time stopping rules.

Storage Gate Select an available gate as the storage gate. 
Indicates which gated data is saved in the FCS 
data file.

Recording 
progress bar
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Setting keyword 
values

To set keyword values that appear in the generated FCS file:

1. Click the Keywords tab.

2. Enter a value for each keyword name you want to include in 
the generated FCS file.

More information • Software overview (page 85)

• Using the Acquisition Dashboard (page 166)

• Viewing keywords with plots (page 193)
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Using the Acquisition Dashboard
Introduction This topic describes the Acquisition Dashboard and what data it 

displays. 

Description Use the Acquisition Dashboard to start or stop acquisition, record 
events, and monitor data acquisition details. The following figures 
show the controls and how they toggle between idle, acquisition, 
and recording modes.

Idle

During acquisition
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Acquisition 
controls

During recording the Acquisition Dashboard has the following 
controls.

Status display The Acquisition Dashboard counters are located to the right of or 
below the acquisition buttons.

Control Description

Starts acquisition and populates plots with data. During acquisition this 
button becomes the Stop button.

Stops the current acquisition or recording.

Clears the current acquisition data and status display. 

You can also press the F5 key to reset when acquiring with the cytometer 
selected in the data source.

Records the current acquisition data in an FCS file. After you record data, the 
FCS file appears in the Data Sources pane. This button is available only after 
you click Acquire.

Pauses the current acquisition or recording. This button is available only 
during acquisition or recording.

Resumes acquisition or recording after pausing.
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The counters display the following acquisition status.

More information • Using the Recording Settings pane (page 162)

• Sorting (page 319)

Status Description

Event Count Displays the total event count.

Event Rate Displays the current event rate.

Efficiency Displays the efficiency (accuracy) percentage of the acquisition: (total 
events – electronic aborts)/total events x 100.

Elapsed Time Displays the total elapsed time for acquisition.

CRC Errors Indicates cyclic redundancy check (CRC) errors. CRC notes any errors 
that occur during the data transmission process. 



12
Plots

This chapter includes these topics:

• Plot overview (page 170)

• Creating plots in a worksheet (page 175)

• Using the Inspector to view and modify plot properties (page 176)

• Modifying plot axis parameters (page 178)

• Modifying dot plot properties (page 180)

• Modifying density plot properties (page 181)

• Modifying contour plot properties (page 183)

• Modifying histogram properties (page 185)

• Creating histogram overlays (page 186)

• Resizing plots (page 189)

• Saving plots as images (page 191)

• Copying and duplicating plots (page 191)

• Viewing keywords with plots (page 193)
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Plot overview
Introduction This topic describes the types of plots you can create and the color 

display options.

Dot plots Dot plots display two-parameter data. Each dot in a dot plot 
represents one or more events. The dot location is defined by two 
values—one for each parameter.

Density plots Density plots display simulated three-dimensional events. They are 
similar to dot plots except that they use different colors to show 
the number of events. The position of each event on the X and Y 
axes reflects its parameter values. The color shows how many 
events fall at each position. 
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Contour plots Contour plots are graphical representations of two-parameter data 
in which contour lines show the distribution of events. Similar to a 
topographical map, contour lines show event frequencies as peaks 
and valleys.
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Histograms Histograms are graphical representations of a single parameter of 
data. The horizontal axis of the graph represents the signal 
intensity of the parameter, and the vertical axis represents the 
number of events (counts) or percentage of events. 

Plot overlays Plot overlays display gated populations or All Events of two or 
more FCS files (or the cytometer) as histogram layers. This allows 
direct comparison of events. Plot overlays are available only with 
histograms.

The following example shows a stained sample from a recorded 
FCS file (green) layered on an unstained sample from the cytometer 
(black).
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Cytometer plot 
with a target 
source

You can add a target source to a cytometer plot to compare live 
data to a specific target FCS file with the same parameters and 
sample type. The targets can provide an acceptable range of data 
or specific event clusters that you want to approximate with live 
data. The target source appears in gray as an overlay (bottom 
layer) in the plot. This is particularly useful for quality control 
(QC). Target sources are available only with cytometer dot plots.

The following figure shows live (black) events on top of FCS (gray) 
target events.
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Dot plot and 
histogram color 
display

Dot plots display all events as black dots by default. Gated 
populations in the dot plot appear in different colors. You can 
modify the color of the events in the Inspector pane or select 
different default colors in the Edit User Preferences dialog. 

Histograms display all events as black lines by default. You can 
modify the color of the events and overlay events in the Histogram 
properties tab of the Inspector pane. 

Density and 
contour plot color 
display

Density and contour plots use the following color type options: 

• Single color. The lowest level is the original population color 
and the colors fade toward white as levels increase.

• Multiple colors. The color shows how many events fall at each 
position by using a different color for each level. Colors range 
from dark blue (representing the lowest number of events) 
through the spectrum to red (representing the highest number 
of events). 

• Gray scale. Displays darker gray at lower levels and fades to 
white as the levels rise.

More information • Creating plots in a worksheet (page 175)

• Modifying dot plot properties (page 180)

• Modifying contour plot properties (page 183)

• Creating histogram overlays (page 186)

• Modifying density plot properties (page 181)
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Creating plots in a worksheet
Introduction This topic describes how to create plots using the plot tools on the 

Worksheet toolbar. All plot types use the same procedure.

Procedure To create plots:

1. Open a worksheet or restore an analysis template. 

2. Click a plot tool on the Worksheet toolbar.

3. Add the plot to the worksheet by doing one of the following:

• To insert a new plot using the default size, click on the 
worksheet.

• To draw a plot of any size, drag on the worksheet.

• To create many plots quickly on a worksheet, double-click 
the plot tool on the toolbar, then click on the worksheet 
where you want to add each plot. To unstick the plot tool, 
click a different worksheet tool.

More information • Creating a worksheet layout (page 144)

• Plot overview (page 170)

• Modifying dot plot properties (page 180)

Dot plot

Density plot

Contour plot

Histogram plot
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Using the Inspector to view and modify plot 
properties
Introduction This topic describes how to use the Inspector to view and modify 

plot and parameter properties after you create a plot.

Description You can click a plot on a worksheet to display plot properties in 
the Inspector pane. Use the Plot Properties tab to modify the plot 
title, displayed keyword, type, source, display count, and X/Y 
parameters and scales.

Guidelines • If you select Cytometer as the data source, you can manually 
assign x- and y- axis parameters to plots from a list of 
available parameters.

• If you select an FCS file as the data source, the parameter 
names come from the FCS file, and labels are not applied 
unless they are in the FCS file. 

• If you select multiple plots on a worksheet, the parameter list 
includes the common parameter names and labels for each 
selected plot.
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Modifying plot and 
parameter 
properties

To modify plot and parameter properties:

1. Click Inspector on the BD FACS Sortware toolbar.

The Inspector opens.

2. Click a plot on the worksheet.

3. In the Inspector, click the Plot Properties tab.

4. Set the following properties under General as needed.

5. Set the following properties under X Parameter as needed.

Property Action

Title Enter a name for the plot. If this field is blank, 
the title defaults to the FCS file name. 

FCS Keyword Select a keyword to display under the plot title. 
Keywords will display on the plot only if a 
keyword was recorded. Only one keyword can 
be selected.

Plot Type Select a different plot type (for example, dot, 
density, or contour).

Source Select Cytometer or an FCS file data source for 
the plot.

Display Count Select the maximum number of events to 
display.

The default for cytometer plots is the default 
display count in the Recording Settings pane. 
The default for FCS file plots is the total 
number of events in the file.

Property Action

Parameter Select an x-axis parameter for the plot.

Scale Select linear, log, or logicle (biexponential) scale. 
Different parameters will have different scales 
available to them.
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6. Set the following properties under Y Parameter as needed.

Modifying plot axis parameters
Introduction This topic describes how to modify the axis parameters for existing 

plots. 

Modifying plot axis 
parameters in a 
plot

To modify the plot axis parameters in a plot: 

1. In a worksheet, right-click on an x- or y- parameter label in a 
plot and select a parameter subgroup from the menu. 

2. Select a parameter. 

Property Action

Parameter Select a y-axis parameter for this plot.

Scale Select linear, log, or logicle (biexponential) scale. 
Different parameters will have different scales 
available to them.

Parameter type Description

ADC Includes all available detectors for raw data 
collection.

DSP Includes all available detectors for 
compensated data collection (must be used for 
compensated data when sorting).
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Integrators 
(optional)

The Integrators subgroup is available only if 
the system has the integrators option installed 
and integrators are turned on for real-time data 
(or integrators were recorded for FCS files). 
Integrators are available for FSC, SSC, and any 
ADC parameter.

 Measures the area.

 Measures pulse width at threshold.

Others  Trigger Pulse Width. Signal width of the 
pulse above the threshold.

 Time. Time stamp that occurs every 100 
ms.

 ROI Bits 1-16. Bits 1–16 of the 32-bit field. 
Computed results from lookup tables, one 
bit per ROI (high = in, low = out).

 ROI Bits 17-32. Bits 17–32 of the 32-bit 
field.

 Classifier Bits. Result from classification 
hardware based on lookup tables, one bit 
per sort direction.

 Sort Enable Bits. Includes information 
about sort decisions and counters 
associated with a sort direction.

 Drop Phase. Measured location of an event 
center within the drop phase and distances 
out to 4 drops to the nearest events before 
and after, in 1/16 of a drop.

Parameter type Description
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More information • Setting plot display preferences (page 107)

• Viewing the cytometer status (page 119)

• Adjusting PMT voltages and using optional integrators 
(page 125)

• Creating plots in a worksheet (page 175)

• Modifying dot plot properties (page 180)

• Resizing plots (page 189)

• Integrators (page 368)

Modifying dot plot properties
Introduction This topic describes how to modify dot plot properties using the 

Inspector pane. 

You can also modify the plot display preferences using the Edit 
User Preferences dialog. 

Procedure To modify dot plot display properties:

1. In the Inspector, click the Dot Plot(s) tab.

2. Set the following properties under General as needed.

Property Action

Dot Size Select a small, medium, or large dot size to 
represent events in the plot.

Target Source Select an available FCS file as the target source. 
See Plot overview (page 170) for more 
information about plots using a target source.
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More information • Setting plot display preferences (page 107)

• Setting statistics view display preferences (page 108)

Modifying density plot properties
Introduction This topic describes how to modify density plots using the 

Inspector pane. 

You can also modify the plot display preferences using the Edit 
User Preferences dialog. 

Modifying density 
plot display 
properties

To modify density plot display properties:

1. In the Inspector, click the Density Plot(s) tab.

2. Set the following properties under General as needed.

Property Action

Dot Size Select a small, medium, or large dot size to 
represent events in the plot.

Color Type Select a color scheme for the event data.

Percentage Type a percentage or use the data slider. This 
value determines the peak height and spacing 
between density levels.

Scale Mode Select a linear, probability density, or 
logarithmic scale.

Show Density 
Lines 

Select True to outline the density area or select 
False for no outlines.

Show Outliers Select True to show outliers (events that are 
below the lowest level) or select False to hide 
outliers.
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3. Set the following properties under Resolution as needed.

4. Set the following properties under Smoother as needed.

The density plot is drawn without smoothed data by default. 
Smoothing data does not affect the calculation of statistics or 
the display of outliers.

More information • Setting plot display preferences (page 107)

• Setting statistics view display preferences (page 108)

Property Action

Analysis Select a display resolution for analysis.

Acquisition Select a display resolution for acquisition.

Property Action

Is Smooth Select True to enable smoothing or select 
False to disable smoothing. 

Smooth Edges Select True to enable edge smoothing or 
select False to disable edge smoothing. 

Kernel Size Select a kernel size of 3, 5, or 7.

Smoothing Select a smoothing level.
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Modifying contour plot properties
Introduction This topic describes how to modify contour plots using the 

Inspector pane. 

You can also modify the plot display preferences using the Edit 
User Preferences dialog. 

Modifying contour 
plot display 
properties

To modify contour plot display properties:

1. In the Inspector, click the Contour Plot(s) tab.

2. Set the following properties under General as needed.

Property Action

Dot Size Select a small, medium, or large dot size to 
represent events in the plot.

Color Type Select a color scheme for the event data.

Percentage Type a percentage or use the data slider. This 
value determines the peak height and 
spacing between contour levels.

Scale Mode Select a linear, probability density, or 
logarithmic scale.

Fill Contour Select True to fill the contour area or select 
False to leave the contour area empty.

Show Contour 
Lines 

Select True to outline the contour area or 
select False for no outlines.

Contour Lines 
Colored 

Select True to color the contour area or 
select False for no color.

Show Outliers Select True to show outliers (events that are 
below the lowest level) or select False to hide 
outliers.
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3. Set the following properties under Resolution as needed.

4. Set the following properties under Smoother as needed.

The contour plot is drawn without smoothed data by default. 
Smoothing data does not affect the calculation of statistics or 
the display of outliers.

More information • Setting plot display preferences (page 107)

• Setting statistics view display preferences (page 108)

Property Action

Analysis Select a display resolution for analysis.

Acquisition Select a display resolution for acquisition.

Property Action

Is Smooth Select True to enable smoothing or select False 
to disable smoothing. 

Smooth Edges Select True to enable edge smoothing or select 
False to disable edge smoothing. 

Kernel Size Select a kernel size of 3, 5, or 7.

Smoothing Select a smoothing level.



Plots 185

Modifying histogram properties
Introduction This topic describes how to modify histograms using the Inspector 

pane. 

You can also modify the plot display preferences using the Edit 
User Preferences dialog. 

Modifying 
histogram display 
properties

To modify histogram display properties:

1. In the Inspector, click the Histogram Plot(s) tab.

2. Set the following properties under General as needed.

3. Set the following properties under Resolution as needed.

Property Action

Draw Curve Select True to draw curves between data points 
on the histogram or select False to draw vertical 
bars of data.

Fill 
Histogram 

Select True to fill the histogram area or select 
False to leave the histogram area empty.

Y Axis Scale Select linear, logarithmic, percent, or normalized 
percent.

Y Axis Max Select or type in a y-axis maximum value or select 
Calculated for an auto-calculated scaling.

Overlays Select True to enable an overlay or False to 
disable an overlay. 

Property Action

Analysis Select a display resolution for analysis. 

Acquisition Select a display resolution for acquisition.
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4. Set the following properties under Smoother as needed.

The histogram is drawn without smoothed data by default. 
Smoothing data does not affect the calculation of statistics or 
the display of outliers.

More information • Setting plot display preferences (page 107)

Creating histogram overlays
Introduction This topic describes how to create overlays on a histogram using 

the Inspector pane.

Before you begin • Create a histogram on a worksheet and open the Inspector 
pane.

• If you want to make an overlay that includes the cytometer 
data, the original histogram needs to have the cytometer as its 
data source.

• You need to have at least one FCS file in the Data Sources pane 
to create an overlay.

Property Action

Is Smooth Select True to enable smoothing or select False 
to disable smoothing. 

Smooth Edges Select True to enable edge smoothing or select 
False to disable edge smoothing.

Kernel Size Select a kernel size of 3, 5, or 7.

Smoothing Select a smoothing level.
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Procedure To create overlays:

1. Click a histogram on the worksheet.

2. In the Inspector pane, click the Histogram Plot(s) tab.

3. From the Overlays menu, select True.

The Overlays tab appears.
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4. Click the Overlays tab and select the checkboxes for the FCS 
files to overlay. 

5. Select the population that you want to overlay and the color of 
each overlay.

More information • Creating plots in a worksheet (page 175)

• Resizing plots (page 189)
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Resizing plots
Introduction This topic describes how to resize plots. 

You can manually resize plots and plot events to any size within 
the worksheet, or expand, collapse, or reshape them based on 
predefined increments.

Manually resizing a 
plot

To manually resize a plot:

1. Click on a plot in the worksheet. 

The plot frame and sizing handles are enabled.

2. Drag a handle to size the plot by doing one of the following:

• To proportionally size the plot, drag a corner handle in or 
out.

• To stretch the plot in a specific direction, drag a top, 
bottom, left, or right handle.
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Proportionally 
resizing multiple 
plots

To proportionally resize multiple plots (simultaneously):

1. Click on the first plot you want to resize.

2. Ctrl+click on all other plots you want to resize. 

The plot frames and sizing handles are enabled.

3. Drag a handle to size the plots by doing one of the following:

• To proportionally size the plot, drag a corner handle in or 
out.

• To stretch the plot in a specific direction, drag a top, 
bottom, left, or right handle.

Additional ways to 
resize a plot

The following table describes additional ways of resizing a plot.

Method Procedure

To make a plot square 
(reshape a modified plot)

Right-click a plot and select Resize Plot > 
Make Square.

To expand a single plot by 
predefined increments

Right-click the plot and select Resize Plot 
> Expand.

To contract (collapse) a 
single plot by predefined 
increments

Right-click a plot and select Resize Plot > 
Contract.
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More information • Magnifying (scaling) analysis elements on a worksheet 
(page 150)

Saving plots as images
Introduction This topic describes how to save a plot as a PNG image file.

Procedure To save a plot as an image file:

1. In a worksheet, right-click a plot and select Save As.

The Save as PNG image dialog opens.

2. Navigate to a target folder.

3. In the File name field, type a name for the image.

4. Click Save.

More information • Copying and duplicating plots (page 191)

Copying and duplicating plots
Introduction This topic describes how to copy and paste plots into third-party 

software as an editable metafile, and how to duplicate plots within 
a worksheet.

About copying and 
pasting plots

You can copy plots and associated metadata from a worksheet and 
paste them into third-party software (for example, Microsoft 
Word, PowerPoint®). After you paste the plot, you can modify the 
plot name, axis labels, font, graphic border colors and thickness, 
and delete elements from the image. 



BD FACSJazz User’s Guide192

The following example describes how to copy and paste into a 
Microsoft PowerPoint slide.

Copying and 
pasting plots into 
third-party 
software

To copy and paste a plot and the associated metadata into third-
party software:

1. Right-click a plot and select Copy.

2. Open Microsoft PowerPoint and click on the target slide.

3. Select Edit > Paste Special > Picture (Enhanced Metafile).

4. Click OK.

The plot appears on the PowerPoint slide. The image pastes as 
a single, grouped object. If you want to modify the image, 
right-click the image and select Grouping > Ungroup. Once the 
element you want to modify is ungrouped, you can customize 
the image.

Duplicating plots To create an exact duplicate of a plot within a worksheet:

1. Right-click the plot and select Duplicate.

A duplicate plot appears.

Copied plot before modifications Copied plot after ungrouping and 
modifications
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More information • Setting plot display preferences (page 107)

Viewing keywords with plots
Introduction This topic describes how to view keywords with plots.

Viewing keywords 
with plots

To view keywords with plots:

1. Save an FCS file with at least one keyword.

2. Select the FCS file in the Data Sources pane and create plots if 
required.

3. Select the plots.

4. Select the FCS keyword from the FCS Keyword menu in the 
Inspector pane.

You can select only one keyword to view in the plot title.
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Gates and populations

This chapter includes these topics:

• Gating overview (page 196)

• Using the Gate Hierarchy pane (page 199)

• Viewing the population hierarchy (page 203)

• Creating rectangle gates (page 206)

• Creating polygon gates (page 207)

• Creating ellipse gates (page 209)

• Creating contour gates (page 210)

• Creating interval gates (page 212)

• Creating quadrant gates (page 213)

• Working with gates (page 214)

• Converting global and local gates (page 218)

• Displaying a statistics view (page 222)
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Gating overview
Introduction This topic describes the gating tools you can use to create gates and 

define populations. 

Gating allows you to identify events of interest, classify events in 
populations, display them in plots, and calculate population 
statistics for display as statistics views. Gates are organized in a 
gate hierarchy based on parent and child (subpopulation) 
relationships.

Types of gates You can draw the following types of gates on a plot:

• Rectangle

• Polygon

• Ellipse 

• Contour 

• Quadrant (Quad) 

• Interval

About drawing 
gates

• The minimum and maximum size of a gate is determined by 
the size of the plot.

• You cannot drag the vertex outside the plot.

• All gate types can be used for sorting.

Gate and 
population 
hierarchies and 
statistics views

A population is a gated set of data. Populations can be viewed in 
the Gate Hierarchy pane, population hierarchy, or statistics view. 
Population hierarchies and statistics views are elements in a 
worksheet.

Populations are assigned in the hierarchy based on the selected 
plot. When you draw a gate on a plot, the population is identified 
by a population number and a color. You can define default colors 
and names for each population in the Edit User Preferences dialog.
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Comparison 
between gate 
hierarchies, 
population 
hierarchies, and 
statistics views

The following figures are examples of a gate hierarchy, population 
hierarchy, and statistics view. 

Gate hierarchy

Population hierarchy 

Statistics view
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The following table describes the similarities and differences in 
displays and actions of the Gate Hierarchy pane, population 
hierarchy, and statistics view.

More information • Editing user preferences (page 101)

• Setting gate and population display preferences (page 105)

• Viewing the population hierarchy (page 203)

Displays and actions
Gate 
hierarchy

Population 
hierarchy

Statistics 
view

Displays the hierarchical relationship of gated 
populations

Yes Yes Yes

Interacts with the Inspector pane to modify gate 
name or color

Yes Yes Yes

Allows manipulation of parent/child populations by 
drag and drop

Yes Yes No

Allows drag and drop of populations into 
Compensation or Sort Layout panes

Yes Yes No

Allows creation of Sort Abort or NOT gates Yes Yes No

Controls the show/hide display of gates and 
populations

Yes No No

Displays and allows the manipulation of global or 
local status

Yes No No

Allows creation of AND or OR gates No Yes No

Displays a limited number of statistical details 
about selected populations

No Yes No

Displays a broad choice of statistical details about 
selected populations and parameters

No No Yes
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Using the Gate Hierarchy pane
Introduction This topic describes how to open and use the Gate Hierarchy pane 

to view and manipulate the relationship of populations, and show 
and hide populations. 

Opening the Gate 
Hierarchy pane

To open the Gate Hierarchy pane:

1. On the BD FACS Sortware toolbar, click Gates to display the 
hierarchy (tree) of the gates in an active plot.

The Gate Hierarchy pane opens. The gate hierarchy 
corresponds to gates in the selected plots, population 
hierarchy, statistics view, or data source.
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When a data source, population hierarchy, or statistics view is 
selected, the gate hierarchy displays only the global/local 
status. 

 

When a plot is selected, the Gate Hierarchy pane displays the 
population and gate frame controllers as well as the global/
local status.   
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Showing or hiding 
populations

To show or hide populations in a plot:

1. Click on a plot with gated populations.

2. In the Gate Hierarchy pane, click the Show/Hide icon for the 
population you want to show or hide.

Showing or hiding 
gates (gate frames)

To show or hide gate frames in a plot:

1. In the Gate Hierarchy pane, click the Show/Hide icon for the 
gate you want to show or hide in the plot.

Shown populations

Hidden gate

Shown gate
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Creating Boolean 
gates using the 
Gate Hierarchy 
pane

To create Boolean gates using the Gate Hierarchy pane:

1. In the Gate Hierarchy pane, right-click a population.

2. Select Create Gate, then select a Boolean gate type: NOT or 
Sort Aborts.

The new gate appears. In the following figure, the NOT events 
appear as the new population color.

More information • Viewing the population hierarchy (page 203)

• Converting global and local gates (page 218)
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Viewing the population hierarchy
Introduction This topic describes how to view population hierarchy information 

using the population hierarchy and the Inspector. 

Population 
hierarchy 
components

A population hierarchy can display the following:

• Events

• %Total 

• %Parent

• %Grandparent

Displaying a 
population 
hierarchy

To display a population hierarchy:

1. Right-click a plot and select Population Hierarchy.

The population hierarchy appears.
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Modifying the 
population 
hierarchy

To modify the population hierarchy:

1. In the worksheet, click the header of the population hierarchy.

2. The Inspector refreshes and displays the Population Hierarchy 
tab.

3. Under General, select an FCS file as a data source if needed. 

4. Under Formulas, select the checkboxes for the statistical 
categories you want to include in the population hierarchy. 

5. Under Format, change the value in the Decimal field to change 
the significant figures for the numbers displayed.
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Creating Boolean 
gates using the 
population 
hierarchy 

To create Boolean gates using the population hierarchy:

1. In the population hierarchy, right-click one or more 
populations.

2. Select Create Gate, then select a Boolean gate type (AND, OR, 
NOT, or Sort Aborts).

The new gate appears. In the following figure, the NOT events 
appear as the new population color.
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Deleting a 
population 
hierarchy 

To delete a population hierarchy from a worksheet:

1. Right-click on the header of the population hierarchy in the 
worksheet and select Delete.

More information • Using the Gate Hierarchy pane (page 199)

• Creating rectangle gates (page 206)

Creating rectangle gates
Introduction This topic describes how to create rectangle gates. You can draw 

rectangle gates on dot, density, or contour plots.

Procedure To create a rectangular gate:

1. Click the Rectangle gate tool on the Worksheet toolbar.
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2. Click inside a plot to position the first corner, then drag 
diagonally to the opposite corner point, then release the mouse 
button to set the gate.

The Gate Hierarchy pane updates to include the new gated 
population.

More information • Using the Gate Hierarchy pane (page 199)

• Creating polygon gates (page 207)

Creating polygon gates
Introduction This topic describes how to create polygon gates. 

You can draw polygon gates on dot, density, or contour plots. 

Limitations Polygon gates require a minimum of 3 vertices and allow a 
maximum of 40.
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Procedure To create a polygon gate:

1. Click the Polygon gate tool on the Worksheet toolbar.

2. Click inside a plot to position the first vertex, then click to 
position each vertex. 

3. Double-click to complete the polygon to close the gate. 

This draws lines between vertices and creates the polygon 
shape.

The Gate Hierarchy pane updates to include the new gated 
population.

More information • Creating rectangle gates (page 206)

• Creating ellipse gates (page 209)



Gates and populations 209

Creating ellipse gates
Introduction This topic describes how to create ellipse gates. 

You can draw ellipse gates on dot, density, or contour plots.

Procedure To create an ellipse gate:

1. Click the Ellipse gate tool on the Worksheet toolbar.

2. Click on a plot, then drag the cursor to create an ellipse of the 
desired shape. Release the mouse button to set the gate.

The Gate Hierarchy pane updates to include the new gated 
population.

More information • Creating polygon gates (page 207)

• Creating contour gates (page 210)
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Creating contour gates
Introduction This topic describes how to view contour levels and create contour 

gates. 

You can only draw contour gates on contour plots.

Viewing contour 
levels

To view contour levels:

1. Move the mouse cursor over any population (contour level) in 
the plot to display a data box. 

The following figure shows a contour plot and the data box 
for the contour level.
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Creating contour 
gates

To create a contour gate:

1. Click the Contour gate tool on the Worksheet toolbar.

2. Click the population to automatically set a gate on the 
population (contour level). 

The Gate Hierarchy pane updates to include the new gated 
population.

More information • Creating polygon gates (page 207)

• Creating interval gates (page 212)
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Creating interval gates
Introduction This topic describes how to create an interval gate. 

Interval gates are gates between the left and right endpoints on the 
horizontal axis. You can draw interval gates only on histograms. 

Procedure To create an interval gate:

1. Click the Interval Gate tool on the Worksheet toolbar.

2. Click in the plot to set the start point (right or left), drag 
horizontally, then release the mouse button to set an end point 
(right or left). 

The Gate Hierarchy pane updates to include the new gated 
population.

More information • Creating ellipse gates (page 209)

• Creating quadrant gates (page 213)
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Creating quadrant gates
Introduction This topic describes how to create quadrant (quad) gates. You can 

draw quadrant gates on dot, density, or contour plots.

Quadrant gates divide a plot into four quadrants. Each quadrant 
has its own population statistics. You can name and color the 
population in each quadrant individually. 

Procedure To create a quadrant gate:

1. Click the Quadrant Gate tool on the Worksheet toolbar.

2. Click in the plot to position the quadrant intersection point.

The Gate Hierarchy pane updates to include the new gated 
population.

More information • Creating interval gates (page 212)

• Converting global and local gates (page 218)

Intersection point
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Working with gates
Introduction This topic describes how to modify gate names and colors and 

manipulate the gate size and display. 

This topic also describes how to reprioritize gated populations and 
how to delete gates in a plot.

Changing the 
hierarchical 
position of gates

To change the hierarchical position of gates:

1. In the Gate Hierarchy pane, click and drag a gate to the new 
desired parent. 

In this example, the P3 gate is now a child of P2. You can also 
perform the same action using the population hierarchy.
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Renaming gates Names are unique to gates. You cannot use the same name for two 
different gates. You cannot rename all events.

To rename a gate:

1. In the Gate Hierarchy pane, click a population.

Alternatively, click a gate in a plot.

2. In the Inspector, in the Name field, type a name for the gate 
(for example, CD4+). 

The new gate name appears in the Gate Hierarchy pane and in 
the plot.
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Changing a gate 
color

This procedure only affects the color of individual gates (global or 
local). To set the default preferences for all gates, use the Edit 
Preferences dialog. Colors are unique to gates. You cannot use the 
same color for two different gates.

To change a gate color:

1. In the Gate Hierarchy pane, click a population.

Alternatively, click a gate in a plot.

2. In the Inspector, right-click the color box to display the color 
picker, then select a color.

The new gate color appears in the Gate Hierarchy pane and in 
the plot.

3. Close the color box to apply the new color.
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Resizing gates 
proportionately

To proportionally resize an existing gate: 

1. Click a gate in a plot.

The outline and handles are enabled.

2. Drag a corner handle in or out to resize the gate.

If the gate is too small to view or drag a handle, zoom in on 
the gate, then resize it. 

Resizing gates 
using vertices

To resize gates using vertices:

1. Double-click a gate.

2. Move the cursor over a vertex.

The cursor will show crosshairs.

3. Click and move the vertex to desired location.

Rotating gates To rotate a gate:

1. Click a gate in a plot.

The outline and handles are enabled.

2. Move the cursor over a corner handle to display a rotation 
handle. 

3. Click and drag the rotation handle to the right or left to rotate 
the gate.

Prioritizing gated 
populations in 
plots

You can prioritize the gate display in a plot and move gated 
populations forward or backward in the display.

To prioritize the gate display:

• To move a gate back in the display, right-click the gate, select 
Send to Back, then select the population you want to move. 

• To move a gate forward in the display, right-click the gate, 
select Bring Forward, then select the population you want to 
move. 
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Deleting gates To delete a gate in a plot:

1. Right-click a gate in a plot and select Delete.

To delete a gate in the Gate Hierarchy pane or Population 
Hierarchy view:

1. Right-click the population and select Delete.

More information • Setting gate and population display preferences (page 105)

• Viewing the population hierarchy (page 203)

• Converting global and local gates (page 218)

Converting global and local gates
Introduction This topic describes how to convert gates from global to local and 

from local to global.

About global and 
local gates

• Global gates. By default, when you create a new gate in a plot, 
the gate is global. Global gates are indicated by a G in the Gate 
Hierarchy pane. These gates apply to the cytometer data 
source and all FCS files imported in the Data Sources pane that 
have the same configuration as the cytometer. 
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• Local gates. You can make global gates unique by converting 
them to local gates. Local gates are indicated by an L in the 
Gate Hierarchy pane. These gates only apply to a specific data 
source. When a gate is converted from global to local, the 
original global gate remains on all other data sources. This 
allows you to change the position, color, shape, and name of a 
local gate without affecting the corresponding global gate on 
other data sources.

Rules for 
converting gates

The following rules apply when you convert a global gate to a local 
gate or a local gate to a global gate:

• If a global gate has child gates and is converted to local, all 
child gates will also be converted to local gates.

• Gates (including Boolean gates) created with a local gate as a 
parent will be local.

• You cannot drag a global gate onto a local gate.

• Gates converted from global to local retain a link to their 
original global gate. When a local gate is converted back to 
global, it will update (overwrite) the original global gate with 
the local gate’s position, size, name, and color. 
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In the following example, the global red P1 gate was converted 
to a local gate in the data source Cells Unstain. The gate was 
moved and renamed Monocytes.

The local gate Monocytes was converted back to global. The 
P1 gate was overwritten with the Monocytes gate properties.
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• If a local gate was created without a link to a global gate (for 
example, you created a child of a local gate), the gate name 
must be unique in order to convert to global.

• If a local gate is converted to global and has child gates, the 
child gates will also be converted to global.

• You cannot convert a local gate to a global gate if its parent 
gate is local.

• Sort gates are always local gates (you cannot convert them to 
global).

• You cannot convert a global gate to a local gate or a local gate 
to a global gate if Boolean or sort abort gates are dependent on 
those gates.

• You cannot convert the global/local status of Boolean or sort 
abort gates.

Converting a global 
gate into a local 
gate

To convert a global gate into a local gate:

1. Right-click a gate in the Gate Hierarchy pane and select 
Convert to Local. 

Alternatively, right-click a gate in a plot and select Convert to 
Local.

Converting a local 
gate into a global 
gate

You can convert a local gate (in one data source) into a global gate 
(for all data sources with matching parameters). 

To convert a local gate to a global gate:

1. Right-click a gate in the Gate Hierarchy pane and select 
Convert to Global.

Alternatively, right-click a gate in a plot and select Convert to 
Global.

The gate is now associated to all plots with matching 
parameters.

More information • Gating overview (page 196)
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Displaying a statistics view
Introduction This topic describes how to display a statistics view for a plot in a 

worksheet.

Default statistics 
view components

The default statistics view displays the following:

• Population

• Events

• % Total 

• % Parent

• X-axis parameter mean events

• Y-axis parameter mean events

Displaying 
statistics for a plot

To display a statistics view for a plot:

1. In a worksheet, right-click a plot and select Statistics View.

A statistics view appears.

If the plot does not have gates, only data for All Events 
appears.

If your plot has gates and defined populations, the data for 
each population and All Events appear in their hierarchical 
order.
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Editing the 
statistics view

To edit a statistics view:

1. Click the header of the statistics view.

2. In the Inspector pane, change the data source (if needed) and 
click Edit Statistics View. 

The Edit Statistics View dialog opens.

3. Use the tabs in this dialog to edit the population, parameters, 
percentiles, and decimal values.

4. Click OK to apply the changes.

Moving a statistics 
view

To move a statistics view within a worksheet:

1. Click the header of the statistics view and drag it.

Deleting a statistics 
view 

To delete a statistics view from the worksheet:

1. Right-click the header of a statistics view box and select 
Delete.

More information • Converting global and local gates (page 218)
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Sort settings and layout

This chapter includes these topics:

• Using the Sort Settings pane (page 226)

• Sort mode settings (page 227)

• Creating a user-defined sort mode (page 231)

• Using the Tray Control pane (page 233)

• Creating a sort device layout (page 235)

• Modifying an existing sort device (page 238)

• Deleting a sort device (page 240)

• Using the Sort Layout pane (page 241)

• Setting a new Sort Ready or Home position (page 243)
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Using the Sort Settings pane
Introduction This topic describes the Sort Settings pane.

Description Use this pane to set the drop formation, delay, breakoff, and 
deflection parameters, and to select a sort mode.

This pane includes the following sections.

More information • Sort mode settings (page 227)

Section Description

Drop Formation Controls for determining the stream breakoff.

Stream Controls for optimizing the side streams.

Stream Deflection Controls for adjusting the side streams 
individually.

Sort Mode Select a defined sort mode. Configure and save a 
new custom sort mode.

Delay Calculator Tools to calculate the approximate drop delay.
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Sort mode settings
Introduction This topic describe sort mode settings.

Sort Mode panel The Sort Mode panel of the Sort Settings pane contains controls 
for selecting a defined sort mode, for modifying a defined sort 
mode, and for defining a new sort mode. 

About sort mode A sort mode is a configuration of settings that define the logic by 
which a gated event assigned for sorting will be accepted or 
rejected. The following factors are relevant to sort mode 
configuration.

• Sort Efficiency. The percentage of target events in the sample 
that has been accepted for sorting. Sort efficiency can be less 
than 100% because target events can be lost when sorting due 
to coincidence aborts and phase-mask aborts. Electronic 
aborts or hardware aborts affect the acquisition efficiency, 
which is reported in the Acquisition Dashboard pane. These 
events are not processed, cannot be targeted to sort, and do 
not affect sort efficiency (since they cannot be targeted).

• Recovery. The percentage of target sort events (the yield) that 
is collected in the sort device. Recovery can be less than 100% 
because target sort events are lost due to incorrect drop delay, 
incorrect flash charge setting, and migration of target events 
out of their drop between the interrogation point and the drop 
breakoff.
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• Coincidence. The presence of another event within a specified 
distance (the “coincidence zone”) of a sort event. Coincidence 
causes a sort event to be rejected whenever a nontarget event is 
located within the coincidence zone, thus reducing yield. 
Coincidence decreases the probability that a nontarget 
“passenger” will sort along with a target sort event, thus 
enhancing sort purity. Coincidence is enabled or disabled using 
the Objective setting. Coincidence override allows a sort to 
proceed when a sort target is located within the coincidence 
zone of another sort target for the same stream. Increase the 
magnitude of the coincidence zone using the Extra 
Coincidence setting or the Drops setting.

• Phase Mask. Sets the region within its drop that a target event 
can occupy and be accepted for sorting.

Drops setting Selects the number of drops to be sorted per target sort event. 

The Drops tool is a selection list with the following options: 1, 1.5, 
and 2. The higher the Drops setting, the greater the potential 
recovery. However, increasing the Drops setting expands the 
coincidence zone, which may reduce sort efficiency. A Drops 
setting greater than 1 reduces the sort-stream precision because of 
the repulsion of the second drop. 

• 1.0 Drop. Sort one drop per sort event.

• 1.5 Drops. Sort one drop per sort event if the event is in the 
middle 50% of a drop. Sort two drops if the event is in outer 
(leading or lagging) 25% of the drop. Probability dictates that 
in half of the events, one drop is sorted. In the other half of 
events, two drops are sorted. The second drop is either the 
leading or the lagging drop, depending on the position of the 
event within its drop.

• 2.0 Drops. Sort two drops per sort event. The second drop is 
either the leading or the lagging drop, depending on the 
position of the event within its drop.
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Objective setting Selects how coincidence is applied to the sort decision.

The Objective setting influences sort purity and sort efficiency. The 
Objective tool includes the following options:

• Enrich. Disables all coincidence.

• Purify. Enables coincidence and coincidence override.

• Single. Enables coincidence and disables coincidence override 
to ensure that only one target event can be sorted.

Extra Coincidence 
setting

Sets how far the coincidence zone of a drop extends into the 
adjacent drops. Every sorted drop is subject to the same 
coincidence settings.

Between the interrogation point and drop breakoff, a nontarget 
event on the edge of an adjacent drop can migrate into the drop 
containing a target sort event.

The Extra Coincidence scale is a numeric scale with values from 0 
to 16, each higher number representing an increment of 1/16 drop. 
The Extra Coincidence setting is applied to both the leading and 
the lagging drop. Increasing the magnitude of the Extra 
Coincidence setting can increase the purity of a sort, but might 
decrease the sort efficiency. 

Phase Mask setting Sets the region within its drop that a target event can occupy and 
be accepted for sorting.

Between the interrogation point and drop breakoff, a target sort 
event on the edge of its drop can migrate out of the target drop. A 
phase mask is typically used to sort only those events that occupy 
the central region of the drop and reject those events on the leading 
or lagging edge and to increase the precision of the side stream. 
However, the user can define a phase mask to select a different 
region within a drop that a target event must occupy. A phase 
mask decreases sort efficiency and might increase recovery.
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Default sort modes Four configurations of sort settings have been programmed in 
BD FACS Sortware for your convenience. Any of the following 
configurations can be added to a Drops setting to create a default 
sort mode.

• Pure. Purify objective with extra coincidence setting 4 and no 
phase mask.

• Yield. Purify objective with no extra coincidence and no phase 
mask.

• Enrich. Enrich objective with no extra coincidence and no 
phase mask.

• Single. Single objective with 4/16th extra coincidence and a 10/
16th phase mask.

The following table lists the default sort modes and their 
attributes.

Name/Setting Drops Objective
Extra 
Coincidence Phase Mask

Pure 1.0

1.5

2.0

Purify 4/16 No

Yield 1.0

1.5

2.0

Purify 0 No

Enrich 1.0

1.5

2.0

Enrich 0 No

Single 1.0 Single 4/16 10/16
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More information • Creating a user-defined sort mode (page 231)

Creating a user-defined sort mode
Introduction This topic describes how to define (configure, name, and save) a 

user-defined (custom) sort mode. User-defined sort modes are fully 
modifiable and can be saved for future use.

Procedure To define a sort mode:

1. Open the Sort Settings pane. 

On the BD FACS Sortware toolbar, click Sort Settings. 

If the Sort Settings pane is already open, make sure that the 
flash charge is off before selecting User Defined in the Sort 
Mode menu. To turn off flash, under Stream, click Flash 
Charge.

Note:  Do not select the user-defined sort mode when flash is 
on.

2. In the Sort Mode panel, select User Defined from the menu at 
the top.
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3. Under Settings: 

a. Make a selection from the Drops menu.

b. Make a selection from the Objective menu.

c. Select the extra coincidence value. 

Use either the graphic scale or the numeric selection list to 
choose a value between 0 and 16. 

d. Select a phase mask by clicking on the graphic.

See Setting numeric values in panes and dialogs (page 90) for 
more information.

Saving a user-
defined sort mode

To save a user-defined sort mode:

Note:  Do not save a user-defined sort mode when flash is on.

1. Under Stream, click Flash Charge to turn off flash, if necessary.

2. Select Sorting > Save Sort Mode.

The Save Sort Mode dialog opens.

3. Under New Sort Mode, type a descriptive name in the Name 
field and add a description in the Description field.

4. Click OK to save the new sort mode and close the dialog.

The new sort mode configuration is available in the Sort Mode 
menu. 

More information • Sort mode settings (page 227)
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Using the Tray Control pane
Introduction This topic describes how to use the Tray Control pane to view or 

modify the sort device configuration.

Description Use this pane to view and adjust the offsets for the sort device or to 
configure a new sort device layout. This pane includes the 
following tabs.

• Current Sort Device. This tab displays the position of the tray. 
Modify the position of the sort device using the offset markers 
or grid coordinate controls and click Set Home to set a new 
sort ready position for the current sort device.
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• Create New Sort Device. Use this tab to create a new sort 
device layout.

More information • Creating a sort device layout (page 235)
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Creating a sort device layout
Introduction This topic describes how to create a new sort device layout using 

the Tray Control pane. 

About creating new 
sort device layouts

In BD FACS Sortware, default sort device dimensions and well 
layouts are based on BD Falcon™ plates. When other sort devices 
are used, it might be necessary to create a custom sort device 
layout or custom devices.

When you create a new sort device layout, it appears as a selection 
in the Sort Device menu in the Sort Layout pane. You can manage 
the list of user-created sort devices using the Manage Sort Device 
dialog. 

Before you begin • Set up for a sort.

• Install a sort device on the tray.

Procedure To create a new sort device layout:

1. Open the Sort Settings pane. 

On the BD FACS Sortware toolbar, click Sort Settings. 
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2. Click the Tray Control pane.

3. Click the Create New Sort Device tab.

4. Type a name for the new sort device layout in the Name field.

5. Enter the number of rows and columns in the Rows and 
Columns fields.

6. Set the A1 (first well) position.

a. Use the tray position controls to bring the A1 position close 
to the stream.
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b. Click the Test Sort button to sort a few drops onto the sort 
device.

c. Open the Sort Layout pane.

d. Click Eject to eject the tray.

e. Check the position of the test sort drop on the sort device.

f. Repeat steps a to e to place the test sort drop in the center 
of the well.

g. Click the Set button next to Upper Left (A1).

7. Move the cursor to set the last well position (bottom right). 

8. Repeat step 6 for the last well position.

9. Move the cursor to set the safe position. 

10. Click the Set button next to Safe Position.

11. Click Create to create the new sort device.

Test sort 
button
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More information • Modifying an existing sort device (page 238)

• Deleting a sort device (page 240)

Modifying an existing sort device
Introduction This topic describes how to modify the home position of an 

existing sort device layout using the Tray Control pane. 

Procedure To modify a sort device:

1. In the Sort Layout dialog, under Sort Device, select a sort 
device.

The selected sort device appears in the Current Sort Device tab 
in the Tray Control pane.
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2. Drag the vertical or horizontal offset markers to a new 
position in the map, or adjust the X and Y locations by 
clicking the up and down arrows in the Location fields.

3. Click Set Home to shift the sort ready position to the new 
location. 

The new position is saved for the current sort device.

More information • Using the Tray Control pane (page 233)

Offset controls

Offset marker
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Deleting a sort device
Introduction This topic describes how to delete a saved (named) sort device 

layout using the Manage Sort Devices dialog.

Procedure To delete a saved sort device:

1. Select Sorting > Manage Sort Devices from the 
BD FACS Sortware menu.

The Manage Sort Devices dialog opens.

2. Under Sort Devices, click the X next to the sort device you 
want to delete.

A confirmation dialog opens.

3. Click Yes to delete the sort device.

More information • Using the Tray Control pane (page 233)
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Using the Sort Layout pane
Introduction This topic describes the Sort Layout pane tools, options, and sort 

controls.

Description Use this pane to select the sort tray or tube, select the sort mode, 
define the population for the sort target, and control the position 
and readiness of the sort tray or tube.

Tools and controls This dialog includes the following sections.

Tube sort targets

Section Description

Sort Device Lists the available sort devices.

Sort Limit Displays the number of events to sort. Modify this setting by typing a value 
in the field. Select the Unlimited checkbox to enable a continuous sort.

Sort Report Displays a preview of the sort report after the sort completes. Sort reports 
save to C:\Users\My User Name\Documents\BD\Sortware\Sort Reports.

Sort Mode Lists the available preset sort modes and any user-defined modes.

Piezo Displays the current piezo amplitude. Modify this setting by typing a value in 
the field or by using the data slider.
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The Sort Layout dialog includes the following sort controls and 
actions.

More information • Software overview (page 85)

• Using the Tray Control pane (page 233)

• Sort setup workflow (page 320)

Control or action Procedure

Selecting individual sort 
targets

Click inside the sort target to select only that target.

Selecting all sort targets Click the upper-left corner of the sort target table to select sort 
targets.

Selected population Right-click in a sort target to select a population gate for the tube 
or well.

Start, Stop, Pause, Reset Click to control the sort operation.

Eject when sort complete 
(checkbox)

Select to eject the sort tray at the end of a sort. Clear the 
checkbox to keep the tray in position.

Sort Ready Click to move the sort tray to the sort ready position and to ready 
the system for a sort.

Safe Click to move the sort tray to the safe position, away from the 
sort head and deflection plates.

Eject Click to eject the sort tray.
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Setting a new Sort Ready or Home position
Introduction This topic describes how to move the sort tray position to optimize 

tube or well alignment with the sample stream. Use the Sort Layout 
dialog and the Tray Control pane to perform this procedure as 
needed.

Defining a new sort 
ready position for a 
sort device 

To move the sort tray to predefined positions:

• To move the sort tray to the home position (ready for sorting), 
click Sort Ready. 

• To move the sort tray to the safe position (away from the 
sample stream), click Safe.

• To move the sort tray to the eject position so you can remove 
the sort device, click Eject.

Manually moving 
the sort tray 
position

To manually move the sort tray position:

1. Open the Tray Control pane.

2. Click Sort Ready in the Sort Layout dialog.

3. Click the Test Sort button to determine the current setting.
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4. Move the tray by clicking the offset control arrows or by 
adjusting the values in the X or Y location fields by using the 
mouse scroll wheel, small arrows, data slider, or keyboard 
keys.

5. Click Set Home to save new sort ready position for the current 
sort device.

More information • Using the Tray Control pane (page 233)

• Using the Sort Layout pane (page 241)

Offset controls

Test Sort control



Part 3
System workflow

This part includes these chapters:

• Chapter 15: System startup (page 247)

• Chapter 16: Alignment and QC (page 267)

• Chapter 17: Optimizing system settings for samples (page 295)

• Chapter 18: Sorting (page 319)

• Chapter 19: System shutdown (page 349)
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15
System startup

This chapter includes these topics:

• Startup workflow (page 248)

• Startup, shutdown, and troubleshooting components (page 250)

• Powering up the system (page 252)

• Preparing the fluidics tanks (page 253)

• Flushing the system (page 257)

• Cleaning the nozzle tip (page 259)

• Backflushing the sample line (page 261)

• Removing bubbles from the nozzle tip (page 262)

• Introducing a sample into the system (page 264)
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Startup workflow
Introduction This topic describes the workflow steps for starting up the 

BD FACSJazz system. 

The workflow you perform depends on how the BD FACSJazz 
system was shut down.

Dry startup 
workflow

Use this workflow if you are starting the BD FACSJazz instrument 
for the first time, or if you are starting up after a dry shutdown (no 
fluids in the instrument). 

Caution: Electrical! Do not place fluids on top of the 
instrument. Fluid spills on the instrument can lead to 
electric shock.

Step Description

1 Powering up the system (page 252) 

2 Preparing the fluidics tanks (page 253) 

3 Flushing the system (page 257) 

4 Cleaning the nozzle tip (page 259) 

5 Backflushing the sample line (page 261) 

6 Removing bubbles from the nozzle tip (page 262) 

7 Introducing a sample into the system (page 264) 
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Wet startup 
workflow 

Use this workflow if you are starting up the BD FACSJazz 
instrument after a wet shutdown (DI water in the instrument). 

More information • Startup, shutdown, and troubleshooting components 
(page 250)

• System shutdown (page 349)

• System shutdown workflow (page 350)

Step Description

1 Powering up the system (page 252) 

2 Preparing the fluidics tanks (page 253) 

3 Cleaning the nozzle tip (page 259) (If needed) 

4 Removing bubbles from the nozzle tip (page 262)
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Startup, shutdown, and troubleshooting 
components
Introduction This topic describes the tools that are used during BD FACSJazz 

startup, shutdown, and troubleshooting.

Tools • Debubble reservoir. Use this tool when you remove bubbles 
from the fluidics during startup or as needed. This reservoir is 
also used during wet shutdowns to submerge the nozzle tip in 
fluid to prevent air from entering the fluidics.

• Flush bucket. This is a moveable receptacle that is attached to 
a waste line. Use this tool during startup and shutdown to hold 
the debubble reservoir or catch the stream directly under the 

The debubble reservoir is attached to a tube 
to hold fluid.

The debubble reservoir with 
DI water is used to submerge 
a nozzle tip during a wet 
shutdown.
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nozzle assembly (which prevents the stream from reaching the 
stream drain in the sort stage). 

The flush bucket mounts in two places: 

– Under the nozzle assembly when in use

– On top of the instrument above the sample station when 
not in use

Use the flush bucket during startup when you:

– Rinse without a nozzle tip to fill the fluidic lines

– Purge with a nozzle tip to remove bubbles from the tip

Use the flush bucket during shutdown when you:

– Dry the fluidics system in a dry shutdown

– Submerge the nozzle tip in DI water using the debubble 
reservoir for a wet shutdown

More information • System startup (page 247)

• Startup workflow (page 248)

The flush bucket under the nozzle 
assembly during a flush procedure

The flush bucket under the 
debubble reservoir during a 
wet shutdown



BD FACSJazz User’s Guide252

Powering up the system
Introduction This topic describes how to power up the BD FACSJazz system.

Procedure To power up the system:

1. Close all laser shutters.

2. Turn on the main power.

This powers the system lasers and electronics. Wait at least 15 
minutes for the lasers to warm up before performing QC. You 
can continue fluidics startup during this time.

3. Turn on the computer.

4. Start the software programs by double-clicking the 
BD FACS Sortware icon. 

The Sortview and Pressure Console panes start at the same 
time.

Caution: Laser! Close all laser shutters.

Main power
switch
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Next step Preparing the fluidics tanks (page 253)

More information • Pressure Console pane (page 92)

• Sortview pane (page 95)

• System startup (page 247)

Preparing the fluidics tanks
Introduction This topic describes how to prepare the fluidics tanks during 

startup and how to balance the sample-to-sheath pressure. 

Required materials • Empty sheath tank and waste tank

• 7 L of sheath fluid

• 0.7 L of bleach (if sorting biohazardous samples)

• 0.2-µm sheath filter (provided). If you are not using a sheath 
filter, pre-filter your sheath fluid to 0.2 µm or smaller to avoid 
excess noise in the system.

Filling the sheath 
tank

Check the sheath level during startup (each day) and refill the tank 
as needed. 

Always empty the waste tank when you refill the sheath tank. 

To fill the sheath tank:

1. Disconnect the air and sheath line quick-connect fittings (when 
performing a wet startup).

Disconnect the sheath and air line from each other (when 
performing a dry startup).

2. Depressurize the sheath tank by opening the pressure relief 
valve (when performing a wet startup).
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3. Place the empty tank on the floor or designated spot (from 
where the BD Service representative calibrated the tank) before 
refilling it. 

4. Fill the sheath tank with up to 7 L of sheath fluid. 

Do not fill past the weld line on the sheath fluid tank to ensure 
that there is adequate space for the tank to pressurize. 

5. Attach the sheath tank lid.

Make sure that the O-ring is properly installed around the 
tank lid and that the lid is properly seated.

6. Attach the air line (blue) and the sheath line (clear) with the 
filter attached to the sheath tank. 

Make sure the sheath filter is inline (not bypassed).

Sheath output to sheath line

Air input

Sheath tank lid

Pressure relief valve
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Preparing the 
waste tank

Empty the waste tank each time you refill the sheath tank. 

To prepare the waste tank:

1. Disconnect the vacuum and the waste line quick-connect 
fittings.

2. Carry the waste tank to the waste disposal area, then remove 
the lid.

3. Empty the waste tank, taking care not to spill waste fluid over 
the pressure gauge.

4. Add enough bleach to achieve a 10% concentration of bleach.

5. Attach the waste tank lid.

6. Place the waste tank next to the sheath tank. 

Caution! The contents of the waste tank and waste 
tubing could be contaminated with biohazardous 
material. Follow standard laboratory procedures for 
biological hazards during all cleaning and maintenance 
procedures. Wear protective clothing, eyewear, and 
gloves.
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7. Attach the quick-connect fittings for the waste line (red) input 
and the vacuum source.

8. Ensure that the hydrophobic waste filter is connected between 
the vacuum source and the waste tank.

9. If the waste tank overfills and wets the filter, empty the waste 
tank and replace the filter.

Pressurizing the 
waste tank

To pressurize the waste tank:

1. Turn on the house vacuum supply or vacuum pump.

2. Verify that the waste pressure gauge reads between 5" Hg and 
10" Hg. 

• If the gauge reads lower than 5" Hg, tighten the waste tank 
lid. 

• If the gauge reads higher than 10" Hg, reduce the vacuum 
applied to the waste tank.

Caution! Do not run the system without the waste 
filter in place. Liquid contamination in the house 
vacuum supply or the dedicated air compressor can 
damage the vacuum system.

Waste line

Vacuum port
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Pressurizing the 
sheath tank

To pressurize the sheath tank:

1. Close the pressure relief valve on the sheath tank.

2. Verify that the house air pressure supply or dedicated air 
compressor is on.

3. Turn on the air supply by switching the Air switch on the right 
side of the cytometer near the sample station.

4. Verify that the sheath tank is sealed by checking the pressure 
gauge. 

The pressure should be about 27 to 29 psi.

If the tank is not pressurizing, verify that the release valve is 
closed, or re-seat the sheath tank lid.

Next step Flushing the system (page 257)

More information • System startup (page 247)

• Introducing a sample into the system (page 264)

• About sample rate, sample pressure, and concentration 
(page 264)

Flushing the system
Introduction This topic describes how to flush the fluidics system to prime the 

system with fluid, forcing air out of the fluidic lines. 

Flush the system:

• After starting up the instrument from a dry shutdown

• After changing the fluidic tubing

Required materials Flush bucket 
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Flushing the 
fluidics

To flush the system:

1. Make sure that the nozzle and nozzle nut are removed.

2. Place the flush bucket under the nozzle.

3. In the Pressure Console pane, click Rinse, and run for at least 
30 seconds, checking that the lines are full of fluid and that the 
flush bucket is not overfilling. 

If the flush bucket is overfilling, check for low vacuum 
pressure, clogged lines, or possible pinches or kinks in the fluid 
waste line.

4. Remove the sheath filter from the velcro attachment and tap it 
gently to dislodge any air bubbles.

5. In the Pressure Console pane, click Rinse again to stop the 
flow.

Next step Cleaning the nozzle tip (page 259)

More information • Replacing the nozzle tip (page 71)

• System startup (page 247)

• Startup, shutdown, and troubleshooting components 
(page 250)

• Preparing the fluidics tanks (page 253)

Caution! If the vacuum pressure is low or the waste 
lines are clogged, the flush bucket can overfill. 
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Cleaning the nozzle tip
Introduction This topic describes how to clean the nozzle tip. 

Clean the nozzle tip daily as part of the startup workflow. Also, 
clean the nozzle tip when the stream is diverted by an apparent 
obstruction or clog. 

Required materials • Syringe with 0.2-μm filtered water, sheath fluid, or a mild 
detergent

• Sonicator

Before you begin Remove the nozzle if it is still installed. See Replacing the nozzle tip 
(page 71) for more information.

Procedure To clean the nozzle tip:

1. Sonicate the nozzle for 1 to 2 minutes.

2. Prepare a syringe with 0.2-μm filtered water, sheath fluid, or a 
mild detergent.
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3. Flush the nozzle in the opposite direction of normal sheath 
flow. 

4. Install the nozzle tip. 

Next step Backflushing the sample line (page 261)

More information • Replacing the nozzle tip (page 71)

• System startup (page 247)

• Introducing a sample into the system (page 264)
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Backflushing the sample line
Introduction This topic describes how to backflush the sample line to remove air 

from the sample line.

Procedure To backflush the sample line:

1. In the Pressure Console pane, click Stream to start the stream.

2. Remove the sample tube and move the tube-lock lever to the 
open position. 

3. In the Pressure Console pane, click Backflush.

4. Once sheath fluid drips from the sample line, click Backflush 
again to turn backflushing off.

Next step Removing bubbles from the nozzle tip (page 262)

More information • System startup (page 247)

• Startup, shutdown, and troubleshooting components 
(page 250)

• Cleaning the nozzle tip (page 259)

• Introducing a sample into the system (page 264)



BD FACSJazz User’s Guide262

Removing bubbles from the nozzle tip
Introduction This topic describes how to remove bubbles from the nozzle tip.

Required materials • Debubble reservoir 

• Flush bucket 

Procedure To remove bubbles from the nozzle tip:

1. Place the flush bucket under the nozzle assembly.

2. Place the empty debubble reservoir in the flush bucket. 

3. In the Pressure Console pane, click Stream to fill the debubble 
reservoir with sheath fluid.

4. Ensure that the nozzle tip is submerged in the sheath fluid.

5. In the Pressure Console pane, click Purge to pull fluid up 
through the nozzle tip. 

This removes air from the tip. 

6. When all air has traveled past the Y-fitting, click Pulse to pulse 
the fluidics lines to free additional bubbles that might be 
trapped in the nozzle.

7. Repeat steps 3 and 6 and until no additional bubbles are 
released from the nozzle.

Debubble reservoir
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If you are having difficulty removing all the bubbles, try the 
following:

• Make sure that the nozzle tip is submerged in fluid 
throughout the process, refilling the debubble reservoir in 
place as needed.

• Use ethanol instead of sheath fluid in the debubble 
reservoir. Follow with a sheath fluid purge to remove the 
ethanol.

• Verify that the O-ring is installed in the nozzle nut and that 
it is as tight as you can get it without using a wrench.

• Remove the debubble reservoir from the flush bucker, then 
reinsert it to introduce a large bubble into the nozzle. The 
large bubble may dislodge the smaller bubbles.

8. In the Pressure Console pane, click Stream to start the stream 
with the debubble reservoir still in place and the nozzle still 
submerged.

9. Remove the debubble reservoir carefully so that any fluid that 
spills out of the reservoir is caught by the flush bucket. 
Remove excess fluid from the nozzle tip with a cotton swab.

10. Verify that the stream is flowing straight out of the nozzle tip.

If the stream is crooked or unstable, clean the nozzle and 
continue purging air from the lines.

Next step Introducing a sample into the system (page 264)

More information • System startup (page 247)

• Startup, shutdown, and troubleshooting components 
(page 250)

• Cleaning the nozzle tip (page 259)

• System shutdown (page 349)
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Introducing a sample into the system
Introduction This topic provides basic information about how to load a sample 

tube into the sample station, then run a sample and test the stream 
alignment. 

Detailed information about aligning and optimizing the streams 
and lasers is included in the Alignment and QC workflow chapter. 

See Alignment and QC (page 267) for more information.

About sample rate, 
sample pressure, 
and concentration

Sample rate or event rate is determined by the combination of the 
sample pressure, the concentration of the sample, and ultimately, 
the width of the core stream.

Adjust the sample pressure offset so that the sample core stream is 
as narrow as possible. When the sample pressure offset is raised, 
the sample core stream widens and the particles are dispersed into 
the wider stream. This increases the CV. 

Typically, a low flow rate can be achieved when the sample 
pressure offset is about 1 psi. This setting varies between 
instruments and depends on the concentration of the sample.

Requirements • Use only BD Falcon 12 x 75-mm polypropylene sample tubes. 

• (Optional) Filter all samples to 40 μm (about half the nozzle 
tip diameter).

Before you begin • Set the sample pressure offset to approximately 1 psi. 

• Check the Status box for any messages regarding the system 
state and its ability to run samples. 

Loading a tube
Caution: Biohazard! Use care when installing the sample 
tube. Once the tube is installed, the sample tube is 
pressurized. Sample fluid can spill or splatter if the 
sample tube is not properly installed and locked in 
place.
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To load a sample tube:

1. Fill a sample tube with up to 3 mL of sample.

2. Load the sample tube into the sample tube holder and pull the 
sample tube-lock lever forward to lock the tube in place over 
the stopper. Do not damage or bend the sample line.

Running the sample To run a sample:

1. In the Pressure Console pane, click Sample to open the sample 
valve and begin running the sample. 

2. In the Pressure Console pane, click Boost and hold for a few 
seconds to temporarily boost the sample offset to 3 psi higher 
than the current offset and introduce the sample into the 
nozzle quickly. 

3. Monitor the sample flow by looking at the event rate.

Tube in the tube 
holder

Tube-lock lever
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4. Adjust the sample pressure to achieve the desired event rate.

Higher sample pressure offsets result in lower resolution 
(higher CV). While adjusting the sample offset, ensure that the 
acquisition efficiency percentage (located in the Acquisition 
Dashboard) is high. If the sample offset is too high relative to 
the sample concentration, the acquisition efficiency will be 
lower.

Removing a sample 
tube

To remove the sample tube:

1. In the Pressure Console pane, click Sample to stop the sample 
run.

2. Push the tube-lock lever slowly backward while holding the 
tube in place with your thumb until the tube is pushed down 
into the recessed area of the tube-lock lever and tube-lock lever 
is all the way back.

3. Remove the tube, being careful not to kink or bend the sample 
line. 

4. In the Pressure Console pane, click Backflush to allow the 
residual sample to backflush.

5. In the Pressure Console pane, click Backflush to stop the 
backflush process.

More information • Sample introduction (page 33)

• System startup (page 247)

Caution: Biohazard! Use care when removing the sample 
tube. The sample tube is usually pressurized and can 
include aerosolized cells.
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Alignment and QC

This chapter includes these topics:

• Aligning and optimizing the optics workflow (page 268)

• Creating a QC workspace (page 270)

• Preparing beads for QC (page 276)

• Aligning the stream (page 277)

• Aligning the primary laser to the core stream (page 283)

• Optimizing the fluorescence signal for the primary laser (page 285)

• Optimizing the forward scatter signal (page 286)

• Optimizing additional lasers (page 288)

• Creating an FCS file to record laser alignment (page 290)

• Saving the QC workspace (page 292)

• Verifying alignment using the target source (page 293)
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Aligning and optimizing the optics workflow
Introduction This topic provides a workflow for aligning and optimizing the 

optics for instrument QC.

Purpose of the 
workflow

Each day before running samples, the system must be aligned and 
optimized. Track the results of alignment to confirm that the 
system is performing consistently over time. Tracking data can be 
useful for troubleshooting.

Alignment and optimization tasks involve mechanically adjusting 
the optics and fluidics, and setting values and recording data with 
BD FACS Sortware. 

Daily alignment and optimization mean aligning the stream to the 
pinholes and the drain, aligning the primary fluorescence 
parameter, aligning the forward scatter, aligning additional lasers, 
positioning the sample core at the focal point of the objective lens 
in the pinhole, illuminating the sample core optimally, aligning the 
fluorescence and forward scatter, then adjusting PMT gains to 
place the QC particles at a target location.

Workflow
Step Description

1 Create or load a saved QC workspace that includes 
appropriate cytometer settings, sort settings, and worksheet 
elements. 

See Creating a QC workspace (page 270).

2 Prepare the beads to be used for alignment and QC.

See Preparing beads for QC (page 276).

3 Align the stream to the pinholes and the BD Accudrop laser, 
and introduce a sample.See Aligning the stream (page 277).

4 Align the primary laser to the core stream.

See Aligning the primary laser to the core stream (page 283).
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More information • Creating a QC workspace (page 270)

5 Optimize the fluorescence signal for the primary laser.

See Optimizing the fluorescence signal for the primary laser 
(page 285).

6 Optimize the forward scatter signal.

See Optimizing the forward scatter signal (page 286).

7 Optimize additional lasers. 

See Optimizing additional lasers (page 288).

8 Create an FCS file to record laser alignment.

See Creating an FCS file to record laser alignment (page 290).

9 Save the QC workspace to save alignment settings.

See Saving the QC workspace (page 292).

10 Verify alignment using the target source.

See Verifying alignment using the target source (page 293).

Step Description
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Creating a QC workspace
Introduction This topic describes how to customize a QC workspace to be saved 

and used for daily QC. 

The QC workspace includes a worksheet with plots to measure 
and track all scatter and fluorescence parameters required for QC. 

About the QC 
workspace

The QC workspace simplifies alignment by presenting the correct 
alignment plots, gates, and statistic boxes.

After alignment and QC, the cytometer settings and sort settings 
can be saved to be used as the base daily cytometer settings.

Procedure summary This example shows how to create a custom QC workspace by 
adding plots and statistics views that display data for the primary 
laser fluorescence parameters, FSC vs SSC, and all other configured 
lasers and included parameters. Statistics should show only the 
essential categories for events, such as median and rCV. 

Stage Description

1 Start with a new workspace.

See Creating a QC workspace (page 270).

2 Add plots for the primary laser fluorescence parameters.

See Adding plots for primary laser fluorescence parameters 
(page 272).

3 Add and customize statistics views for the primary laser 
fluorescence parameters and create a gate for the QC 
population. 

See Adding and customizing a statistics view (page 273).



Alignment and QC 271

Creating a QC 
workspace 

To create a QC workspace:

1. Select File > New Workspace.

A confirmation dialog opens.

2. Click OK.

The worksheet clears and all plots, gates, data sources, and 
statistics are deleted. 

3. (Optional) Add header or footer information to customize the 
worksheet. 

See Customizing worksheet properties (page 146) for more 
information.

4 Add an FSC vs SSC plot and statistics view.

See Adding an FSC vs SSC plot and a statistics view 
(page 275).

5 Add plots and statistics views for all other lasers and 
fluorescence parameters.

See Adding plots and statistics for all other configured lasers 
and parameters (page 275).

6 Save the workspace and an FCS file (after you perform the 
alignment procedures).

See Saving the QC workspace (page 292).

Stage Description
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4. In the Cytometer Settings pane, clear the Log checkbox for 
each detector to ensure that all parameters use the linear 
amplifier.

Adding plots for 
primary laser 
fluorescence 
parameters

To add plots for the primary laser fluorescence parameters:

1. On the worksheet, double-click the Dot Plot tool on the 
Worksheet toolbar, then click in the worksheet to create 
several plots.

2. To stop creating multiple dot plots, select a new tool such as 
the pointer icon used to select worksheet elements.

3. Use the alignment tools to align the plots on the worksheet, 
then right-click the x- and y-axis parameters and select 
different ADC parameters.

Modify the dot plots for the primary (blue) laser fluorescence 
parameters and one plot for side scatter. For example, for an 
instrument detecting four fluorescence parameters using the 
blue laser, create the following dot plots: 

• 530/40 (488)vs 585/29 (488)

• 692/40 (488) vs 750 LP (488)

• SSC (488) vs 750 LP (488)

Log/Lin scaling 
checkbox
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Adding and 
customizing a 
statistics view

To add and customize a statistics view for the primary laser 
fluorescence parameters:

1. Right-click a plot, then select Statistics View. 

A statistics view appears in the worksheet.

2. Right-click the statistics view, then select Edit Statistics View.

The Edit Statistics View dialog opens.

3. In the Populations tab, under Formulas, select only the Events 
checkbox.

4. Click the Parameters tab. 
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5. For each primary laser fluorescence parameter (488), select the 
Median and RCV checkboxes.

6. Click OK.

7. Drag the corners of the statistics view to size it to fit the width 
of the worksheet.

The worksheet should look like the following figure.
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Note that if you need more viewing or printing space for the 
statistics view, you can create separate statistics views for each 
plot, or any combination of plots.

Adding an FSC vs 
SSC plot and a 
statistics view

To add an FSC vs SSC plot and a statistics view:

1. Create a dot plot for FSC vs SSC.

2. Right-click the dot plot(s) and select Statistics View.

A statistics view appears in the worksheet.

3. Right-click the statistics view and select Edit Statistics View. 

The Edit Statistics View dialog opens.

4. In the Populations tab, under Formulas, select only the Events 
checkbox.

5. Click the Parameters tab. 

6. For FSC and SSC, select the Median and RCV checkboxes.

7. Click OK.

8. Drag the corners of the statistics view to size it to fit the width 
of the worksheet.

Adding plots and 
statistics for all 
other configured 
lasers and 
parameters

To add plots and statistics for all other configured lasers and 
parameters:

1. Create plots, select parameters, and add a statistics view for 
each laser.

2. If you require more space for your additional plots, click the 
Add Page tool on the Worksheet tool bar to add pages.
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Next step Preparing beads for QC (page 276)

More information • About settings files (page 110)

• Working with settings files (page 113)

• Viewing the cytometer status (page 119)

Preparing beads for QC
Introduction This topic describes how to prepare beads for alignment and QC.

Required materials • BD Falcon 5-mL polypropylene sample tubes

• 3-µm SPHERO Ultra Rainbow beads

• 1 mL of sheath fluid

Preparing beads To prepare a tube of beads:

1. Add at least 1 drop per 0.5 mL of sheath fluid to a tube.

2. Load the tube of Ultra Rainbow beads onto the sample tube 
holder and close the tube-lock lever.

3. In the Pressure Console pane, click Sample to start the sample 
flow.

Next step Aligning the stream (page 277)

More information • Introducing a sample into the system (page 264)
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Aligning the stream
Introduction This topic describes the method for aligning the stream to the 

pinholes, as well as centering the stream to hit the center of the 
stream drain and ensuring that the Accudrop laser is intercepting 
the side and center streams equally.

Required materials 50-mL conical tube

Before you begin

1. Start up the system.

2. Ensure that the deflection plate power is off.

See System controls (page 29) for more information.

3. Remove the plate access panel.

4. Manually open the deflection plates to prevent the sheath fluid 
from splashing on the plates and spraying. 

To remove the plates, lift up slightly and out (towards you).

Testing the stream 
alignment

To test the stream alignment:

1. Place a 50-mL conical tube in the two-way sort device installed 
on the sort stage so that the tube is centered below the stream 
drain.

Caution: Shock hazard. You must power off the 
deflection plates before manually opening or adjusting 
them.
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2. Remove the flush bucket so that the stream passes through the 
illumination chamber into the sort chamber.

Note:  The plate access panel and Sort Chamber door must be 
closed for the Accudrop laser to illuminate.

3. In the Pressure Console pane, click Illum to illuminate the 
stream just above the drain. 

Caution! The stream might splash and spray out of 
the stream drain if the drain is clogged or vacuum is 
not applied.

Flush bucket under the nozzle assembly



Alignment and QC 279

Adjusting the 
nozzle stage

The nozzle assembly provides adjustment knobs used to center the 
stream on the pinhole and to center the stream into the drain.

Vertical adjustment Focus adjustment

Left/Right (roll) 
knob

Horizontal 
adjustment

In/Out (pitch) knob

Adjustment Description

Vertical (top silver knob). Pinhole alignment. Moves the stage vertically.

Focus (silver knob at the back of nozzle stage). 
Pinhole alignment.

Moves the stage in and out perpendicular 
to the laser light path.
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Aligning the stream 
to the pinholes

To align the stream to the pinholes:

1. Adjust the horizontal adjustment knob so that the stream is 
placed over the pinholes.

2. Adjust the focus adjustment knob so that the stream is in focus 
with crisp stream edges.

Horizontal (silver knob on right side of nozzle). 
Pinhole alignment.

Moves the stage side to side, parallel to the 
laser light path.

Pitch (black knob front of nozzle stage). Drain/
Accudrop alignment.

Moves the nozzle pitch back and forth to 
the stream drain. 

Left/Right (roll) black knob. Drain alignment. Moves the nozzle roll left and right to the 
stream drain. 

Adjustment Description

Pinholes and stream before alignment

Stream

After alignment
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Aligning the stream 
with the drain

To align the stream with the drain:

1. Adjust the In/Out and Left/Right knobs on the nozzle stage to 
move the stream to the center of the drain, if needed. 

2. Ensure that the stream is still focused on the pinholes. 

You might need to make small adjustments and go between 
aligning the stream to the pinhole and to the drain to get an 
accurate alignment. 

Aligning the side 
and center streams 
to the Accudrop 
laser (optional)

After you align the stream with the pinholes and the drain, you can 
use the Accudrop laser to optimize the alignment of the side and 
center streams to the Accudrop laser (the stream is brightest when 
the laser is aligned with the stream). Ensuring that the Accudrop 
laser is illuminating the side and center streams equally is 
important for determining the most accurate drop delay before 
sorting.

To align the side and center streams with Accudrop:

1. Optimize the stream breakoff.

2. Move the deflection plates into the sort position.

3. Turn on the deflection plates.

4. Test and then optimize the side streams.

Stream

Drain

RightLeft

Out

In
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5. View the side streams in the stream drain image.

6. Ensure that both the side and center streams are illuminated by 
the Accudrop laser. Adjust the In/Out pitch and Left/Right roll 
knobs if necessary.

7. Confirm that the stream is still focused and aligned on the 
pinholes. 

If the stream is not focused and aligned on the pinholes, adjust 
the nozzle stage focus and horizontal adjustment. Then repeat 
steps 5 through 7 until the Accudrop laser is aligned with the 
side and center streams and the stream is centered and focused 
on the pinholes.

8. Turn off the test streams.

9. Turn off the deflection plates.

Next step Aligning the primary laser to the core stream (page 283)

More information • Aligning and optimizing the optics workflow (page 268)

• Preparing beads for QC (page 276)

• Optimizing the drop breakoff (page 321)

• Optimizing the side streams (page 322)
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Aligning the primary laser to the core stream
Introduction This topic describes how to optimize a fluorescence channel by 

aligning the primary laser into the sample stream. In this 
procedure, the blue (488-nm) laser is the primary laser.

Before you begin Prepare a tube of 3-µm SPHERO Ultra Rainbow beads (1 drop per 
0.5 mL of filtered sheath fluid).

Procedure To align the primary laser to the core stream:

1. Close the nozzle access door and ensure that the chamber lid is 
in place.

2. Place your finger over the reset sensor in the upper-right corner 
of the chamber door to reset the safety interlock.

Reset 
sensor

Interrogation
chamber lid

Nozzle
access door
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3. Open the shutter for the 488-nm (primary) laser by pulling the 
laser shutter tab to the top position.

4. Load the tube of Ultra Rainbow beads onto the sample tube 
holder and close the tube-lock lever.

5. Verify that the sample pressure offset is about 1.0 psi.

Use the Pressure Control pane to adjust the sample offset, if 
necessary. 

See Introducing a sample into the system (page 264).

6. In the Pressure Console pane, click Sample to start running 
beads. 

7. Lower the offset as necessary to produce a narrow core stream 
which will reduce the sample CVs. 

If the event rate is too low, add more beads to your sample.

8. In the Pressure Console pane, click Boost for a few seconds to 
deliver sample to the laser more quickly, if needed.

Next step Optimizing the fluorescence signal for the primary laser (page 285)

More information • Aligning and optimizing the optics workflow (page 268)

Laser
shutter tabs
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Optimizing the fluorescence signal for the primary 
laser
Introduction This topic describes how to use BD FACS Sortware to optimize the 

fluorescence signal for the primary laser. 

Procedure To optimize the fluorescence signal for the primary laser:

1. Restore the user-defined QC workspace. 

2. Click Recording on the BD FACS Sortware toolbar.

The Recording Settings pane opens.

3. Change the Default Display Count to 200. 

The default display count dictates the default refresh rate. 
While making adjustments, it is helpful to have a low display 
count, which gives a quick refresh rate. 

4. Click a plot that has the primary (typically blue) laser 
parameters.

5. Use the blue laser alignment knob to maximize the bead 
fluorescence signal in the plots associated with the laser you 
are optimizing.
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6. Use the stream focus to optimize the signal.

7. Repeat steps 5 and 6 until the primary laser signals are at 
maximum intensity.

8. Once the signal has been optimized, adjust the fluorescence 
parameter photomultiplier tube voltages (PMTVs) so that the 
bead population is at a median of approximately 45,000 for 
each blue laser parameter.

9. Draw a gate around the primary laser signal.

Next step Optimizing the forward scatter signal (page 286)

More information • About settings files (page 110)

• Working with settings files (page 113)

• Viewing cytometer details (page 130)

• Worksheet overview (page 140)

Optimizing the forward scatter signal
Introduction This topic describes how to adjust the forward scatter stage to 

maximize the signal from the forward scatter detectors. 

Before you begin • Open your QC workspace.

• Align the fluorescence detectors.
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Optimizing the 
forward scatter 
signal

To optimize the forward scatter signal:

1. Adjust the horizontal and vertical knobs on the forward 
scatter stage to maximize the signal from the detector in the 
plot, if needed.

2. Adjust the FSC and SSC voltages to place the bead population 
at a mean of approximately 25,000.

Next step Optimizing additional lasers (page 288)

More information • Optimizing the fluorescence signal for the primary laser 
(page 285)
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Optimizing additional lasers
Introduction This topic describes how to optimize additional lasers that your 

system might include. 

About additional 
lasers

The primary laser (through the top pinhole) is the system trigger. 
With multi-laser systems, you need to adjust the laser delay to 
synchronize the signals from additional lasers.

When a system has more than one laser, the signal from the 
optional lasers need to be optimized also, which includes adjusting 
the laser to maximize the signal and adjusting the laser delay.

Before you begin Ensure that the primary laser signal and the forward scatter signals 
are optimized.

Optimizing 
additional lasers

To optimize additional lasers:

1. In the QC workspace worksheet, view a plot that has the 
parameters for the laser that you are aligning. 

If the plot does not exist on the worksheet, create a new dot 
plot and statistics view. The statistics view should include total 
events, median, and rCV for the laser that you are aligning.

2. Use the laser alignment knob to maximize the bead 
fluorescence signal in the plots associated with the laser that 
you are optimizing. 

Primary laser, blue, 488 nm

Violet laser, 405 nm

Red laser, 640 nm
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The goal is to achieve the maximum signal.

3. In the Cytometer Settings pane, locate the laser that you want 
to adjust in the list. 

4. Adjust the laser delay in small increments in the Delay field 
using the mouse scroll wheel, data slider, or keyboard keys.

Adjust the delay above and below the current value to find the 
delay that gives the highest fluorescent signal in the plot.

See Setting numeric values in panes and dialogs (page 90) for 
more information.

5. Repeat steps 2 and 4 until the signal is maximized in the plot.

6. Adjust the PMTV to place the bead population at a median of 
about 45,000 for each fluorescent parameter of the laser that 
you are aligning. 

You need to adjust the PMTVs as you are optimizing the signal 
if the bead population is off-scale.

Next step Creating an FCS file to record laser alignment (page 290)

More information • Optimizing the forward scatter signal (page 286)
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Creating an FCS file to record laser alignment
Introduction This topic describes how to create an FCS file to record laser 

alignment.

Procedure After the instrument alignment is optimized for all lasers, record an 
FCS file for future reference.

To save a data file to record laser alignment:

1. Ensure that the laser shutters for all applicable lasers are open.

2. Click Recording on the BD FACS Sortware toolbar.

The Recording Settings pane opens.

3. Under FCS File, click Path.

The Browse For Folder dialog opens.

4. Navigate to the folder where you want to store QC data, and 
click OK.

5. In the File field, name the new QC data file.
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6. Under Recording Rule, modify the recording rules as needed.

7. Decrease the sample offset if needed so that you have a small 
core stream.

8. In the Acquisition Dashboard, click Acquire, then click Record 
to record the data file.

Next step Saving the QC workspace (page 292)

More information • Laser delay (page 52)

• Adjusting PMT voltages and using optional integrators 
(page 125)

• Optimizing the forward scatter signal (page 286)

• Verifying alignment using the target source (page 293)
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Saving the QC workspace
Introduction This topic describes how to save the QC workspace.

Procedure To save the QC workspace:

1. Select File > Save > Workspace. 

The Save Workspace dialog opens.

2. Under Workspace Details, type a useful name for the QC 
workspace in the Name field (for example, Jazz daily QC). 

3. (Optional) Type a description of this workspace template in 
the Description field.

4. Click OK.

You can restore the QC workspace whenever you want to 
perform QC.

Next step Verifying alignment using the target source (page 293)

More information • Aligning the stream (page 277)

• Optimizing additional lasers (page 288)
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Verifying alignment using the target source
Introduction This topic describes how to use a target data source (FCS file) to 

verify instrument alignment. 

The following procedures describe how to create a QC target FCS 
file specifically for this purpose and apply it as a target source. To 
use the target source feature, the target source FCS file 
configuration must match the same configuration as the cytometer 
data source.

Recording a target 
source FCS file

To record a target source FCS file:

1. In the Recording Settings pane, create a file which contains a 
few specific events (for example, set the event limit to 500, and 
set a stopping gate on singlets). In the File field, name the file 
(for example, Target QC).

See Creating an FCS file to record laser alignment (page 290) 
for instructions on creating an FCS file using the Recording 
Settings pane.

2. In the Acquisition Dashboard, click Acquire, then click Record 
to record the data file.
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Applying the target 
source

You can add a target source to your plots to show what your 
optimized alignment looks like.

To apply the target source:

1. Select the plot(s) that you want to apply the target source to.

2. In the Inspector, click the Dot Plot(s) tab.

3. In Target Source field, select the target QC FCS file.

The target source appears in gray as an overlay (bottom layer) 
in the plot. 

4. (Optional) Save the QC workspace with the target file 
displayed. 

5. Acquire the sample and view where the live events are in 
relationship to the gray target data. 

If the live events are close to the target data, the alignment is 
consistent. If not, the lasers alignment needs adjustment or the 
PMTV settings need adjustments to match medians of 45,000 
(fluorescent parameters) and 25,000 (scatter parameters).

More information • Optimizing the forward scatter signal (page 286)

• Laser delay (page 52)

• Adjusting PMT voltages and using optional integrators 
(page 125)

• Saving the QC workspace (page 292)
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Optimizing system settings for

samples
This chapter includes these topics:

• Creating plots and gates for optimization (page 296)

• Optimizing with compensation controls (page 301)

• Optimizing scatter parameters (page 302)

• Optimizing fluorescence detector voltages (page 305)

• Collecting data files for compensation (page 306)

• Defining populations for compensation (page 308)

• Performing auto compensation (page 311)

• Saving a compensation matrix (page 315)

• Restoring (importing) a compensation matrix (page 316)
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Creating plots and gates for optimization
Introduction This topic describes how to create plots and gates that you can use 

to optimize the fluorescence settings for a sample. This topic 
describes basic optimization tasks and does not include 
compensation. 

The following procedure uses 8-peak beads to illustrate the 
example.

Creating plots for 
optimization

To create plots to optimize settings for your sample:

1. Select File > New Workspace to start with a new workspace, if 
needed.

2. In the Data Sources pane, select Cytometer as the data source.

3. Double-click the Dot Plot tool on the Worksheet toolbar, then 
click twice in the worksheet to create two plots (scatter and 
fluorescence).

To stop creating multiple plots, click the pointer icon (used to 
select other worksheet elements).

4. Use the alignment tools on the Worksheet toolbar to align the 
two plots.
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Verify that the first plot (scatter) displays FSC vs SSC for the x- 
and y-axis labels.

5. Click the second plot (fluorescence) to enable the Plot 
Properties tab in the Inspector.

6. Under X Parameter, select 530/40(488) from the Parameter 
menu.
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7. Under Y Parameter, select 670/30(488) from the Parameter 
menu.

You can substitute different fluorescence parameters as 
needed.

8. Click Acquire in the Acquisition Dashboard to populate the 
plots with data.

9. Load a tube of the 8-peak beads sample.

10. In the Pressure Console pane, click Sample.

11. In the Recording Settings pane, select 200 from the Default 
Display Count menu.

12. Adjust the voltages for the scatter plot to place the population 
onscale, if needed.
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13. Adjust the voltages for the fluorescence to place all peaks 
onscale.

Creating gates for 
optimization

To create gates to optimize settings for your sample:

1. In the worksheet, click the scatter (FSC vs SSC) plot.

2. Create a gate on the singlet bead population. 

3. In the worksheet, click the scatter plot to enable the gating 
controls in the Gate Hierarchy pane.

Gate
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4. In the Gate Hierarchy pane, click the Show/Hide icon for the 
All Events population to show only the P1 population in the 
plot.

5. In the worksheet, click the fluorescence plot (530/40 vs 670/
30).

6. Create a gate around one of the bead populations.

More information • Creating rectangle gates (page 206)

• Creating polygon gates (page 207)

• Creating ellipse gates (page 209)

• Creating interval gates (page 212)
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Optimizing with compensation controls
Introduction This topic describes how to optimize the system using unstained 

and single-color controls to determine fluorescence spillover values 
and calculate compensation. 

Examples and figures show the application of this workflow using 
a generic immunophenotyping assay. You should adapt the 
procedure steps for your specific application.

This procedure assumes that single-color controls are cells. If you 
plan to perform compensation with beads, your control tubes 
should include separate tubes with stained and unstained beads. 
Note that you must use ADCs to generate the raw data that you 
use to calculate compensation. 

Workflow Perform the following workflow steps to optimize the system with 
compensation controls.

More information • Creating plots and gates for optimization (page 296)

• Restoring (importing) a compensation matrix (page 316)

Step Description

1 Optimizing scatter parameters (page 302)

2 Optimizing fluorescence detector voltages (page 305)

3 Collecting data files for compensation (page 306)

4 Defining populations for compensation (page 308)

5 Performing auto compensation (page 311)

6 Saving a compensation matrix (page 315)
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Optimizing scatter parameters
Introduction This topic describes how to optimize scatter parameters by creating 

a plot, populating the plot with data, drawing a gate, and adjusting 
the PMTVs and trigger levels. 

Procedure To optimize scatter parameters:

1. Select File > New Workspace, if needed.

2. In the Data Sources pane, select Cytometer as the data source.

3. In the Cytometer Settings pane, select FSC from the Detection 
Trigger menu.

4. Create an FSC vs SSC dot plot in the worksheet.

5. Load the tube of unstained cells.

6. In the Pressure Console pane, click Sample.

7. Click Acquire in the Acquisition Dashboard to populate the 
plots with data.

The plot populates.

Lymphocytes
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8. Click the FSC vs SSC plot to enable the Plot Properties tab in 
the Inspector.

9. In the Recording Settings pane, select 200 from the Default 
Display Count menu.

A low display count is useful for setup and compensation. Use 
a higher display count when you acquire a data file.

10. Adjust the FSC and SSC voltages so that the sample is onscale. 

11. In the Cytometer Settings pane, adjust the trigger level. 

If you set the trigger level too high, the population might not 
appear in the plot. If you adjust the trigger too low, you might 
display debris and less of the actual sample.
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12. Draw a gate around the population of interest on the FSC vs 
SSC plot. 

You can rename or change the color of the gate if needed. 

13. In the Gate Hierarchy pane, click the Hide/Show button for 
All Events to hide all events.

14. In the Pressure Console pane, click Sample to stop sample 
introduction. 

15. Remove the sample tube.

16. In the Pressure Console pane, click Backflush. Then after 
approximately 10 seconds, click Backflush again to stop the 
backflush.

More information • Optimizing with compensation controls (page 301)
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Optimizing fluorescence detector voltages
Introduction This topic describes how to optimize the fluorescence detector 

voltages using the single-color cellular compensation controls.

Procedure To optimize the fluorescence detector voltages:

1. In the Cytometer Settings pane, select Log for the fluorescence 
parameters that you will be using in your sample.

2. In the Cytometer Settings pane, add labels to the detectors. 

For example: 

a. Enter FITC for 530/40 (488). 

b. (Optional) Select preferences from the Edit menu and clear 
the Show Parameter’s Full Name checkbox to show only 
the label for each parameter.

3. Create dot plots so that each parameter in the experiment is 
represented. 

4. Load a tube containing the fully stained positive control 
(mixed with the negative control) on the tube holder. 

5. In the Pressure Console pane, click Sample.
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6. Adjust the voltage as necessary so that the negative and 
positive populations are onscale for each parameter.

7. In the Acquisition Dashboard, click Reset to refresh all plots. 

8. In the Pressure Console pane, click Sample to stop sample 
introduction.

9. Remove the sample tube, and in the Pressure Console pane, 
click Backflush. Then after approximately 10 seconds, click 
Backflush again to stop the backflush.

10. Repeat steps 6 to 9 as necessary.

Next step Collecting data files for compensation (page 306)

More information • Optimizing with compensation controls (page 301)

• Optimizing scatter parameters (page 302)

Collecting data files for compensation
Introduction This topic describes how to collect data files for compensation 

using cell controls. Compensation is performed by sampling a 
positive and negative population for each fluorescence parameter. 
The software uses these representative populations to compute the 
amount of dye spillover from each primary detector reaching other 
detectors. Compensation is computed using a compensation matrix 
(the inverted spillover matrix).

Before you begin Optimize settings for the sample. All voltages should be verified 
before recording the first compensation control. Changes to 
fluorescence parameter voltages during or after this step can result 
in inaccurate spillover estimates. 
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Recording controls To record the unstained control:

1. Select Cytometer > Configuration. 

The Cytometer Configuration dialog opens.

2. In the Channels tab, select the detectors you want to record for 
this experiment.

3. Select Cytometer as the data source. 

4. In the Recording Settings pane, click Path to select where you 
want to save the FCS file for the unstained control. 

5. In the Prefix field, type a prefix (name) or type a name in the 
File field for the unstained control sample before you record 
data.

6. In the Recording Settings pane, under Recording Rule, set the 
event limit value for your sample (for example, 1,000 events).

7. Load the tube of unstained cells.

8. In the Pressure Console pane, click Sample.

9. In the Acquisition Dashboard, click Acquire, then click Record 
to create an FCS file for the unstained sample tube.

10. In the Pressure Console pane, click Sample and remove the 
sample tube. 
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11. In the Pressure Console pane, click Backflush. Then after 
approximately 30 seconds, click Backflush again to stop the 
backflush.

12. Load a tube of single-color stained cells.

13. In the Pressure Console pane, click Sample.

14. Repeat steps 6 to 13 to record the remaining fluorescence 
controls.

Next step Defining populations for compensation (page 308)

More information • Optimizing with compensation controls (page 301)

• Collecting data files for compensation (page 306)

Defining populations for compensation
Introduction This topic describes how to define populations for compensation. 

The workflow provided is an example of performing compensation 
when each color control is in a separate tube. The same principles 
can be used when more than one color is in a tube.

Before you begin Collect files for compensation for using cell controls.

Procedure summary 1. For each single-color tube, make the FSC vs SSC gate a local 
gate.

2. Draw child gates for the positive population specific to the 
source for a single color. 

3. The negative population will be the local FSC vs SSC gate 
applied from the unstained control sample. 
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Selecting the 
negative control 
population

To identify and select a negative control population:

1. Add a new page to the worksheet.

2. In the Data Sources pane, select the unstained control.

3. Create two FSC vs SSC plots.

4. Draw a gate around the population of interest in the first plot, 
if needed.

5. Rename the gate (if needed), by typing in the Name field in the 
Inspector pane when the gate is selected (for example, Cells).

6. In the second dot plot, change the axes to fluorescence 
parameters using the Inspector pane or by right-clicking the 
axes labels (for example, FITC vs SSC).

7. Select the second plot. 

8. In the Gate Hierarchy pane, right-click the created gate (Cells) 
and select Convert to Local.

9. In the Gate Hierarchy pane, click the Hide/Show button for 
All Events to hide all events.

10. In the Gate Hierarchy pane, ensure that the converted-to-local 
scatter gate is selected, then select the gate that you previously 
created (for example, Cells).

11. Draw a gate around the negative events in the second plot and 
rename the gate (for example, Negative Control).

12. (Optional) Change the axes in the second plot to other 
fluorescence parameters and make sure that your gate for 
negative cells is negative in all the relevant parameters.

13. Select both plots. 

14. In the Inspector pane, change the source to one of your single-
color compensation controls.

15. In the Gate Hierarchy pane, right-click the gate of interest (for 
example, Cells) and select Convert to Local.
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16. Change the axes in the second plot so that one of the axes 
displays the parameter that matches your single-color sample 
(for example, if your sample is a FITC positive control, select 
FITC as one of the axes on the plot).

17. Select the gate (Cells) in the Gate Hierarchy pane, then draw a 
gate around the positive population.

18. Rename the new population (for example, FITC Control).

19. Repeat steps 13 to 18 for the remaining compensation 
controls. 

Next step Performing auto compensation (page 311)

More information • Working with gates (page 214)

• Optimizing with compensation controls (page 301)

• Collecting data files for compensation (page 306)
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Performing auto compensation
Introduction This topic describes how to select auto compensation parameters 

to build a compensation matrix, then select positive and negative 
controls and calculate compensation.

About applying 
compensation

Perform compensation using ADC parameters. However, when the 
plots that use compensation are created for sorting, create plots 
and gates using DSP parameters. 

Before you begin Gate populations for compensation using cells.

Selecting 
populations for the 
negative 
compensation 
control 

To select the population for the negative compensation control:

1. Click Compensation on the BD FACS Sortware toolbar.

The Compensation pane opens.

2. Click the Matrix tab, then click Manage Parameters. 

The Select Compensation Parameters dialog opens.
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3. Select only the checkboxes for the ADC parameters that 
should be compensated. 

4. Click OK to apply the selections and close the dialog.

The Matrix tab refreshes and displays the compensation 
matrix for the selected parameters.

5. Click the Auto Compensation tab.

6. Make sure that the list of parameters includes all parameters 
you want to include for compensation.

7. In the Gate Hierarchy, drag the negative control gate to the 
Auto Compensation tab and into the Negative column header.

This applies the negative control to all parameters in the Auto 
Compensation tab.
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Selecting 
populations for the 
positive 
compensation 
control 

To select populations for the positive compensation control:

1. In the Positive column, right-click the first parameter box, 
select the corresponding data source (FCS file) that contains 
the positive control, and then select the positive population.

In the following example, the gate (FITC Positive) was created 
with the FITC-positive sample and is being assigned to the 
FITC-positive box. You can also drag the required populations 
from the Gate Hierarchy pane or the population hierarchy.

The box changes color to reflect the assigned population. You 
can place the mouse cursor over each box to view the name of 
the population.

2. Repeat the assignments for the remaining parameters.

3. Click Calculate.

A compensation matrix is computed from the sampled 
spillover values (population medians) defined in the selected 
populations and is uploaded into the BD FACSJazz firmware. 
Any unused DSP parameters (ADC parameters that are not 
compensated) are then removed from the list of available DSP 
parameters.
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4. Click the Matrix tab, then select the Visualize checkbox.

This turns on software compensation for the ADC parameters, 
which mimics the output of the DSPs. You can visually 
compare uncompensated data to compensated data by 
toggling the Visualize checkbox using the ADC data in 
memory, which is easier and more efficient than reloading 
matrixes into the firmware and recollecting data.

The Visualize checkbox applies to the selected data source in 
the Compensation pane. If you are having trouble visualizing 
ADC compensation with the checkbox, verify that a spillover 
matrix exists for your data source (a compensation icon will be 
visible under the FCS file name in the Data Sources pane) and 
that the data source in the Compensation pane matches the 
data source of your plots.

Compensation is applied through the software to the ADC 
(raw) data of the data source selected for visualization only. 
The DSP data is the actual compensated data used for 
classifying sort decisions. You must sort on DSP-gated 
parameters (hardware compensation), not on compensation-
enabled ADC parameters (software compensation). DSP 
parameters are indicated by an asterisk (*) in front of the 
parameter name on the axis parameters.

Next step Saving a compensation matrix (page 315)

More information • Optimizing with compensation controls (page 301)

• Defining populations for compensation (page 308)

• Restoring (importing) a compensation matrix (page 316)
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Saving a compensation matrix
Introduction This topic describes how to save a compensation matrix file so that 

you can restore specific compensation settings at any time.

Procedure To save a compensation matrix file:

1. In Data Sources pane, under Cytometer, right-click 
Compensation, then select Save Compensation.

The Save Compensation Matrix dialog opens.

2. In the Name field, type a new file name.

3. In the Description field, add a description about when or how 
this compensation matrix should be used.

4. Click OK.

The compensation matrix file is saved. You can restore 
(import) this compensation matrix for other configurations.

More information • Optimizing with compensation controls (page 301)

• Performing auto compensation (page 311)

• Restoring (importing) a compensation matrix (page 316)



BD FACSJazz User’s Guide316

Restoring (importing) a compensation matrix
Introduction This topic describes how to load a pre-defined compensation 

matrix for your configuration. Compensation matrixes can be 
restored on the cytometer (subsequent acquired or recorded data 
will have ADC visualized compensation as well as DSP 
compensation) or already recorded FCS files (only ADC visualized 
compensation will be available). 

Restoring a 
compensation 
matrix file

To restore (import) a compensation matrix file:

1. In Data Sources pane, right-click Cytometer or another data 
source (FCS file), then select Restore Compensation. 

The Restore Compensation Matrix dialog opens.

2. Under Compensation List, select a compensation matrix.

3. Click OK.

The compensation matrix file imports into the current 
configuration.
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4. In the Compensation pane, click the Matrix tab, select the 
desired data source, and then select the Visualize checkbox.

More information • Performing auto compensation (page 311)

• Saving a compensation matrix (page 315)
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Sorting

This chapter includes these topics:

• Sort setup workflow (page 320)

• Optimizing the drop breakoff (page 321)

• Optimizing the side streams (page 322)

• Aligning the side streams with the sort tubes (page 327)

• Determining an accurate drop delay (page 329)

• Determining the drop delay with BD FACS Accudrop (page 330)

• Determining the drop delay using the calibration slides (page 334)

• Saving and restoring sort layouts (page 337)

• Monitoring the sort (page 338)

• Working with sort reports (page 340)

• Index sorting (page 341)
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Sort setup workflow
Introduction This topic describes the workflow steps for setting up and 

performing a sort. 

Before you begin • Perform QC.

• Optimize system settings for your samples.

Workflow

More information • Creating plots and gates for optimization (page 296)

• Saving and restoring sort layouts (page 337)

• Working with sort reports (page 340)

• Index sorting (page 341)

Step Description

1 Optimizing the drop breakoff (page 321)

2 Optimizing the side streams (page 322)

3 Aligning the side streams with the sort tubes (page 327)

4 Determining an accurate drop delay (page 329)

5 Monitoring the sort (page 338)
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Optimizing the drop breakoff
Introduction This topic describes how to optimize the drop breakoff. 

Drop formation and breakoff are achieved by applying an acoustic 
wave to the stream. The stability of the drop breakoff is a function 
of nozzle size, sheath pressure, and drop frequency. The instrument 
has a fixed nozzle size (100 µm) and sheath pressure (27 psi). 
Minor adjustments can be made to the drop frequency (~39 kHz) 
for breakoff optimization. The optimal frequency has the highest 
breakoff (closest to the nozzle).

Procedure To optimize the drop breakoff:

1. Click Sort Settings on the BD FACS Sortware toolbar. 

2. The Sort Settings pane opens.

3. Set the piezo amplitude value.

In the Drop Formation panel:

a. Make sure the piezo amplitude is on.

b. Set the piezo amplitude to 4.0.

4. Adjust the drop frequency to achieve the highest breakoff.
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If the breakoff is too high to visualize, lower the piezo 
amplitude to keep it on screen.

Next step Optimizing the side streams (page 322)

More information • Sort setup workflow (page 320)

Optimizing the side streams
Introduction This topic describes how to bring the breakoff into phase with the 

charge cycle, thus optimizing side-stream deflection, which helps 
maximize sort recovery. 

Before you begin • Verify that the deflector plates voltage is turned off. Make sure 
that they are clean and dry.

• Make sure that a waste collection device is in place to catch the 
test stream.

• Make sure that the stream breakoff has been optimized.

• Verify that the deflections plates are in the closed position, 
replace the plate access panel (interlocked to the Accudrop 
laser and deflection plates), and close the sort chamber door 
(interlocked to the Accudrop laser and deflection plates).

No breakoff Initial 
breakoff

Adjusted 
breakoff

Highest breakoff 
and optimal 
frequency
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Optimizing the side 
streams with a 
flash charge

To optimize the side streams with a flash charge:

1. Close the nozzle access door (interlocked to the drop charge).

2. Turn on the plates by pressing the PLATES button (or clicking 
Plates in the Pressure Console pane).

The PLATES button illuminates when the voltage is on.

3. Open the Sort Layout pane. 

4. Under Sort Device, select 2 Tube Holder - 2 Way Sort. 

The left and right sort positions appear. 

5. Click Safe to move the sort tray so that the center of the waste 
receptacle aligns under the stream drain.

6. Click Sort Settings on the BD FACS Sortware toolbar. 

The Sort Settings pane opens.

7. Under Stream, click Test Streams to charge the drops. 
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Sort streams should now be visible in the sort stream image.

If the streams are fanning or not visible, adjust the piezo 
amplitude. 

8. Click Flash Charge to test the synchronization of the drop 
formation with the charge cycle.

If the side streams are not optimally deflected, the drop 
formation is not in phase with the charge cycle.

9. Under Drop Formation, in the Piezo Amplitude field, adjust 
the amplitude until the side streams are optimally deflected. 
Keep the breakoff in camera view.
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There should be little to no difference between test streams 
with flash charge on or off. Short flash can be used to further 
optimize side streams.

10. Under Stream, click Flash Charge again to turn it off.

11. Under Stream, adjust the Stream Focus value to minimize the 
center stream fanning.

Fanning of 
main 
stream

Before amplitude adjustment After amplitude adjustment
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12. Click Test Streams to turn off the side stream deflection.

13. View and note how the drops are connected and note the size 
of the small detached drop after the last connected drop.

The shape of the drop at the breakoff must remain constant 
during the sort. It may be necessary to adjust the piezo 
amplitude while sorting to maintain the drop shape.

Next step Aligning the side streams with the sort tubes (page 327)

More information • Sort setup workflow (page 320)

Before stream focus adjustment

Residual charge 
on drops

After stream focus adjustment
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Aligning the side streams with the sort tubes
Introduction This topic describes how to align the side streams with the sort 

tubes.

Procedure To align the side streams with the sort tubes:

1. Click Sort Layout on the BD FACS Sortware toolbar.

The Sort Layout pane opens.

2. Click Eject to move the sort tray into the loading position.

3. Load the tube or sort device.

4. Under Sort Device, select the sort device from the list.

5. Place the appropriate number of tubes in the desired positions 
in the sort device.

6. Click Sort Ready to move the sort tray to the sort ready 
position.

7. In the Sort Settings pane, click Test Streams to deposit sheath 
fluid into the tubes.

8. Verify that the side streams are aligned with the center of each 
tube.
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9. If the streams are too narrow or too wide, adjust the 
maximum stream deflection for the appropriate stream 
position. Repeat steps 2 through 8 until the side streams are 
aligned with the center of the sort tubes.

10. Adjust the tray control position if necessary.

a. Click the Tray Control pane on the BD FACS Sortware 
toolbar to show the pane.

b. If the streams are hitting too far forward or backward, 
adjust the Y position to align the sort device with the 
streams.

c. Once the tray position has been optimized, click Set Home 
to save the x- and y-coordinates for the sort device.
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Next step Determining an accurate drop delay (page 329)

More information • Sorting (page 319)

• Sample collection (page 58)

• Sort setup workflow (page 320)

• Optimizing the side streams (page 322)

Determining an accurate drop delay
Introduction This topic list the options for determining an accurate drop delay, 

which will help ensure that you sort the correct target events. 

Drop delay 
workflow options

The following drop delay workflows are available.

• Determining the drop delay with BD FACS Accudrop 
(page 330)

• Determining the drop delay using the calibration slides 
(page 334) 

• Saving and restoring sort layouts (page 337)

More information • Sort setup workflow (page 320)

• Aligning the side streams with the sort tubes (page 327)
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Determining the drop delay with BD FACS 
Accudrop
Introduction This topic describes how to determine the drop delay with 

BD FACS Accudrop.

How drop delay is 
determined

To determine the drop delay, the streams are illuminated by the 
Accudrop laser just below the deflection plates. When the 
Accudrop optical filter is in place, Accudrop beads can be viewed 
in the center and in the side streams as the drop-delay value is 
adjusted. The most precise drop-delay value yields the most 
particles in the side streams and the fewest in the center stream.

Before you begin In a tube, mix one drop of BD FACS Accudrop beads (Part No. 
345249) in 0.5 mL of filtered phosphate buffered saline (PBS) or 
sheath fluid.

Determining the 
drop delay

To determine the drop delay:

1. Load the tube of Accudrop beads.

2. In the Cytometer Settings pane, select FSC from the Trigger 
Detector menu.

3. Adjust the sample offset (in the Pressure Console pane) to 
achieve an event rate near 1,000.
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4. In the worksheet, create a large gate encompassing all events of 
an FSC vs SSC plot. 

This gate should include all bead populations, including 
aggregates.

Selecting the sort 
mode and starting 
the sort

To select the sort mode and start the sort:

1. Click Sort Layout on the BD FACS Sortware toolbar.

The Sort Layout pane opens.

2. Under Sort Device, select Accudrop Setup.

The sort mode defaults to 1.0 Drop Enrich, and the Unlimited 
checkbox is checked. 

3. Assign the Accudrop gate as the target sort population.
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4. Click Sort Ready.

5. Click Start.

Setting up the 
Accudrop filter

To set up the Accudrop filter:

1. In the Pressure Console pane, click Accudrop to move the 
Accudrop filter in place.

2. Ensure that the sort chamber door is closed. 

The side stream camera should show the location of the 
Accudrop beads either in the center stream, the side stream, or 
both.

Determining the 
drop delay

To determine the drop delay:

1. Locate the Drop delay field in the Sort Settings dialog. 

2. In the stream camera, note the brightness of the beads being 
sorted to the left and to the center (waste bucket). 

3. Adjust the drop-delay value while monitoring the center and 
left sort streams. 

The correct drop delay is set when the center stream is dark (or 
not present) and the left stream is bright.

The following figures illustrate correct and incorrect drop 
delays with the Accudrop filter in place. The image 
background color has been altered for illustrative purposes. 

The incorrect drop delay image shows that the illuminated 
beads are going to the waste bucket. The correct drop delay 
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image shows that the illuminated beads are being sorted to the 
left.

Next step Monitoring the sort (page 338)

More information • Aligning and optimizing the optics workflow (page 268)

• Sort setup workflow (page 320)

Incorrect drop delay with 
beads sorted to waste

Correct drop delay with 
beads sorted to the left
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Determining the drop delay using the calibration 
slides
Introduction This topic describes how to determine an accurate drop-delay 

value by sorting multiple drops forming puddles onto a microscope 
slide, each with a different drop-delay value.

A precise drop-delay value results in more beads in a target puddle. 
There are multiple ways to sort onto a slide to determine the delay. 
This topic describes the calibration slide method.

Required materials • Fluorescent beads (larger beads are easier to see and count on 
the slide but may cause side stream fanning)

• 0.5 mL of filtered sheath fluid

• 12 x 75-mm glass slides 

• A fluorescence microscope 

Before you begin • Prepare a tube of fluorescent beads (1 drop per 0.5 mL of 
filtered sheath fluid).

• Optimize the stream breakoff.

Preparing a 
calibration slide

To prepare a calibration slide:

1. Run a tube of fluorescent beads.

2. Create an FSC vs SSC plot.

3. Draw a gate around the singlet bead population in the plot.

4. Adjust the Sample Offset value to achieve an event rate of 500 
beads per second.

5. Click Sort Layout on the BD FACS Sortware toolbar.

The Sort Layout pane opens.

6. Click Eject to access the sort tray.

7. Place a microscope slide in the front position of the universal 
sort device.
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Sorting onto a 
calibration slide

To sort onto a calibration slide:

1. In the Sort Layout pane, under Sort Device, select Coarse 
Calibration Slide.

The sort mode and sort limit settings update automatically 
with the defined values for the coarse calibration slide.

2. Select all wells and assign the singlet bead gate for the 
fluorescent beads as the target sort population. 

3. Click Sort Ready and ensure that the left side stream is aligned 
with the slide. 

4. Click Start to start the sort.

The Sort Drop Delay dialog opens once the sort is complete. 
Do not close this dialog until you have determined the proper 
delay in the next step.

5. Using a fluorescence microscope, count the number of beads in 
each puddle and identify which well contains the most beads.
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6. In the Sort Drop Delay dialog, click the drop-delay value that 
corresponds to the drop with the highest bead counts.

7. Click OK to set the drop delay value.

8. In the Sort Layout pane, under Sort Device, select Calibration 
Slide, and repeat steps 1 through 7 to determine a precise drop 
delay.

Next step Monitoring the sort (page 338)

More information • About settings files (page 110)

• Working with settings files (page 113)

• Sort setup workflow (page 320)

• Determining an accurate drop delay (page 329)
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Saving and restoring sort layouts
Introduction After you have set up your sort, you can save all settings in the Sort 

Layout pane except the piezo amplitude.

About saving and 
restoring sort 
layouts

You can save a sort layout and restore it at any time. Note that the 
sort layout is also saved when you save a workspace. If you save a 
specific sort layout separately, you can restore it and apply it to any 
workspace.

See About settings files (page 110) for more information about 
what information is saved.

Saving a sort layout To save a sort layout:

1. Select File > Save > Sort Layout.

The selected Save Sort Layout dialog opens.

2. Select the storage folder where you want to save the settings 
file from the Storage menu.

See Creating storage folders (page 116) for more information 
about creating custom storage folders.

3. Under Sort Layout Details, type a name for the new settings 
file in the Name field.

4. Click OK to save the workspace and close the dialog.

Restoring a saved 
sort layout

To restore a saved sort layout:

1. Select File > Restore > Sort Layout.

The selected Restore Sort Layout dialog opens.

2. Under Sort Layouts, select the layout you want to restore, then 
click OK. 

The Sort Layout dialog reflects the restored layout.
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Monitoring the sort
Introduction This topic describes how to monitor the sort for best results. 

The timing of when a drop is charged is defined during the sort 
setup and drop-delay optimization. It is important to monitor the 
sort to ensure that the breakoff does not change, if necessary 
making small adjustments to the piezo amplitude. It is also 
important to maintain the same scatter and population percentages 
during the sort.

This chapter provides tips to maintain a successful sort.

Before you begin • Make sure that you have removed bubbles from the fluidics 
tubing.

• Turn on the deflection plates.

• Filter all samples to 40 µm (about half the nozzle tip size) to 
prevent nozzle clogs and ensure optimal sorting.

• Load a sample tube.

• Record data to create pre-sort FCS files.

Monitoring the sort To monitor the sort:

1. View the scatter plot in the worksheet and slowly increase the 
sample offset (if needed).

Stop increasing the sample offset when:

• The scatter populations shift or change shape.

• The sorting efficiency counter is unacceptably low.
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2. Monitor the following.

3. (Optional) Save an FCS file during a long sort to maintain a 
record of the sort.

Saving a sort To save a sort if a clog forms during a sort:

1. Quickly turn off the deflection plates, stop the sample flow, 
stop the stream, and install the flush bucket under the nozzle.

2. If you are working with nonhazardous materials, remove the 
collection device to avoid contamination with unwanted cells.

Category What to look for Troubleshooting

Sort efficiency 
counter (in the Sort 
Layout pane)

Efficiency varies depending on 
population percentages and 
sample concentration.

Decrease the sample offset to 
improve sorting efficiency.

Acquisition 
efficiency (in the 
Acquisition 
Dashboard pane)

Efficiency becomes 
unacceptably low. 

Reduce the sample offset, or 
filter, or dilute the samples.

Gates and 
populations (in 
worksheets)

Populations should stay within 
the gates and should not move 
during the sort.

Decrease the sample offset or 
adjust the gates. Refresh the plot 
display rate often to confirm that 
populations have not moved out 
of the gate.

Drop image Breakoff should be stable and 
remain at the same drop.

Adjust the piezo amplitude to 
keep the breakoff at the same 
drop and maintain the breakoff 
profile.

Stream image Side streams should not fan or 
spray out of the drain.

 Verify that the 100-µm nozzle 
is large enough for the cells 
being sorted.

 Adjust the piezo amplitude 
slightly.

 Filter the cells before sorting.
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More information • Sort setup workflow (page 320)

• Working with sort reports (page 340)

Working with sort reports
Introduction This topic describes how to preview and print sort reports after a 

sort completes and how to save them as PDF files. Sort reports are 
automatically stored to the default location (C:\Users\My User 
Name\Documents\BD\Sortware\Sort Reports).

Viewing a sort 
report

To view a sort report:

1.  Under Sort Report, click Preview.

The Report Dialog opens.

Printing a sort 
report

To print a sort report:

1. In the Sort Layout, click Preview, if needed.

2. In the Report Dialog, click the Print button on the toolbar.
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Creating a PDF 
version of a sort 
report

To create a PDF sort report:

1. In the Sort Layout, click Preview, if needed.

2. In the Report Dialog, click the PDF button on the toolbar.

The Select PDF Output File dialog opens.

PDFs are created by default. This process creates a PDF to a 
user-specified location using the preview.

3. In the Save in field, select a folder.

4. In the File name field, type a new name for the report, then 
click Save.

More information • Sort setup workflow (page 320)

• Monitoring the sort (page 338)

Index sorting
Introduction This topic describes index sorting.

About index sorting Index sorting is useful in characterizing subpopulations of 
phenotypically similar events using post-sort genetic, chemical, 
and/or metabolic applications.

Index sort mode is a special acquisition mode which records the x 
and y positions of the sort stage in the FCS file, allowing you to 
trace the events sorted to a particular location (for example, a well 
on a plate tray device) to the specific event that was sorted in 
BD FACS Sortware.



BD FACSJazz User’s Guide342

Before you begin • Prepare the sort chamber for sorting by cleaning the deposition 
area and installing a sort device onto the sort tray.

• Optimize the stream breakoff.

• Determine the drop delay.

Setting up for index 
sorting

To set up for index sorting:

1. In the Compensation pane, click Manage Parameters and 
verify that there are at least two unassigned parameters. 

If all parameters are assigned, clear at least two compensation 
parameters from the ADC list before starting index sort mode. 
The FSC and SSC DSP channels are typically not needed for 
compensation and can be used for index sorting.

2. On the BD FACS Sortware toolbar, click Sort Layout.

3. In the Sort Layout pane, select a multi-position sort device:

• Default multi-position formats include: 6 Well Tray, 24 
Well Tray, 96 Well Tray, 384 Well Tray, and 4 x 12 Slide.

• Custom multi-position formats.

4. Select a sort mode and sort limit. 

See Selecting the sort mode and starting the sort (page 331).

Note:  The 1-Drop Single sort mode is typically used for single- 
cell deposition.
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5. Align the side streams to the sort device using the Sort Settings 
dialog and the Tray Control pane.

6. Load a sample and acquire data.

7. Ensure that the voltages, compensation, sort gates, and event 
rate are appropriate.

8. In the Sort Layout dialog, assign populations to each well sort 
target.

9. Stop the sample from running.

Starting an index 
sort

To start an index sort:

1. Make sure that the software is not currently acquiring data. 

Acquisition must be stopped so that index sort mode 
acquisition can start.

2. In the Recording Settings pane, click Path to select the path 
and file name for your index sort file.In the Sort Layout pane, 
click Sort Ready.

3. In the Pressure Console pane, click Sample.

4. In the Sort Layout pane, under Recording, click Start Index 
Sort.
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Data is continually recorded and displayed while index sort 
mode is running.

Index sort mode creates an FCS file. Using the Data Sources 
functions, you can generate a CSV file where all the sort 
deposition information and tray position information is stored 
on an event-by-event basis. All the events are stored in the file, 
including those not actually sorted. You can import this CSV 
file into a spreadsheet to review the results.

5. Once the sort is complete, click the Stop Index Sort button to 
stop the index sort mode.

Analyzing the index 
sort

To analyze the index sort:

1. Select the index sort FCS file in the Data Sources pane. 

2. Create dot plot(s) in the worksheet. 

3. Select the plot(s).

4. In the Inspector dot plot(s) tab, select Large from the Dot Size 
menu. 



Sorting 345

5. In the Data Sources pane, double-click Index Sort Analysis for 
the index sort data source of interest. 

6. In the Index Sort Analysis and Report dialog, select one or 
more locations to display on plot(s). 
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To select multiple locations, drag the cross hair to include all 
locations of interest. 

Viewing index sort 
results in a 
spreadsheet

You can generate an index sort report CSV file that you can import 
into a spreadsheet to view the results for each sort. 

To generate the index sort report CSV file:

1. Create the statistics view for the index sort data source.

2. Right-click the statistics view associated with the plot you used 
for index sorting and select Export Index Sort Statistics.

The Select Output File dialog opens.
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3. Navigate to the folder where you want to save index sort 
reports, then select the CSV file type.

4. Click Save.

5. Open your spreadsheet application and open the index sort 
report as a CSV file.

The following figure shows an example an index sort report 
for a 4 x 12 slide. To add Tray X and Tray Y medians, include 
them in your statistics view.

More information • Sort setup workflow (page 320)
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System shutdown

This chapter includes these topics:

• System shutdown workflow (page 350)

• Cleaning the sample line (page 351)

• Installing the debubble reservoir (page 352)

• Rinsing the system (page 353)

• Drying the fluidics lines (page 355)

• Cleaning the sort chamber (page 356)

• Turning off the power (page 357)
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System shutdown workflow
Introduction This topic describes the workflows for performing a wet or dry 

shutdown of the system. 

If you perform a wet shutdown, your startup workflow (the next 
day) is different than if you perform a dry shutdown. See Startup 
workflow (page 248) for more information.

About wet 
shutdown

Wet shutdown is useful when you plan to use the BD FACSJazz 
sorter the next day and you do not need to run a specific cleaning 
or decontamination protocol as a part of your daily maintenance.

Wet shutdown 
workflow

About dry 
shutdown

Dry shutdown is required when you need to prepare the system for 
a period of non-use, or when you want to run a specific cleaning or 
decontamination protocol in preparation for instrument service or 
maintenance.

Step Description

1 Cleaning the sample line (page 351) 

2 Installing the debubble reservoir (page 352) 

3 Turning off the power (page 357) 
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Dry shutdown 
workflow

More information • Cleaning and inspecting the instrument (page 63)

• Startup workflow (page 248)

Cleaning the sample line
Introduction This topic describes how to clean the sample line for a wet or dry 

shutdown.

Required materials • Sample tubes

• 10% bleach solution

• DI water

Stage Description

1 Cleaning the sample line (page 351) 

2 Rinsing the system (page 353) 

3 Drying the fluidics lines (page 355)

4 Cleaning the sort chamber (page 356)

5 Turning off the power (page 357)
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Procedure To clean the sample line for a shutdown:

1. Load a tube of 10% bleach and run it for 5 minutes.

2. Load a tube of DI water and run it for 5 minutes.

3. Perform one of the following steps depending on the type of 
shutdown you are performing:

• If you are performing a wet shutdown, leave the tube of DI 
water on the sample holder.

• If you are performing a dry shutdown, remove the tube of 
DI water from the sample holder.

Next steps • If you are performing a wet shutdown, see Installing the 
debubble reservoir (page 352).

• If you are performing a dry shutdown, see Rinsing the system 
(page 353).

More information • System shutdown workflow (page 350)

• Startup, shutdown, and troubleshooting components 
(page 250)

Installing the debubble reservoir
Introduction This topic describes how to use the debubble reservoir for a wet 

shutdown. 

Required materials • Debubble reservoir

• DI water

• Flush bucket
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Procedure To install the debubble reservoir:

1. While the stream is still running, place the flush bucket under 
the nozzle.

2. Fill the debubble reservoir with DI water. 

3. Place it on top of the flush bucket.

4. Verify that the nozzle tip is submerged in the water in the 
debubble reservoir.

5. In the Pressure Console pane, click Stream to stop running the 
stream. 

6. Disconnect the sheath line from the sheath tank.

7. Turn off the house vacuum and air supply.

Next step Turning off the power (page 357)

More information • Fluidics overview (page 32)

• Startup, shutdown, and troubleshooting components 
(page 250)

• System shutdown workflow (page 350)

Rinsing the system
Introduction This topic describes the cleaning procedure to complete a dry 

shutdown.

Required materials • 1 L of DI water for the sheath tank

• Flush bucket

Before you begin Clean the sample line. 
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Procedure To clean the system for a dry shutdown:

1. Install the flush bucket.

2. In the Pressure Console pane, click Stream to turn off the 
stream.

3. Remove the tube of DI water.

4. Turn off the air supply by switching the Air switch off.

5. Empty the sheath tank and fill it with 0.5–1.0 L of DI water.

6. Empty the waste tank. 

7. Reattach the sheath tank and waste tank.

8. Turn on the air supply by switching the Air switch on.

9. In the Pressure Console pane, click Rinse, then click Backflush 
to rinse all fluid lines with DI water. Then after approximately 
2 minutes, click Backflush again to stop the backflush.

10. Release the pressure in the sheath tank by opening the pressure 
release valve. 

11. Bypass the sheath filter by disconnecting the sheath lines from 
the sheath filter and reconnecting the sheath lines together 
without the sheath filter.

12. Click Rinse, then click Backflush to rinse the tubing with the 
rest of the DI water until the tank runs dry and the sample line 
is not longer dripping water.

13. In the Pressure Console pane, click Rinse to turn off the flow.

Next step Drying the fluidics lines (page 355)

More information • System shutdown workflow (page 350)
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Drying the fluidics lines
Introduction This topic describes how to dry the fluidics lines for a dry 

shutdown.

Required materials • DI water

• Flush bucket

Procedure To dry the fluidics lines:

1. Remove the nozzle tip. 

2. Place the flush bucket under the nozzle.

3. Release the pressure in the sheath tank by opening the pressure 
release valve.

4. Bypass the sheath filter by disconnecting the air and fluid lines 
from the sheath tank and connecting them to each other.

5. In the Pressure Console pane, click Rinse, then click Backflush.

6. Allow air to blow through the system for about 10–15 minutes 
to completely dry it.

7. In the Pressure Console pane, click Rinse to stop drying the 
system.

8. Turn off the air supply by switching the Air switch off.

9. Turn off the house air supply or air compressor and vacuum 
supply.

10. Empty all fluid from the waste and sheath tanks, rinse them 
with clean DI water, and allow them to dry overnight.

Next step Cleaning the sort chamber (page 356)
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More information • Replacing the nozzle tip (page 71)

• Decontaminating the fluidics (page 66)

• System shutdown workflow (page 350)

• Rinsing the system (page 353)

Cleaning the sort chamber
Introduction This topic describes how to clean the sort chamber for a dry 

shutdown.

Required materials • DI water

• Kimwipes or other lint-free towel

Procedure

To clean the sort chamber:

1. Verify that the deflection plates are off. 

2. Clean the deflection plates with DI water. See Cleaning the 
deflection plates (page 64) for more information. 

3. Wet a Kimwipes wipe or other lint-free towel and wipe any 
spills in the sort chamber or sample port area.

4. Wet a Kimwipes wipe or other lint-free towel with DI water 
and wipe again. 

Next step Turning off the power (page 357)

Caution: Biohazard! Wear protective clothing before 
cleaning the sort chamber.
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More information • System controls (page 29)

• Cleaning and inspecting the instrument (page 63)

• Decontaminating the fluidics (page 66)

• System shutdown workflow (page 350)

Turning off the power
Introduction This topic describes how to turn off the system power for a wet or 

dry shutdown.

Procedure To turn off power for shutdown:

1. Save your workspace, if needed.

2. Select Cytometer > Shutdown Cytometer, then click OK.

The cytometer interface is now disconnected from the 
instrument electronics and will turn off automatically.

3. Exit BD FACS Sortware software.

4. Turn off the computer.

5. Turn off the air supply by switching the Air switch off.

6. Turn off the main power.

More information • Cleaning and inspecting the instrument (page 63)

• System shutdown workflow (page 350)

• Cleaning the sort chamber (page 356)
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20
BD FACSJazz options

This chapter includes these topics:

• BD FACSJazz system options overview (page 362)

• Aerosol management option (page 363)

• Air compressor and vacuum pump (page 364)

• Biological safety cabinet (page 365)

• Temperature control option (page 367)

• Integrators (page 368)
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BD FACSJazz system options overview
Introduction This topic lists the options and upgrades available for the 

BD FACSJazz system.

About options System options described in this chapter have been validated and 
qualified for use with the BD FACSJazz system. If you plan to use 
other third-party hardware, you are responsible for validating the 
system and verifying the results.

Options The following table lists the available options.

Ordering and 
installing options

Contact your BD representative for more information about 
ordering and installing these options.

Category Option More information

System 
hardware

Aerosol 
evacuation unit

Aerosol management option 
(page 363)

Air compressor 
and vacuum pump

Air compressor and vacuum pump 
(page 364)

Biological safety 
cabinet

Biological safety cabinet (page 365)

Temperature 
control

Temperature control option 
(page 367)

Integrators Integrators (page 368)

Optics Laser upgrade Contact your BD representative.
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Aerosol management option
Introduction This topic describes the aerosol management option for the 

BD FACSJazz system. 

Aerosol 
management 
option

The BD FACSJazz aerosol management option (AMO) uses a 
vacuum source to rapidly evacuate aerosolized particles through an 
ultra-low penetration air (ULPA) filter during routine sorting or 
acquisition. This unit evacuates aerosols from the sort chamber, 
preventing the aerosols from being circulated back through the 
chamber.

Using the AMO 
with the 
BD FACSJazz system

The following are some guidelines for using the AMO with the 
BD FACSJazz system:

• Operate the AMO at 20% during sorting.

• Operate the AMO at 100% for 1 minute after a clog, before 
opening the sort chamber door.

• Change the filter according to the manufacturer’s instructions.

Installation BD Service performs installation.
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More information • BD FACSJazz system options overview (page 362)

Air compressor and vacuum pump
Introduction This topic describes the air compressor and vacuum pump options 

for the BD FACSJazz system. 

Air compressor 
option

An external air compressor is necessary if you do not have a 
compressed air supply in your laboratory. The external air 
compressor provides a constant supply of clean, dirt- and oil-free 
air at sufficient pressure to achieve the needed 27 psi for the 
BD FACSJazz system during operation.

The air compressor runs directly from the wall power source, 
independent from the instrument power circuitry. Make sure that 
you run the system with clean, dry air.

Air compressor 
installation

Attach the air line to the sheath tank valve.

Vacuum pump 
option

An external vacuum pump is necessary if you do not have a 
vacuum supply in your laboratory. The vacuum pump runs directly 
from the wall power source, independent of the instrument power 
circuitry. Make sure that you run the system with a moisture trap. 
Otherwise, water can get into the vacuum lines and can cause 
damage to your pump.
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More information • BD FACSJazz system options overview (page 362)

Biological safety cabinet
Introduction This topic describes the biosafety cabinet option for the 

BD FACSJazz system.

About the biosafety 
cabinet (BSC)

The biosafety cabinet (BSC) that is available as an option with the 
BD FACSJazz system is a Baker SterilGARD Class II A2 biological 
safety cabinet that separates the work space and air flow from the 
laboratory. It has a separate high efficiency particulate air (HEPA)-
filtered air supply and exhaust that protects laboratory personnel 
from materials in the biosafety cabinet, and also protects the 
materials in the cabinet from outside contaminating agents. 

See the BSC operator’s manual for details on the structure and 
operation of the cabinet.

Vacuum pump

Vacuum line

Hydrophobic filter
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Using the BSC with 
the BD FACSJazz 
system

During a sort, the system may overheat in the BSC, resulting in 
poor sorting. Monitor the sort and adjust the piezo amplitude as 
needed.

Installation The BSC is installed by the customer. BD Service installs the 
BD FACSJazz system. The BD FACSJazz system is placed in the 
indicated location in the BSC. Sheath and waste tanks are placed 
outside the BSC. If you have the temperature control option, cables 
and tubing exit the cable port on the right side wall.

More information • BD FACSJazz system options overview (page 362)
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Temperature control option
Introduction This topic describes the BD™ temperature control option for the 

BD FACSJazz system.

Temperature 
control option

The BD temperature control option can be used to control the 
temperature of sorted samples in the BD FACSJazz system.

The temperature control option comes with a recirculating water 
bath, 15 x 75-mm tube and 15-mL tube temperature-controlled 
collection devices, and connecting tubing.

Using the 
temperature 
control option

To use the temperature control option:

1. Turn on the temperature control option.

2. Set the desired temperature.

The temperature control option detects temperature changes in 
the sample input tube and the sample collection device and 
adjusts the temperature accordingly.

More information • BD FACSJazz system options overview (page 362)
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Integrators
Introduction This topic describes the integrator option for the BD FACSJazz 

system.

About integrators Integrators are dedicated hardware components that measure the 
area and the width of a voltage pulse for selected parameters. They 
work in parallel with the height measurement.

You can select to enable or disable integrators as needed. Each 
parameter is available for integration. You can apply different 
integrators to different plots within the same worksheet.

Installation BD Service performs installation.

More information • Adjusting PMT voltages and using optional integrators 
(page 125)

• Integrators tab (page 127)

• Turning integrators on (page 128)

• BD FACSJazz system options overview (page 362)
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Troubleshooting

This chapter includes these topics: 

• Sorting troubleshooting (page 370)

• Acquisition troubleshooting (page 379)

• Fluidics troubleshooting (page 385)

• Alignment troubleshooting (page 389)

• Application troubleshooting (page 391)

• Electronics troubleshooting (page 392)

• Equipment troubleshooting (page 393)
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Sorting troubleshooting
Introduction This topic describes sorting problems and their possible solutions.

Stream is out of 
alignment Possible causes Possible solutions

Nozzle is not aligned Adjust the silver knobs to align the stream to 
the pinholes and adjust the black knobs to 
align the stream to the drain. See Optimizing 
the side streams (page 322) for more 
information. 

Bubbles in the nozzle  Install the debubble reservoir filled with 
clean sheath or ethanol and purge the 
nozzle.

 Verify that the nozzle tip and O-ring are 
seated properly and are aligned.

Clogged or damaged 
nozzle

1. Remove the nozzle tip and sonicate it in 
DI water or detergent to remove the clog. 

2. Examine the nozzle under a microscope 
to check for damage. 

If the nozzle is damaged, replace it. 
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No stream is visible

Side streams are 
not aligned

Possible causes Possible solutions

Empty sheath tank Refill the sheath tank.

Sheath tank is not 
pressurized

 Check the fittings for leaks and tighten 
the pressure release valve, using a wrench 
if necessary.

 Make sure that the O-ring is properly 
installed around the tank lid and that the 
lid is properly seated.

 Check the air compressor or the house air 
supply. Make sure that the Air switch is 
on.

Clogged or damaged 
nozzle

1. Remove the nozzle and sonicate it in DI 
water or detergent to remove the clog. 

2. Examine the nozzle under a microscope 
to check for damage. 

If the nozzle is damaged, replace it.

Leaking nozzle seal Reinstall the nozzle, ensuring that the O-ring 
is properly installed.

Air in the sheath filter 1. Use the RINSE fluidics mode and gently 
tap the sheath filter to remove air from 
the filter.

2. Purge the sheath filter.

Possible causes Possible solutions

Stream deflection is 
incorrect

Start the stream and adjust the stream 
deflection so that the stream is aligned to the 
tube.

Tray position is 
incorrect

Use the Tray Control pane to move the tray 
to its appropriate location.
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Last column is 
unreachable during 
plate sorting

Unstable stream or 
stream breakoff

Possible causes Possible solutions

Side stream is 
deflected too far to the 
left and unable to 
reach the far right 
column

Decrease the side stream deflection and 
reinsert the tray.

Possible causes Possible solutions

Debris or bubbles in 
the nozzle

 Remove the nozzle and sonicate it in DI 
water or detergent to remove the clog.

 Purge the nozzle using the debubble 
reservoir and clean sheath fluid or 
ethanol.

 Verify that the nozzle and O-ring are 
seated properly and tightened.

Fluidics are not 
warmed up

Run the stream for 30 minutes to 1 hour 
before sorting.

Air currents  Close the sort chamber door.

 Check the room for drafts.

Air or fluid leak  Check the sheath tank for leaks.

 Check the fluidic lines for leaks.

 Contact BD service.

Chemical residue in 
the sheath line

Perform a system flush or replace the sheath 
line.

Sheath tank is low or 
empty

Refill the sheath tank.

Air in the sheath filter Purge the sheath filter.

Clogged sheath filter Replace the sheath filter. 

Large cells or clumpy 
sample

Filter the sample. 
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No side streams are 
visible

Frequency setting is 
not optimal

Find the frequency setting that gives the 
shortest breakoff and the most stable stream. 

Sample line was not 
installed correctly in 
the nozzle

Adjust the sample line position in the nozzle. 

Debris in the sample Prepare a new sample.

Possible causes Possible solutions

Possible causes Possible solutions

Drop charge is not 
turned on

1. Turn on the test deflection.

2. Start the drop charge amplitude at 0 and 
increase it while watching for side 
streams.

Deflection plates are 
powered off

Turn on the deflection plates.

Deflection plates are 
open

1. Power off the deflection plates.

2. Close the deflection plates.

Drop charge is too 
high

Start the drop charge amplitude at 0 and 
increase it while watching for side streams.

Drop drive is not 
turned on

1. Increase the piezo amplitude.

2. Optimize the drop-drive frequency.

DI water is in the 
sheath lines

Use sheath fluid for drop charging.

Pressure and 
frequency settings are 
not optimized

Find the frequency setting that gives the 
shortest breakoff and most stable stream.
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Bad contact point for 
drop charge 
connection

Make sure the piezo amplitude is set to 0, 
then remove the nozzle assembly to inspect 
the charge contacts.

 If there is corrosion, clean the contact 
points.

 If the contact points are damaged, replace 
them.

Contact point is stuck 
due to salt buildup

1. Power off the deflection plates.

2. Remove the deflection chamber access 
cover and deflection plates.

3. Remove the plate carrier and use a stream 
of warm water to clean the contact 
points. 

4. Dry thoroughly before replacing and 
reassembling. 

Arcing between 
deflection plates

1. Power off the deflection plates.

2. Clean and dry the plates.

Side streams are not 
aligned to the 
Accudrop laser

Realign the side streams.

Wet, dirty, or salty 
plates

1. Power off the plates.

2. Clean and dry the plates.

Nozzle access door is 
open

Close the nozzle access door.

Sort chamber door is 
open

Close the sort chamber door.

Plate access panel is 
open

Close the plate access panel.

Possible causes Possible solutions
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Fanning around 
center or side 
streams when 
deflection plates 
are on

Possible causes Possible solutions

Clogged or damaged 
nozzle

1. Remove the nozzle and sonicate it in DI 
water or detergent to remove the clog. 

2. Examine the nozzle under a microscope 
to check for damage. 

3. If the nozzle is damaged, replace it.

Clumpy sample Filter the sample.

Frequency settings are 
not optimized

Scan the frequency settings around the 
recommended frequency to find the setting 
that gives the shortest breakoff and most 
stable stream.

Piezo amplitude is too 
low

Increase the piezo amplitude.

Stream focus is not set 
correctly

Adjust the stream focus to tighten the center 
stream.

Drop charging is out 
of phase with drop 
formation

1. Turn on test deflection and flash charge.

2. Adjust the piezo amplitude until the side 
streams are deflected as far as possible 
with minimum spraying.

Incorrect sort mode Verify that the sort mode is appropriate for 
your sorting requirements.
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Fluttering side 
streams, especially 
during Flash 
Charge and Short 
Flash modes

Fluttering side 
streams with AMO 
on

Low sort efficiency

Possible causes Possible solutions

Salt bridging that leads 
to partial discharge of 
the deflection plates

1. Power off the deflection plates.

2. Remove the deflection chamber access 
cover.

3. Remove and clean each plate.

4. Dry each plate and plate carrier 
thoroughly before reassembly.

If the problem persists, also remove, clean 
and dry the plate carrier.

Possible causes Possible solutions

AMO causes excessive 
air currents within the 
sort chamber

1. Ensure that the AMO is operating at the 
minimum level (20%) during the sort.

2. Run the sort with the sort chamber door 
slightly ajar (approximately 1 cm or 1/4−
1/2 in. maximum at the bottom).

Possible causes Possible solutions

Event rate is too high 
for drop-drive 
frequency

Decrease the sample pressure.

Gating conflicts Verify the sorting gate strategy.

Incorrect sort mode Verify that the sort mode is appropriate for 
your sorting requirements.

Rare sort populations Enrich the sample for the population of 
interest before sorting.

Sorted on ADC 
parameters, not on 
DSP parameters

Create plots with DSP parameters.
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Cannot see excited 
beads in the 
Accudrop laser

Can see excited 
Accudrop beads 
but not sorted 
Accudrop beads

Erratic sort rate

Unexpected sort 
results

Possible causes Possible solutions

Accudrop filter is not 
in place

In the Pressure Console pane, click Accudrop 
to move the Accudrop filter in front of the 
sort stream camera.

Event rate is too low  Add more beads to the tube.

 Increase the event rate.

 Increase the sample offset.

Possible causes Possible solutions

Deflected events are 
out of range of the 
Accudrop laser

1. Reduce the drop charge voltage until 
deflected drops just clear the drain. 

2. Restore the deflection voltage after 
performing the Accudrop.

Possible causes Possible solutions

Event rate is too high Decrease the event rate.

Clogged or kinked 
sample line

 Filter the sample.

 Clean or replace the sample line.

Possible causes Possible solutions

Incorrect drop delay Check the drop delay.

Incorrect sort mode Verify that the sort mode is appropriate for 
your sorting requirements.

Breakoff is not stable 
during the sort

 Watch the breakoff during the sort and 
adjust the piezo amplitude if necessary. 

 Remove the nozzle and sonicate it.



BD FACSJazz User’s Guide378

Index sorting 
button is not 
available or cannot 
start

Side streams are 
not hitting the 
target

Incorrect logic in sort 
gating

Verify the sorting gate strategy and check for 
any yellow populations (conflicts).

Side streams are 
fanning during the sort

See Fanning around center or side streams 
when deflection plates are on (page 375).

Sort device is not 
aligned correctly

Check the tubes and side streams for proper 
alignment before sorting.

Event rate is too high Decrease the sample pressure.

Possible causes Possible solutions

Possible causes Possible solutions

Cannot perform an 
index sort while 
acquiring data

Stop acquiring data.

No available DSP 
parameters

Manage parameters in the Compensation 
window and clear the parameters that you 
are not using.

Possible causes Possible solutions

Deflection rate is too 
low or too high

 Increase the maximum drop charge.

 Increase the maximum stream deflection.

Droplet breakoff is too 
low

Adjust the sort settings.

Wet or dirty plates Power off the plates and clean them.
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More information • Startup, shutdown, and troubleshooting components 
(page 250)

• Acquisition troubleshooting (page 379)

• Fluidics troubleshooting (page 385)

• Alignment troubleshooting (page 389)

• Application troubleshooting (page 391)

• Electronics troubleshooting (page 392)

• Equipment troubleshooting (page 393)

Acquisition troubleshooting
Introduction This topic describes acquisition problems and possible solutions.

No sample events
Possible causes Possible solutions

Laser(s) are shuttered Move the laser shutter tab to the open 
position.

Laser power is off Turn on the laser power supply and turn the 
key to start the laser.

Laser safety interlock 
is engaged

Close the nozzle access door and place your 
finger over the optical sensor in the upper-
right corner to reset the safety interlock.

Lasers are vertically 
misaligned

Vertically align the lasers. See Vertically 
aligning the lasers (page 68).

No sample in the tube Install a new sample tube.

Sample is not mixed 
properly

Mix the sample thoroughly and re-install the 
tube.

Sample line is clogged Clean or replace the sample line.
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Bubble detector 
triggered

 In the Pressure Console pane, click 
Backflush to reset the bubble detector.

 Verify that the sample line is long enough 
to reach the sample.

Air line sensor was 
triggered

Contact BD Service.

Tube is not properly 
installed

1. Re-install the tube.

2. Close the tube-lock lever under the tube.

3. In the Pressure Console pane, click 
Sample to pressurize the tube.

Laser or stream is not 
properly aligned

Align the stream and lasers.

Trigger is not set 
correctly

 Set the trigger detector or level according 
to the needs of your sample.

 Check the PMT voltage and the linear/log 
setting for the trigger detector.

Tube is not pressurized  Check the sample stopper for damage 
and replace it if necessary.

 Check the tube for damage and replace it 
if necessary.

PMT power is off Turn on the PMT power and adjust the 
voltage.

Sample pressure is too 
low

Adjust the sample offset to increase the 
sample pressure.

Possible causes Possible solutions
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No fluorescent or 
scatter signal

Sortware not 
connecting to the 
cytometer interface

Possible causes Possible solutions

Fluorochrome is not 
optimized for 
detection filters

Make sure that you use the appropriate 
fluorochromes that can be detected by the 
BD FACSJazz system for your application.

Laser delay or trigger 
delay is set incorrectly 

Adjust the laser delay.

PMT is labeled 
incorrectly

Check the instrument configuration to verify 
that you are looking at the correct channel.

Sample was not 
appropriately stained

Verify that the appropriate antibody or dye 
was added to the sample tube.

Forward scatter 
detector is not aligned

Align the forward scatter detector.

Wrong excitation laser 
wavelength

Use the correct excitation wavelength.

Wrong trigger channel 
is selected

Change the trigger detector and trigger level.

Possible causes Possible solutions

The cytometer 
interface is not turned 
on

Turn on the main power.

Faulty connection 
between 
BD FACS Sortware 
and the cytometer 
interface

1. Turn the main power off, then on, and 
wait for two beeps that indicate the 
cytometer interface is started. 

2. Restart the computer.

3. Start BD FACS Sortware. 
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Distorted 
populations or high 
CVs

Possible causes Possible solutions

Lasers are not 
properly aligned

Align the lasers.

Lasers are vertically 
misaligned

Vertically align the lasers. See Vertically 
aligning the lasers (page 68).

Instrument settings 
were adjusted 
incorrectly

Optimize the cytometer settings.

Sample pressure is too 
high

Decrease the sample pressure.

Debris or bubbles in 
the nozzle

 Remove the nozzle and sonicate it in DI 
water or detergent to remove the clog.

 Purge the nozzle using the debubble 
reservoir and clean sheath or ethanol.

 Verify that the nozzle and O-ring are 
seated properly and tightened.

Poor sample 
preparation

Repeat sample preparation.

Excess background 
light

Dim the lights in the room.

Stream is not aligned Align and focus the stream.

Sample/sheath index 
of refraction mismatch

Verify that you are using the appropriate 
sheath fluid and resuspension fluid for your 
sample.
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Excessive amount 
of debris in plots Possible causes Possible solutions

Trigger level is set too 
low

Increase the trigger level.

Dead cells or debris in 
the sample.

Examine the sample under a microscope and 
prepare a new sample, if necessary.

Sheath filter is dirty or 
contaminated

1. Remove the sheath filter.

2. Perform a system flush or replace the 
sheath line.

3. Replace the sheath filter.

Sample is 
contaminated

Prepare a new sample.

Carryover from a 
previous sample

1. Remove the sample line.

2. Backflush the sample line.

3. Reset the plot display.
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Noisy FSC or 
fluorescence signal

Low acquisition 
efficiency

Possible causes Possible solutions

Noise from the drop 
formation

Lower the piezo amplitude.

Lasers are vertically 
misaligned

Vertically align the lasers. See Vertically 
aligning the lasers (page 68).

Ambient light leak  Close all safety covers on the instrument.

 Verify that all optical filters are correctly 
installed and the O-rings are in place.

Piezo amplitude is set 
too high

Lower the piezo amplitude.

Laser or stream is not 
properly aligned

Align the stream and lasers.

Sample pressure is too 
high

Decrease the sample offset.

PMT voltage is set too 
high

Decrease the PMT voltage.

Possible causes Possible solutions

Drop-drive noise Lower the piezo amplitude.

High sample event rate Lower the sample offset.

Clumps or filaments in 
the sample

Filter the sample.

Poor laser alignment Align the laser.

Lasers are vertically 
misaligned

Vertically align the lasers. See Vertically 
aligning the lasers (page 68).
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More information • Startup, shutdown, and troubleshooting components 
(page 250)

• Sorting troubleshooting (page 370)

• Fluidics troubleshooting (page 385)

• Alignment troubleshooting (page 389)

• Application troubleshooting (page 391)

• Electronics troubleshooting (page 392)

• Equipment troubleshooting (page 393)

Fluidics troubleshooting
Introduction This topic describes fluidics problems and suggests possible 

solutions.

Cannot pressurize 
the sheath tank Possible causes Possible solutions

Bad or missing O-ring Replace the O-ring around the tank lid.

Tank is leaking 
pressure

 Check the fittings for leaks.

 Tighten the pressure release valve, using a 
wrench if necessary.

 Make sure that the lid is properly seated.

No air supply Check the air compressor or house air supply.
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Waste tank has no 
vacuum

Flush bucket, 
backflush drain, or 
stream drain does 
not empty

Possible causes Possible solutions

Tank is not sealed 
properly

 Connect all fittings.

 Verify that the O-ring is installed around 
the lid and replace the O-ring if necessary.

 Make sure that the lid is properly seated.

 Tighten the lid.

No vacuum supply Verify that the vacuum pump or supply is 
turned on.

Air filter is wet or 
clogged

Replace the air filter on the vacuum line.

Waste tank is full Empty the waste tank.

Possible causes Possible solutions

No vacuum See Waste tank has no vacuum (page 386).

Debris is clogging the 
drain

Remove the flush bucket and clean it with 
detergent.

Pinched tubing Check the tubing for kinks.
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Wide sample core
Possible causes Possible solutions

Damaged sample line Replace the sample line.

Bubbles in the nozzle  Install the debubble reservoir filled with 
clean sheath or ethanol and purge the 
nozzle.

 Verify that the nozzle and O-ring are 
seated properly and tightened.

Clogged or damaged 
nozzle

1. Remove the nozzle tip and sonicate it in 
DI water or detergent to remove the clog. 

2. Examine the nozzle under a microscope 
to check for damage. 

If the nozzle is damaged, replace it.

Sample pressure is too 
high

Decrease the sample offset.

Sample concentration 
is too low

 Concentrate the sample. 

 Prepare a new sample with higher 
concentration.

Sample/sheath index 
of refraction mismatch

Verify that you are using the appropriate 
sheath fluid and resuspension fluid for your 
sample.

Sheath tank is empty 
or low

Fill the sheath tank.

Incorrect laser or 
stream alignment

Realign the stream and laser.
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Sample tube makes 
popping sound 
when removed

Cannot open pinch 
valve to replace 
sample line

More information • Startup, shutdown, and troubleshooting components 
(page 250)

• Sorting troubleshooting (page 370)

• Acquisition troubleshooting (page 379)

• Alignment troubleshooting (page 389)

• Application troubleshooting (page 391)

• Electronics troubleshooting (page 392)

• Equipment troubleshooting (page 393)

Possible causes Possible solutions

Tube-lock lever was 
opened too quickly

Open the tube-lock lever slowly.

The filter on the 
sample tube air line is 
wet

Replace the air filter.

The sensor on the 
tube-lock lever is not 
responding

Contact BD service.

Possible causes Possible solutions

Pinch valve does not 
spring open when 
tubing is not in place

1. Press the Override button on the Pressure 
Console to deactivate the pinch valve.

2.  Use a tool to push the sample line behind 
the pinch valve.
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Alignment troubleshooting
Introduction This topic describes alignment problems and possible solutions.

Laser is not visible 
on the pinhole 
monitor

Core stream not 
visible on pinhole 
monitor when 
running alignment 
beads

Possible causes Possible solutions

Laser shutter is closed Open the laser shutter.

Laser safety interlock 
is engaged

Close the nozzle access door and place your 
finger over the optical sensor in the upper-
right corner to reset the safety interlock.

Stream is not aligned Align the stream before aligning the lasers.

Laser is not aligned Align the lasers.

Lasers are vertically 
misaligned

Vertically align the lasers. See Vertically 
aligning the lasers (page 68).

Laser did not start up Restart the main power.

Possible causes Possible solutions

Laser shutter is closed Open the laser shutter.

Laser did not start Restart the main power.

Laser safety interlock 
is engaged

Close the nozzle access door and place your 
finger over the optical sensor in the upper-
right corner to reset the safety interlock.

Stream is not aligned Align the stream before aligning the lasers.

Laser is not aligned Align the lasers.

Lasers are vertically 
misaligned

Vertically align the lasers. See Vertically 
aligning the lasers (page 68).
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Poor signal, hockey 
stick shape

More information • Startup, shutdown, and troubleshooting components 
(page 250)

• Sorting troubleshooting (page 370)

• Acquisition troubleshooting (page 379)

• Fluidics troubleshooting (page 385)

• Application troubleshooting (page 391)

• Electronics troubleshooting (page 392)

• Equipment troubleshooting (page 393)

Sample pressure is too 
low

Increase the sample offset.

Bubbles in the nozzle  Install the debubble reservoir filled with 
clean sheath or ethanol and purge the 
nozzle.

 Verify that the nozzle and O-ring are 
seated properly and tightened.

Beads are not excited 
by the laser

Use the appropriate alignment beads.

Possible causes Possible solutions

Possible causes Possible solutions

Sample pressure is too 
high

Decrease the sample offset.

Sample carryover of 
bright particles

1. Rinse the sample line with detergent.

2. Backflush the sample line.

Stream or laser is not 
aligned

Align the stream or laser.

Lasers are vertically 
misaligned

Vertically align the lasers. See Vertically 
aligning the lasers (page 68).
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Application troubleshooting
Introduction This topic describes application problems and possible solutions.

Incorrect 
compensation

Unable to perform 
autocompensation

Unable to sort on 
compensation

More information • Sorting troubleshooting (page 370)

• Acquisition troubleshooting (page 379)

• Fluidics troubleshooting (page 385)

• Alignment troubleshooting (page 389)

• Electronics troubleshooting (page 392)

• Equipment troubleshooting (page 393)

Possible causes Possible solutions

Error with staining Manually adjust the spillover values.

Possible causes Possible solutions

Too few positive or 
negative events

Collect more events.

Possible causes Possible solutions

ADC parameters are 
being used instead of 
DSP parameters

Recreate plots using DSP parameters.
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Electronics troubleshooting
Introduction This topic describes electronics problems and suggests possible 

solutions.

Cytometer error 
when opening 
BD FACS Sortware 
software

Hear three 
repeating beeps 
from the 
electronics box

More information • Sorting troubleshooting (page 370)

• Acquisition troubleshooting (page 379)

• Fluidics troubleshooting (page 385)

• Alignment troubleshooting (page 389)

• Application troubleshooting (page 391)

• Equipment troubleshooting (page 393)

Possible causes Possible solutions

Cytometer interface is 
not connected to the 
instrument

1. Turn the main power off, then on, and 
wait for two beeps that indicate the 
cytometer interface is started.

2. Restart the computer.

3. Open BD FACS Sortware. 

Possible causes Possible solutions

Sortware controller is 
not connected to the 
instrument

1. Turn off the main power button on the 
front of the electronics box.

2. Turn on the main power button.

When you hear two beeps from the 
electronics box, the controller is fully 
turned on. It may take up to two minutes 
for BD FACS Sortware to establish a 
connection after two beeps are heard.
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Equipment troubleshooting
No indication 
whether the 
Buffalo Aerosol 
Management 
System is running

Cannot reach the 
back of the sort 
chamber tray to 
clean spill

More information • Sorting troubleshooting (page 370)

• Acquisition troubleshooting (page 379)

• Fluidics troubleshooting (page 385)

• Alignment troubleshooting (page 389)

• Application troubleshooting (page 391)

• Electronics troubleshooting (page 392)

Possible causes Possible solutions

The Power button on 
the front of the unit 
does not indicate 
status.

1. Turn on the main switch at the back of 
the unit. 

The LED indicators on the control panel 
are illuminated.

2. Press the Power button on the front of the 
unit to turn the suction on and off.

3. View the filter flow gauge on the right 
side of the unit to verify that the suction 
is on or off.

Possible causes Possible solutions

The stepper table arm 
makes tray access 
difficult

Slide the tray forward until the back of the 
tray is in line with the front of the stepper 
arm. Do not remove the tray completely.
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